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Warranty
The material contained in this docu-
ment is provided “as is,” and is subject 
to being changed, without notice, in 
future ed itions. Further, to the maxi-
mum extent permitted by appl icable 
law, Keysight d isclaims all warranties, 
either express or implied, with regard 
to this manual and any information con-
tained herein, includ ing but not l imited 
to the implied warranties of merchant-
abil ity and fitness for a particular pur-
pose. Keysight shall not be l iable for 
errors or for incidental or consequential 
damages in connection with the fur-
nishing, use, or performance of this 
document or of any information con-
tained herein. Should Keysight and the 
user have a separate written agreement 
with warranty terms covering the mate-
rial in this document that confl ict with 
these terms, the warranty terms in the 
separate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a 
U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as 
“Commercial computer software” as defined 
in DFAR 252.227-7014 (June 1995), or as a 
“commercial item” as defined in FAR 2.101(a) 
or as “Restricted computer software” as 
defined in FAR 52.227-19 (June 1987) or any 
equivalent agency regulation or contract 
clause. Use, duplication or d isclosure of 
Software is subject to Keysight Technologies’ 
standard commercial license terms, and non-
DOD Departments and Agencies of the U.S. 
Government will receive no greater than 
Restricted Rights as defined in FAR 52.227-

19(c)(1-2) (June 1987). U.S. Government 
users will receive no greater than Limited 
Rights as defined in FAR 52.227-14 (June 
1987) or DFAR 252.227-7015 (b)(2) (Novem-
ber 1995), as applicable in any technical 
data.

Open Software License 
A portion of the software in this product is 
licensed under terms of the General Public 
License Version 2 (“GPLv2”). The text of the 
license and source code can be found at:

www.keysight.com/find/GPLV2

Declaration of Conformity
To get the latest version of the declaration of 
conformity, go to http://www.keysight.com/
go/conformity and type in the product num-
ber in the Search field.

Latest Information
To get the latest firmware/software/elec-
tronic manuals/specifications/support infor-
mation, go to www.keysight.com and type in 
the product number in the Search field at the 
top of the page.





COMPLIANCE WITH GERMAN NOISE REQUIREMENTS

This is to declare that this product is in conformance with the German Regulation on 
Noise Declaration for Machines 
(Lärmangabe nach der Maschinenlärminformation-Verordnung -3.GSGV Deutschland).

• Herstellerbescheinigung

GERÄUSCHEMISSION

Lpa < 70 dB

am Arbeitsplatz

normaler Betrieb

nach DIN 45635 T. 19

• Manufacturer’s Declaration

ACOUSTIC NOISE EMISSION

Lpa < 70dB

operator position

normal operation

per ISO 7779

South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.



Safety Summary
The following general safety precautions must be observed during all phases of 
operation, service, and repair of this instrument. Failure to comply with these 
precautions or with specific warnings elsewhere in this manual may impair the 
protections provided by the instrument. In addition, it violates safety standards of 
design, manufacture, and intended use of the instrument. Agilent Technologies, Inc. 
assumes no liability for customer’s failure to comply with these requirements.

Product manuals may be provided on CD-ROM or in printed form. Printed manuals are 
an option for many products. Manuals may also be available on the Web. Go to 
www.agilent.com and type the product model number in the Search field at the top of 
the page.

NOTE Do not use this instrument in any manner not specified by the manufacturer. The 
protective features of this instrument may be impaired if it is used in a manner not 
specified in the operation instructions.

This instrument is an INDOOR USE product.

This instrument complies with INSTALLATION CATEGORY II for mains input and 
INSTALLATION CATEGORY I for measurement input terminals, and POLLUTION 
DEGREE 2 defined in IEC 61010-1.

If an instrument is marked CAT I (IEC Measurement Category I), or it is not marked 
with a measurement category, its inputs must not be connected to line-voltage mains.

• DANGEROUS PROCEDURE WARNINGS

Warnings, such as example below, shall be complied. Procedures throughout in 
this manual prevent you from potentially hazard. Their instructions contained in 
the warnings must be followed.

WARNING Hazardous voltage of up to the instrument’s maximum voltage may appear at High 
Force, Guard, and High Sense terminals if Interlock terminal is closed. Open the 
Interlock terminal when the High Force, Guard, and High Sense terminals are 
accessible. Voltage applied to the terminals will be limited up to ±42 V.

• BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the 
instrument before applying power. Note the instrument's external markings 
described under “Safety Symbols”.



• GROUND THE INSTRUMENT

This is Safety Class I instrument. To minimize shock hazard, the instrument 
chassis and cabinet must be connected to an electrical ground. The power 
terminal and the power cable must meet International Electrotechnical 
Commission (IEC) safety standards.

• DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE

Do not operate the instrument in the presence of flammable gases or fumes. 
Operation of any electrical instrument in such an environment constitutes a 
definite safety hazard.

• DO NOT REMOVE COVERS

No operator serviceable parts inside. Refer servicing to qualified personnel. To 
prevent electrical shock do not remove covers.

• IN CASE OF DAMAGE

Instruments that appear damaged or defective should be made inoperative and 
secured against unintended operation until they can be repaired by qualified 
service personnel. Return the instrument to a Agilent Technologies sales or 
service office for services and repair to ensure that safety features are maintained.

• USE ONLY THE SPECIFIC ACCESSORIES

Specific accessories satisfy the requirements for specific characteristics for using 
the instrument. Use the specific accessories, cables, adapters, and so on for 
safety reasons.



Safety Symbols
The general definitions of safety symbols used on equipment or in manuals are listed 
below.

Direct current.

Alternating current.

Earth ground terminal.

Protective conductor terminal. For protection against electrical shock in case of a 
fault. Used with field wiring terminals to indicate the terminal which must be 
connected to ground before operating equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment 
which normally includes all exposed metal structures.

Grounded terminal which indicates the earth potential.

On supply.

Off supply.

Standby supply. The equipment will be marked with this symbol is not completely 
disconnected from AC mains when power switch is in the standby position.

In position of a bi-stable push switch.

Out position of a bi-stable push switch.

Hazardous voltage and potential for electrical shock. Do not touch terminals that have 
this symbol when the equipment is on.

Hot surface. Avoid contact. Surfaces are hot and may cause personal injury if touched.

Instruction manual symbol. The equipment will be marked with this symbol when it is 
necessary for the user to refer to the instruction manual.

WARNING The warning sign denotes a hazard. It calls attention to a procedure, practice, 
condition or the like, which, if not correctly performed or adhered to, could result in 
injury or death to personal.

CAUTION The caution sign denotes a hazard. It calls attention to an operating procedure, 
practice, condition or the like, which, if not correctly performed or adhered to, could 
result in damage to or destruction of part or all of the equipment.



IEC Measurement Category I

The CE mark shows that the product complies with all applicable European Directives.

The CSA mark is a registered trademark of the Canadian Standards Association.

The C-Tick mark is a registered trademark of the Australian Communications 
Authority. This signifies compliance with the Australian EMC Framework Regulations 
under the terms of the Radio communications Act.

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

This is the symbol for an Industrial, Scientific and Medical, Group 1 Class A product. 
(CISPR 11)

Korea’s safety and EMC mark

China RoHS -  Environmentally Green Product Label

China RoHS -  Product with Toxic Substance 40 yr EPUP

The Chinese mark for paper-based packaging materials; Paperboard and Corrugated 
Fiberboard

Plastic Material Coding Identification



Power Supply and Measurement Safety
• Power Supply Safety

This instrument can output high currents and voltages. Make sure that the load or 
device under test can safely handle the output current and voltage. Also, make 
sure that the connection leads can safely withstand the expected currents and are 
insulated for the expected voltages.

The instrument outputs may be connected so as to float relative to earth ground. 
Isolation or floating voltage ratings are indicated on the instrument, near the 
output terminal or the Chassis ground terminal.

• Voltage/Current Measurement Safety

Multimeters and other instruments capable of measuring high voltages and 
currents are subject to specific safety concerns because of the circuits to which 
they may be connected. To safely use these instruments, you need to understand 
the markings on the instrument near the input terminals, which include the 
Protection Limits and the IEC Measurement Category.

• Protection Limits

Agilent multimeters and other voltage measurement instruments provide 
protection circuitry to prevent damage to the instrument and to protect against the 
danger of electric shock, provided the Protection Limits are not exceeded. To 
ensure safe operation of the instrument, do not exceed the Protection Limits 
shown on the input terminals.



• Source/Measure Terminals

This instrument can simultaneously perform DC voltage or current output and 
measurement, and has the Force, Sense, and Guard terminals as shown below. 
Normally the Force, Sense, and Guard are the same potential. Voltage marked 
around the terminals indicates the Protection Limits.

Force and Sense must be connected to a terminal of a device under test (DUT) for 
the 4-wire connection (Kelvin connection) which is effective for applying voltage 
accurately. For the 2-wire connection to ease the connections, connect Force only. 
Do not connect Sense. It must be opened.

Guard should be connected to the guard shield which covers the DUT high side 
wiring for reducing leakage current caused by the wire. Or else, the Guard must be 
opened.

Chassis ground (green terminal) should be connected to the ground shield which 
covers the DUT including the guard shield to minimize the affect of noise. Or else, 
the chassis ground should be opened.

The following image is the source and measurement terminals of Agilent B2961A/ 
B2962A. For the B2961A/B2962A, the High Force, High Sense, and Guard are the 
same potential. And the Low Force and Low Sense are the same potential.

High Sense, for 4-wire connection

High Force

Guard

Chassis ground

Low Force

Low Sense, for 4-wire connection



High Voltage Shock Hazard

Agilent B2961A/B2962A can force dangerous voltages (±210 V) at the High Force, 
Guard, and High Sense terminals. To prevent electric shock hazard, the following 
safety precautions must be observed during the use of Agilent B2961A/B2962A.

• Use a three-conductor AC power cable to appliance coupler (inlet) and the 
instrument to an electric ground (safety ground).

• Prepare shielding box which covers interface to a device under test and equipped 
with interlock circuit that opens when the door is opened.

• Before performing measurement, connect the interlock circuit to the Interlock 
terminal of this instrument.

• Confirm periodically that the interlock function works normally.

• Before touching the connections of the High Force, Guard, and High Sense 
terminals, turn the instrument off and discharge any capacitors of the 
measurement path. If you do not turn the instrument off, complete “all” of the 
following items, regardless of any instrument’s settings.

• Terminate source output by pressing the On/Off switch, confirm that the 
On/Off switch turns off.

• Confirm that the High Voltage indicator is not lit.

• Open the shielding box access door (open the Interlock terminal).

• Discharge any capacitors if the capacitance is connected to this instrument.

• Warn workers in the vicinity of the instrument about hazardous conditions.



Gefahr durch Hochspannung

Von den Geräten Agilent B2961A/B2962A können Spannungen an den Anschlüssen 
“High Force”, “Guard” und “High Sense” von bis zu 210 V ausgehen. Um elektrischem 
Schlag vorzubeugen, ist bei der Benützung der Geräte Agilent B2961A/B2962A 
folgendes zu beachten.

• Verwenden Sie ein dreiphasiges AC-Stromkabel für die Gerätsteckvorrichtung 
(Eingang) und schließen Sie das Instrument an eine Erdung an 
(Sicherheitserdung).

• Bereiten Sie das Abschirmungsgehäuse vor, dass die Oberfläche eines zu 
testenden Geräts abdeckt und mit einem Verriegelungsstromkreis ausgestattet ist, 
der bei geöffneter Tür unterbrochen wird.

• Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem 
Interlock-Anschluss dieses Instruments.

• Prüfen Sie in regelmäßigen Abständen, dass die Verriegelungsfunktion 
ordnungsgemäß funktioniert.

• Bevor Sie die Verbindungen zu den Anschlüssen “High Force”, “Guard” und “High 
Sense” berühren, schalten Sie das Instrument aus und entladen alle 
Kondensatoren des Messwegs. Wenn Sie das Instrument nicht ausschalten, 
führen Sie, unabhängig von den Instrumenteinstellungen, alle folgenden Schritte 
durch.

• Beenden Sie die Messung, indem Sie auf die Taste “On/Off” drücken. Stellen 
Sie sicher, dass die Statusanzeige “On/Off” nicht leuchtet.

• Stellen Sie sicher, dass die Anzeige “High Voltage” nicht leuchtet.

• Öffnen Sie die Tür des Abschirmungsgehäuses (öffnen des 
Interlock-Anschlusses).

• Entladen Sie alle Kondensatoren, wenn die Kapazität mit das Instrument 
verbunden ist.

• Warnen Sie Mitarbeiter in der Umgebung des Instruments vor den Gefahren.



Danger de choc dû à une haute tension

Une tension dangereuse  (max. ± pour; 210 Vdc) émanant du dispositif Agilent 
B2961A/B2962A peut être sortie aux bornes High Force, Guard et High Sense, 
d'appareil de protection ou de détection. Les précautions suivantes doivent être 
obserées contre commotion électrique accidentelle.

• Utilisez un câble d’alimentation CA à trois conducteurs vers le coupleur secteur 
(entrée) et branchez l’instrument sur une mise électrique à la terre (prise de terre 
de sécurité).

• Préparez le boîtier de protection qui couvre l’interface avec le dispositif à tester et 
équipez-le d’un circuit de sécurité qui s’ouvre lors de l’ouverture d’une porte.

• Avant de procéder aux mesures, connectez le circuit de sécurité à la borne 
Interlock de l’instrument. 

• Vérifiez régulièrement le bon fonctionnement de la fonction de sécurité.

• Avant de toucher les connexions des bornes High Force, Guard et High Sense, 
mettez l’instrument hors tension et déchargez tout condensateur du chemin de 
mesure. Si vous ne mettez pas l’instrument hors tension, effectuez « toutes » les 
opérations ci-dessous, quels que soient les paramètres de l’instrument.

• Terminez les mesures en appuyant sur la touche On/Off ; vérifiez que 
l’indicateur d’état On/Off est éteint.

• Vérifiez que le témoin High Voltage est éteint.

• Ouvrez la trappe d’accès au boîtier de protection (ouvrez la borne Interlock).

• Déchargez les éventuels condensateurs si la capacité est connectée à 
l’instrument.

• Informez les personnes travaillant à proximité de l’instrument des conditions.



高電圧感電注意

Agilent B2961A/B2962A の High Force、Guard、High Sense 端子には、危険電圧が出力さ
れることがあります（最大 ±210 Vdc）。感電事故防止のため、必ず以下の事柄を
守ってください。

• 3 極電源ケーブルを使用して本器を接地してください。

• ドアを開くことによって開放されるインターロック回路を装備し、被測定デバ
イスとのインタフェースを覆うことのできるシールド・ボックスを用意してく
ださい。

• 測定を開始する前にはインターロック回路を本器の Interlock 端子に接続してく
ださい。

• インターロック機能が正常であることを定期的に確認してください。

• High Force、Guard、High Sense 端子に繋がる接続部に触れる前には、本器の電源
を切断してください。また、測定系のキャパシタを放電してください。電源を
切らない場合は、以下の事項を全て実施してください。

• On/Off スイッチを押して On/Off スイッチが消灯したことを確認してくださ
い。

• 高電圧警告（High Voltage）インジケータが消灯していることを確認してくだ
さい。

• シールド・ボックスのドアを開けてください（Interlock 端子を開放してくだ
さい）。

• 本器にキャパシタが接続されているならば、キャパシタを放電してくださ
い。

• 周囲のほかの作業者に対しても、高電圧危険に対する注意を徹底してください。



Product Stewardship
• Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC

This product complies with the WEEE Directive (2002/96/EC) marking 
requirements. The affixed label indicates that you must not discard this electrical/ 
electronic product in domestic household waste. 

Product Category: With reference to the equipment types in the WEEE directive 
Annex 1, this product is classified as a “Monitoring and Control instrumentation” 
product. 

Do not dispose in domestic household waste. 

To return unwanted products, contact your local Agilent office or visit the 
following website for more information.

www.agilent.com/environment/product/

• LCD Fluorescent Lamp

Certain products sold by Agilent contain a liquid crystal display (LCD); backlighting 
for the LCD is provided by a fluorescent lamp which contains mercury, and must 
be managed, recycled, and/or disposed in accordance with all applicable laws, 
ordinances and regulations. 

For information on how to recycle or dispose of the fluorescent lamp contained in 
your own product, visit the following website.

http://www.agilent.com/environment/mercury.shtml

If you live in the U.S., also visit the following websites.

http://www.lamprecycle.org

http://www.eiae.org

If you have additional questions, please visit the following website.

http://www.agilent.com/go/contactus

• Perchlorate Information

Perchlorate Material - special handling may apply. Visit the following website.

http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

Equipment's real-time clock battery or coin cell battery may contain perchlorate 
and may require special handling when recycled or disposed of in California.



In This Manual 
This manual describes the front panel operation, installation, and functions of the 
Agilent Technologies B2961A/B2962A Low Noise Power Source. This manual 
consists of the following chapters.

• Chapter 1, “Getting Started”

This chapter briefly explains how to use the Agilent B2961A/B2962A by the front 
panel operation.

• Chapter 2, “Introduction”

This chapter describes overview, specifications, accessories, and options of the 
Agilent B2961A/B2962A.

• Chapter 3, “Installation”

This chapter explains how to install the Agilent B2961A/B2962A, and how to 
connect the device under test to a test fixture.

• Chapter 4, “Front Panel Reference”

This chapter provides the reference information of the Agilent B2961A/B2962A 
front panel keys and graphical user interface.

• Chapter 5, “Front Panel Operations”

This chapter explains how to use the Agilent B2961A/B2962A in the local mode.

• Chapter 6, “Function Details”

This chapter explains the several functions and initial settings of the Agilent 
B2961A/B2962A.
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Getting Started
This chapter describes basic operations for Agilent B2961A/B2962A. Before 
learning the details of B2961A/B2962A, let us briefly cover the use of the 
B2961A/B2962A. The operations require only B2961A/B2962A and the power 
cord. To get started with the operations, open the measurement terminals.

This chapter consists of the following sections.

• “Applying DC Output”

• “Applying Waveform Output”

• “Performing Spot Measurement”

• “Performing Sweep Measurement”

• “Operation Tips”

• “Operation Summary”

NOTE Turning B2961A/B2962A on

1. Connect the power cord from the AC input connector (receptacle) on 
B2961A/B2962A’s rear panel to an AC power outlet at your site.

2. Press the line switch  on the front panel.

B2961A/B2962A boots up and performs a self-test. After B2961A/B2962A boots 
normally, the front panel LCD displays the following view. It will be the Single 
view for the 1-channel model or the Dual view for the 2-channel model.

NOTE Connecting your DUT

If you want to connect your device under test, see “Connecting a DUT” on page 
3-11.

1: Single view D: Dual view
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Getting Started
Applying DC Output
Applying DC Output
B2961A/B2962A can be used as a DC current or voltage source. The following 
procedure configures B2961A/B2962A as a voltage source and applies a voltage of 
+0.5 V.

Step 1. Press the  key to display the Single view or Dual view.

Step 2. Setting the Source mode (voltage output)

1. Press the Mode assist key on a 1-ch model, or the Ch1 Mode assist key on a 2-ch 
model.

The field pointer appears on the Source mode, and the status changes to EDIT 
(green). The status information will show .

2. Press the VOLTS (V) assist key. Or use the rotary knob or arrow keys 
 and  to specify the mode, and press the knob to fix the setting.

The status changes to MOVE (blue). The status information will show .

Step 3. Setting the Source value (voltage output value)

1. Press the Source assist key on a 1-ch model, or the Ch1 Source assist key on a 
2-ch model. Or, use the rotary knob or arrow keys to move the field pointer onto 
the Source value and press the knob. The field pointer appears on the Source 
value, and the status changes to EDIT (green).

2. Turn the rotary knob clockwise to increase the value, or counter clockwise to 
decrease the value. Set the desired value. 

When you press an arrow key, a digit pointer will appear on a digit. Turning the 
knob will change the value of the digit or move the decimal point if the pointer is 
on it. 

3. Press the rotary knob to fix the value. The status changes to MOVE (blue).
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Getting Started
Applying DC Output
The numeric/alpha keys and the unit assist keys are also available for setting the 
Source value in the same way as for setting the Limit value, shown in the next step.

This example sets the Source value to +0.5 V.

Step 4. Setting the Limit value (current limit value)

1. Press the Limit assist key on a 1-ch model, or the Ch1 Limit assist key on a 2-ch 
model. Or, use the rotary knob or arrow keys to move the field pointer onto the 
Limit value and press the knob. The field pointer appears on the Limit value, and 
the status changes to EDIT (green).

2. Use the rotary knob, arrow keys, or numeric/alpha keys  
to set the value.

3. Press one of the unit assist keys to set the unit and fix the value. 
The status changes to MOVE (blue).

This example sets the Limit value to 100 nA.

Step 5. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. The 
channel 1 changes status to CV (Constant Voltage) and starts DC output.

The channel 1 also performs output monitor. In this example, the channel 1 
measures the channel output voltage and current once.

In this status, changing the setup changes the channel output immediately.

Step 6. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Applying Waveform Output
Applying Waveform Output
B2961A/B2962A can be used as a current or voltage waveform generator. The 
following procedure configures B2961A/B2962A as a voltage waveform generator 
and applies a sinusoidal wave voltage of 1 V and 1 Hz.

If you want to apply DC output before starting the waveform output, set the DC 
source. Setup example is described in “Applying DC Output” on page 1-3.

Step 1. Press the  key to display the Single view.

Step 2. Setting the waveform parameters

1. Use the rotary knob or arrow keys to move the field pointer onto the Function 
field. If the screen does not display the field, press More and Hide xxxx.

2. Press the rotary knob to change the status to EDIT (green).

3. Press More and ARB SINUSOID to set the sinusoidal wave mode. The source 
shape indicator shows the sinusoid icon, and the status changes to MOVE (blue).

4. Use the rotary knob, arrow keys, or numeric/alpha keys to set the Amplitude, 
Frequency, and Offset. Optionally, press Show Preview to display the preview.

This example sets Amplitude/Frequency/Offset to 1 V/1 Hz/0 V.

Step 3. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. The 
channel 1 changes status to CV (Constant Voltage) and starts DC output.

Step 4. Press the  key to start a waveform output.

Step 5. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Performing Spot Measurement
Performing Spot Measurement
B2961A/B2962A can be used as a DC current and voltage meter. The following 
procedure measures current and voltage.

If you want to apply DC output before starting measurement, set the DC source. 
Setup example is described in “Applying DC Output” on page 1-3.

Step 1. Setting the Measure parameter (current and voltage measurement)

1. Press Measure on a 1-ch model or Ch1 Measure on a 2-ch model. 

2. Press AMPS (I).

3. Press the  key once, and press the rotary knob once. 

4. Press VOLTS (V).

Step 2. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. The 
channel 1 changes status to CV (Constant Voltage) or CC (Constant Current) and 
starts DC output.

Step 3. Starting measurement

• Press the  key to start a single (one shot) measurement. Spot 
measurement is performed once.

• Press the  key to start a repeat (continuous) measurement. Spot 
measurement is performed repeatedly.

The following example shows the measurement results for a 10 M resistor 
connected between the High Force and Low Force terminals of channel 1.

Step 4. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Performing Sweep Measurement
Performing Sweep Measurement
B2961A/B2962A can be used as a DC current/voltage sweep source and meter. The 
following example applies a staircase sweep voltage and measures current and 
voltage at each step voltage.

Step 1. Press the  key to display the Single view.

Step 2. Set the Source mode, Limit value, and Measure parameter. Setup example is 
described in “Applying DC Output” and “Performing Spot Measurement”.

This example sets the voltage output mode, 100 nA limit value, and both current and 
voltage measurements.

Step 3. Setting the Sweep parameters

1. Use the rotary knob or arrow keys to move the field pointer onto the Function 
field. If the screen does not display the field, press More and Hide xxxx.

2. Press the rotary knob to change the status to EDIT (green).

3. Press LINEAR SINGLE to set the linear single sweep mode. The source shape 
indicator shows the staircase icon, and the status changes to MOVE (blue).

4. Use the rotary knob, arrow keys, or numeric/alpha keys to set the Start (sweep 
start value), Stop (sweep stop value), and Step (sweep step value) or Points 
(number of sweep steps).

This example sets Start to 0 V, Stop to 0.5 V, and Points to 11.

Step 4. Setting the Trigger parameters

1. Press More and Show Trigger to display the Trigger setup. 

2. Press the rotary knob onto the Trigger field to change the status to EDIT (green).

3. Press TIMER to set the timer trigger mode.
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Getting Started
Performing Sweep Measurement
4. Use the rotary knob, arrow keys, or numeric/alpha keys to set the Count (trigger 
count) for both Source and Measure.

This example sets Count to 11 for both Source and Measure.

Step 5. Press the  key to display the Graph view.

Step 6. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. The 
channel 1 changes status to CV (Constant Voltage) and starts DC output.

Step 7. Press the  key to start a single (one shot) measurement. Sweep measurement 
is performed once. And the measurement results will be displayed on the I-t graph. 

Step 8. Press Auto Scale to fit the trace in the graph scale.

The following example shows the measurement results for a 10 M resistor 
connected between the High Force and Low Force terminals of channel 1.

Step 9. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Operation Tips
Operation Tips
This section introduces key operation and status information on B2961A/B2962A.

• “Changing the View Mode”

• “Editing the Setup”

• “Status Information”

Figure 1-1 Changing the View Mode

For details about the View mode, see “Display and Assist Keys” on page 4-5.
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Figure 1-2 Editing the Setup

For more information about the front panel keys, see “Hard Keys and Rotary Knob” 
on page 4-3.

If the field pointer is in the EDIT (green) status on the Source or Limit field, turning 
the knob changes the setting value of the source channel in real time.

Figure 1-3 Status Information

For details about the status information, see “Status Information” on page 4-24.
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Operation Summary
Operation Summary
This section summarizes front panel operations on B2961A/B2962A.

• “Basic Operations”

• “Channel Setup”

• “Source Setup”

• “Measurement Setup”

• “Display Setup”

• “File Operations”

• “Miscellaneous Functions”

• “Interface Setup”

• “System Setup and Operations”

For details about front panel operations, see Chapter 4, “Front Panel Reference.”
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Table 1-1 Basic Operations

Table 1-2 Channel Setup

Task Relevant front panel key

To turn the B2961A/B2962A on/off Line switch

To change the display mode View key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To cancel the previous setup operation Cancel/Local key

To return to the upper menu of a function key or softkey Cancel/Local key

To return to the local status from the remote status Cancel/Local key

To start a single (one shot) output/measurement Trigger key

To start a repeat (continuous) measurement Auto key

To move the field pointer Rotary knob or arrow keys

To move the digit pointer Rotary knob or arrow keys

To switch the EDIT/MOVE status Rotary knob on a setup field

To select the setup value Assist keys, rotary knob, or arrow keys

Task Relevant front panel key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To select the sensing type; 2-wire or 4-wire Config > Source > Connection function keys

To select the low terminal status; grounded or floating Config > Source > Connection function keys

To enable/disable high capacitance mode Config > Source > Connection function keys

To enable/disable over voltage/current protection Config > Source > Connection function keys

To enable/disable resistance compensation Config > Measure > R Compen function keys

To enable/disable 2-channel synchronous operation Config > Common > Group function keys
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Table 1-3 Source Setup

Task Relevant front panel key

To enable/disable source output Ch 1 On/Off switch or Ch 2 On/Off switch

To select source output mode Mode, Ch1 Mode, or Ch2 Mode assist key

To set source output value Source, Ch1 Source, or Ch2 Source assist key

To set limit value Limit, Ch1 Limit, or Ch2 Limit assist key

To set function OFF, sweep output 
(linear single, linear double, log single, 
log double, or list), or arbitrary 
waveform output (exponent, ramp, 
square, sinusoid, trapezoid, triangle, or 
user defined)

Hide Options/Pulse/Trigger assist key on Single view

To set constant source ranging mode Show Options assist key on Single view

To set programmable output resistance Show Options assist key on Single view

To set list sweep source Edit assist key in the EDIT status for the LIST sweep 
Start/Stop/Points field

To set sweep source ranging mode Config > Source > Sweep function keys

To set sweep direction Config > Source > Sweep function keys

To set source output value after sweep Config > Source > Sweep function keys

To set pulse source Show Pulse assist key on Single view

To set source wait time Config > Common > Wait function keys

To set output filter Config > Source > Filter function keys

To use external low noise filter Config > Source > Ext. Filter function keys

To set programmable output resistance 
using emulation table

Config > Source > Output R function keys

To select output-off status Config > Source > Connection function keys

To enable/disable automatic output ON Config > Source > Connection function keys

To enable/disable automatic output OFF Config > Source > Connection function keys
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Table 1-4 Measurement Setup

Table 1-5 Display Setup

Table 1-6 File Operations

Task Relevant front panel key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To select measurement mode Measure, Ch1 Measure, or Ch2 Measure assist key

To set measurement speed Show Options assist key on Single view

To set measurement wait time Config > Common > Wait function keys

Task Relevant front panel key

To change the display mode View key

To change the color set Display > Color function keys

To enable zoom-in Display > Zoom > ON function keys

To disable zoom-in Zoom Out assist key for the zoom-in display status

To enable/disable the front panel display 
in the remote condition

Display > Remote function keys

Task Relevant front panel key

To save a measurement result data to USB memory File > Save > Measure function keys

To save a math result data to USB memory File > Save > Math function keys

To save a trace buffer data to USB memory File > Save > Trace function keys

To save a system setting data to USB memory File > Save > Config function keys

To save a graph screen damp to USB memory Dump Screen assist key on Graph view

To load a system setting data from USB memory File > Load > Config function keys

To load a list sweep data from USB memory Load assist key in the EDIT status for the LIST 
sweep Start/Stop/Points field

To load a user defined waveform data from USB 
memory

Load assist key in the EDIT status for the ARB 
USER Start/Stop/Points field
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Table 1-7 Miscellaneous Functions

Table 1-8 Interface Setup

Task Relevant front panel key

To enable V/I Limit for each polarity Display > Pref. function keys

To enable immediate V/I update by knob Display > Pref. function keys

To see measurement result Result > Measure function keys

To use math expression Function > Math function keys

To see math result Result > Measure function keys

To set trace buffer Function > Trace function keys

To see trace statistical result Result > Trace function keys

To select program memory Program > Catalog function keys

To control program memory Program > Control function keys

To set trigger parameters easily Show Trigger assist key on Single view

To set trigger parameters in detail Function > Trigger > Config function keys

To control trigger system Function > Trigger > Initiate/Abort/Immediate function keys

Task Relevant front panel key

To specify measurement data elements I/O > Format > Measure function keys

To specify math data elements I/O > Format > Math function keys

To specify trace statistical data elements I/O > Format > Trace function keys

To select data output format I/O > Format > Data Type function keys

To enable/disable byte swap of binary data I/O > Format > Byte Swap function keys

To set LAN configuration I/O > LAN > Config function keys

To see status of LAN interface I/O > LAN > Status function keys

To reset all of LAN connections I/O > LAN > Reset function keys
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Table 1-9 System Setup and Operations

To sets LAN settings to the default settings I/O > LAN > Default function keys

To see status of USB interface I/O > USB function keys

To set GPIB address I/O > GPIB function keys

To see status of GPIB interface I/O > GPIB function keys

To set configuration of Digital I/O I/O > DIO > Config function keys

To read/write a value set to Digital I/O I/O > DIO > R/W function keys

Task Relevant front panel key

To set power line frequency System > PLC function keys

To initialize B2961A/B2962A System > Reset function keys

To perform self-calibration System > Cal/Test > Self-Cal function keys

To perform self-test System > Cal/Test > Self-Test function keys

To check errors System > Error > Log function keys

To clear errors System > Error > Clear function keys

To clear time stamp System > Timestamp > Clear function keys

To set automatic clear of time stamp System > Timestamp > Auto CLR function keys

To set start-up operation System > More > Start-up function keys

To enable/disable beep and sound System > More > Sound function keys

To set date and time System > More > Info. > Date/Time function keys

To perform firmware update System > More > Info. > Update > Firmware function keys

To perform demonstration System > More > Info. > Demo. function keys

Task Relevant front panel key
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Introduction
This chapter describes the basic functions and features of the Agilent B2961A/ 
B2962A, and consists of the following sections.

• “Agilent B2961A/B2962A”

• “Front View”

• “Rear View”

• “Power Source”

• “Specifications”

• “Operation and Functions”

• “Software and Drivers”

• “Accessories”

• “Options”
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Agilent B2961A/B2962A
Agilent B2961A/B2962A is 6½ digit low noise power source. B2961A/B2962A 
provides the LCD, front panel keys, and rotary knob for applying voltage/current or 
measuring voltage/current/resistance. B2961A/B2962A also supports several 
functions, such as arbitrary waveform generation, pulse output, sweep output, trace 
buffer, math expressions, and graph plot. Hence, B2961A/B2962A can be used as a 
DC (constant) voltage/current source, sweep voltage/current source, pulse generator, 
arbitrary waveform generator, and multimeter.

Table 2-1 Agilent B2961A/B2962A 6½ Digit Low Noise Power Source

B2961A/B2962A is a LAN eXtended Interface Core compliant instrument.

Model 
No.

Number 
of 

channels

Effective set and measure value

Minimum 
resolution Maximum 

current
Maximum 

voltage
 Set Measure

B2961A 1 0.01 pA, 
0.1 V

1 pA, 
10 V

DC: ± 3.03 A 
Pulse: ± 10.5 A

± 210 V

B2962A 2
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Front View
This section describes the front view of the Agilent B2961A/B2962A.

• Line switch

Turns the instrument on or off.

• Display

Displays the source setup, measurement result, status information, etc. For 
details, see Chapter 4, “Front Panel Reference.”

• Trigger key

Starts a single (one shot) output/measurement or initiates trigger system. If a 
repeat measurement is in progress, stops it.

The single measurement is performed with the DC bias output, pulsed bias 
output, arbitrary waveform output, staircase sweep output, or pulsed sweep 
output set to the channel. One single measurement can contain the maximum of 
100000 measurement points.

Once a single measurement starts, the data buffer (maximum 100000 data) is 
cleared, and the last single measurement result is stored in the buffer. The 
measurement result is displayed on the Single view, Dual view, or Graph view.

NOTE If measurement is not performed properly, check the trigger setting. The trigger type 
must be set to AUTO, or the trigger count (Count) must be set properly. See 
“Trigger Parameters” on page 4-19.
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• Auto key

Starts a repeat (continuous) measurement. If a repeat measurement is in 
progress, stops it.

The repeat measurement is performed with the DC bias output of the Source 
value. And the measurement result is displayed on the Single view or Dual view. 
The repeat measurement result is not stored in the buffer.

• USB-A connector

Used to connect a USB memory. After disconnecting the USB memory, wait 10 
seconds before connecting it again or new one.

CAUTION Turning the instrument off while the USB memory is being accessed may damage 
the device. 

• Function keys

Six function keys are available below the display. They are assigned to the 
softkeys, Config, Function, Trigger, Result, File, Program, I/O, Display, System, 
and More. For details, see Chapter 4, “Front Panel Reference.”

• Assist keys

Five assist keys are available to the right of the display. They are assigned to 
several softkeys, such as Mode, Source, Limit, Measure, and More. The softkey 
assignment depends on the display mode (Single, Graph, or Dual). For details, 
see Chapter 4, “Front Panel Reference.”

• View key

Changes the display mode. Pressing the key changes the mode as shown below.

On B2961A Single  Graph  (return to Single)

On B2962A Dual  Single for channel 1  Single for channel 2  
Graph  (return to Dual)

• Cancel / Local key

Cancels the setup operation if the instrument is in the local status. Returns the 
instrument to the local status if it is in the remote status.
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• Numeric/alpha keys

Used to enter the value of setup parameters such as the source output value, limit 
value, and message, specified by the field pointer.

• Rotary knob

If the field pointer is in the MOVE (blue) status, turning the knob moves the 
pointer. Pressing the knob fixes the pointer position and changes the pointer 
status to EDIT (green).

If the field pointer is in the EDIT (green) status, turning the knob changes the 
value of the setup parameter specified by the pointer. Pressing the knob fixes the 
value and changes the pointer status to MOVE (blue).

• Left and right keys

If the field pointer is in the MOVE (blue) status, pressing the key moves the 
pointer.

If the field pointer is in the EDIT (green) status, pressing the key changes the 
value of the setup parameter specified by the pointer.

If the field pointer is in the EDIT (green) status on a numeric value entry field, 
pressing the key changes the pointer to a digit pointer.

• On/Off switch(es)

Used to enable or disable the channel. Turns the channel off if it is in the output 
status even if it is in the remote status. One switch on 1-channel models, and two 
switches on 2-channel models.

The switch turns green if the channel is enabled.

The switch turns red if the channel is in the high voltage state.

• Channel 1 source/measure terminals

Terminals for channel 1. High Force, Low Force, High Sense, Low Sense, 
Guard, and chassis ground. For details, see “Connecting a DUT” on page 3-11

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2961A/B2962A.

CAUTION Do not apply current to the chassis ground terminal. Doing so will damage the 
B2961A/B2962A.
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Rear View
This section describes the rear view of the Agilent B2961A/B2962A.

• Channel 2 source/measure terminals

Only on 2-channel models. Terminals for channel 2. High Force, Low Force, 
High Sense, Low Sense, Guard, and chassis ground. For details, see 
“Connecting a DUT” on page 3-11

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2961A/B2962A.

CAUTION Do not apply current to the chassis ground terminal. Doing so will damage the 
B2961A/B2962A.

• GPIB interface connector

Use an Agilent 82357A/B USB/GPIB interface or Agilent 10833A/B/C/D GPIB 
cable to connect to an external computer or equipment.

• Cooling fan

• AC input connector

AC power cord is connected to this receptacle.

• LAN interface connector

Connects to 10/100 Base-T interface. Left LED indicates activity. Right LED 
indicates link integrity.
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• USB-B connector

Connects to USB interface.

• Digital I/O connector

D-sub 25 pin female connector for general purpose I/O (GPIO). Can be used as 
trigger input/output terminals or as an interface to a handler or the likes. For 
details, see “Using Digital I/O” on page 3-33

Pins 16 and 24 and pins 17 and 25 are reserved for the interlock function. If the 
terminals are open, the instrument output is limited to ±42 V. Be sure to connect 
the terminals to the Agilent 16442B test fixture or another DUT interface before 
performing measurements. If you do not use 16442B, you need to install an 
interlock circuit. For details on how to install the interlock circuit, see “Installing 
the Interlock Circuit” on page 3-23.

WARNING Dangerous voltage of up to the maximum voltage of channel may be present at 
the High Force, High Sense, and Guard terminals if the Interlock terminal is 
closed.

NOTE Serial Number

You will need the instrument’s serial number when using the Agilent Technologies 
telephone assistance program. The serial number label is attached to the bottom of 
the instrument.
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Power Source
The power source can apply voltage or current, and can measure current or voltage.

Figure 2-1 shows a simplified power source circuit diagrams. The power source can 
perform the following operations.

• Applies voltage and measures current

• Applies current and measures voltage

• Applies voltage and measures voltage

• Applies current and measures current

Figure 2-1 Simplified Power Source Circuit Diagram

High Force

Chassis ground

High Sense

4-wire connections

Low Sense

Low Force

High Force

Chassis ground
Low Force

2-wire connections

DC
Current

and
Voltage
Monitor

(4½ digit)

DC
Current

and
Voltage
Monitor

(4½ digit)
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Measurement Parameters

B2961A/B2962A supports the following measurement parameters.

• Current

• Voltage

• Resistance

• Power

• Percent-to-Limit (= measured value / Limit value  100 %)

Resistance data is given by Resistance = Vmeas / Imeas.

Power data is given by Power = Vmeas  Imeas.

In the above formula, Vmeas is the voltage measurement data, and Imeas is the 
current measurement data.

For using the resistance compensation, see “Resistance Compensation” on page 
6-18.

NOTE Measurement Range

Voltage source uses the present output range to measure voltage and/or the 
minimum range which covers the Limit value to measure current.

Current source uses the present output range to measure current and/or the minimum 
range which covers the Limit value to measure voltage.

Limit

B2961A/B2962A has a compliance feature that limits the output voltage or current 
to prevent damage to the device under test. When the channel applies voltage, you 
can specify the current limit. When the channel applies current, you can specify the 
voltage limit. For details, see “Limit/Compliance” on page 6-3.
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Output and Measurement Ranges

This section describes typical specifications of the Agilent B2961A/B2962A.

• Maximum voltage and current: see Figure 2-2.

• Maximum power: 31.8 W

• Output/measurement value and resolution: see Table 2-2 to Table 2-6.

Figure 2-2 Maximum Voltage and Current

NOTE For using the arbitrary waveform output function or an external filter 
(N1294A-021/022 low noise filter), the range of DC output is applied.
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Table 2-2 Current Output Range

Range 
value

Setting 
resolution

DC output current or 
pulse peak/base 

current a b

Maximum voltage

Pulse width t cDC 
output

Pulsed 
output

10 nA 10 fA 0  |I|  10.5 nA 210 V 210 V 50 s  t  tmax

100 nA 100 fA 0  |I|  105 nA

1 A 1 pA 0  |I|  1.05 A

10 A 10 pA 0  |I|  10.5 A

100 A 100 pA 0  |I|  105 A

1 mA 1 nA 0  |I|  1.05 mA

10 mA 10 nA 0  |I|  10.5 mA

100 mA 100 nA 0  |I|  105 mA

1 A 1 A 0  |I|  105 mA

105 mA < |I|  1.05 A 21 V 21 V

0  |I|  1.05 A  200 V 50 s  t  2.5 ms

 180 V 50 s  t  10 ms

1.5 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

0  |I|  1.515 A  200 V 50 s  t  2.5 ms

0  |I|  1.05 A  180 V 50 s  t  10 ms

3 A 10 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

1.515 A < |I|  3.03 A 6 V 6 V

10 A 0  |I|  10.5 A  6 V 50 s  t  1 ms

0  |I|  1.515 A  200 V 50 s  t  2.5 ms

0  |I|  1.05 A  180 V 50 s  t  10 ms
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Table 2-3 Voltage Output Range

a. Table 2-4 shows the limitations when using Channels 1 and 2 for DC output or 
Pulsed output with 50 s  t  tmax (=99.9999 ks).

b. Maximum base current is 500 mA for the pulse with 50 s  t  1 ms, and 50 mA for 
the pulse with 50 s  t  2.5 ms or 50 s  t  10 ms.

c. Maximum duty cycle is 99.9999 % for the pulse with 50 s  t  tmax, and 2.5 % for 

the pulse with 50 s  t  1 ms, 50 s  t  2.5 ms, or 50 s  t  10 ms.

Range 
value

Setting 
resolution

DC output voltage 
or pulse peak/base 

voltage

Maximum current a

a. Table 2-4 shows the limitations when using Channels 1 and 2 for DC output or Pulsed 
output with 50 s  t  tmax (=99.9999 ks).

Pulse width t b

b. Maximum duty cycle is 99.9999 % for the pulse with 50 s  t  tmax, and 2.5 % for 

the pulse with 50 s  t  1 ms, 50 s  t  2.5 ms, or 50 s  t  10 ms.

DC 
output

Pulsed 
output

0.2 V 0.1 V 0  |V|  0.21 V 3.03 A 3.03 A with 50 s  t  tmax

10.5 A with 50 s  t  1 ms2 V 1 V 0  |V|  2.1 V

20 V 10 V 0  |V|  6 V

6 V < |V|  21 V 1.515 A 1.515 A with 50 s  t  tmax

200 V 100 V 0  |V|  6 V 3.03 A 3.03 A with 50 s  t  tmax

10.5 A with 50 s  t  1 ms

6 V < |V|  21 V 1.515 A 1.515 A 50 s  t  tmax

21 V < |V|  210 V 105 mA 105 mA

0  |V|  180 V  1.05 A 50 s  t  10 ms

0  |V|  200 V  1.515 A 50 s  t  2.5 ms
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Table 2-4 Limitations for using Channels 1 and 2

Table 2-5 Current Measurement Range

Channel 1 voltage V1 Channel 2 voltage V2 Current limit a

a. I1: Channel 1 current, I2: Channel 2 current

0 < |V1|  6 V 0 < |V2|  6 V I1 + I2  4 A

6 V < |V2|  21 V I1 + I2  1.6  4 A

6 V < |V1|  21 V 0 < |V2|  6 V I1 + I2  0.625  2.5 A

6 V < |V2|  21 V I1 + I2  2.5 A

Range value Current measurement value Resolution

10 nA 0  |I|  10.6 nA 1 pA

100 nA 0  |I|  106 nA 10 pA

1 A 0  |I|  1.06 A 100 pA

10 A 0  |I|  10.6 A 1 nA

100 A 0  |I|  106 A 10 nA

1 mA 0  |I|  1.06 mA 100 nA

10 mA 0  |I|  10.6 mA 1 A

100 mA 0  |I|  106 mA 10 A

1 A 0  |I|  1.06 A 100 A

1.5 A 0  |I|  1.53 A

3 A 0  |I|  3.06 A 1 mA

10 A a

a. Available for pulse mode. Not available for DC mode.

0  |I|  10.6 A
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Table 2-6 Voltage Measurement Range

Range value Voltage measurement value Resolution

0.2 V 0  |V|  0.212 V 10 V

2 V 0  |V|  2.12 V 100 V

20 V 0  |V|  21.2 V 1 mV

200 V 0  |V|  212 V 10 mV
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Specifications
This chapter lists specifications and supplemental information for the Agilent 
B2961A/B2962A. The specifications are the standards against which the B2961A/ 
B2962A is tested. When the B2961A/B2962A is shipped from the factory, it meets 
the specifications.

Specification Conditions

The source and measurement accuracy are specified under the conditions listed 
below.

1. Temperature: 23 C ± 5 C

2. Humidity: 30 % to 80 % RH

3. After 60 minutes warm-up

4. Ambient temperature change less than ± 3 C after self-calibration execution

5. Calibration period: 1 year

6. Measurement speed: 1 PLC (Power Line Cycle)

Maximum Voltage and Current

• Voltage output range: See Figure 2-2, Table 2-3, and Table 2-4.

• Current output range: See Figure 2-2, Table 2-2, and Table 2-4.

Source Specifications

• Voltage source specifications: See Table 2-7.

• Current source specifications: See Table 2-8.
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Table 2-7 Voltage Source Specifications

Table 2-8 Current Source Specifications

Range
Programming 

resolution

Accuracy 
(gain error 

(% of reading) 
+ offset error)

Noise a 
(peak-peak) 

0.1 Hz to 10 Hz

a. Supplemental characteristics

Maximum 
voltage 

(over range)

200 mV 100 nV (0.015 % + 225 V)  5 V 210 mV

2 V 1 V (0.02 % + 350 V)  15 V 2.1 V

20 V 10 V (0.015 % + 5 mV)  150 V 21 V

200 V 100 V (0.015 % + 50 mV)  1.5 mV 210 V

Range
Programming 

resolution

Accuracy 
(gain error 

(% of reading) 
+ offset error)

Noise a 
(peak-peak) 

0.1 Hz to 10 Hz

a. Supplemental characteristics

Maximum 
current 

(over range)

10 nA 10 fA (0.10 % + 50 pA)  1 pA 10.5 nA

100 nA 100 fA (0.06 % + 100 pA)  2 pA 105 nA

1 A 1 pA (0.025 % + 500 pA)  20 pA 1.05 A

10 A 10 pA (0.025 % + 1.5 nA)  60 pA 10.5 A

100 A 100 pA (0.02 % + 25 nA)  1 nA 105 A

1 mA 1 nA (0.02 % + 200 nA)  6 nA 1.05 mA

10 mA 10 nA (0.02 % + 2.5 V)  100 nA 10.5 mA

100 mA 100 nA (0.02 % + 20 V)  600 nA 105 mA

1 A 1 A (0.03 % + 1.5 mA)  20 A 1.05 A

1.5 A 1 A (0.05 % + 3.5 mA)  20 A 1.515 A

3 A 10 A (0.4 % + 7 mA)  60 A 3.03 A

10 Ab

b. 10 A range is available only for pulse mode, not available for DC mode.

10 A (0.4 % + 25 mA)c

c. Measurement speed: 0.01 PLC

 10.5 A
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Source Supplemental Characteristics

Pulsing Capabilities

• Minimum programmable pulse width: 50 s

• Pulse width programming resolution: 1 s

• Pulse width definition:

The time from 10 % leading to 90 % trailing edge as follows.

• Maximum duty cycle and pulse width: See Table 2-9.

• Minimum pulse width at the given voltage, current, and settling conditions: See 
Table 2-10.

Sweep Capabilities

• Sweep mode: linear, logarithmic (log), or list

• Sweep direction: single or double

• Type: DC or pulse

• Number of steps: 1 to 100,000

• Minimum programmable value to create list sweep waveform: Minimum 10 s 
with 1 s resolution

Arbitrary Waveform Generation Capabilities

Pre-defined waveforms and user-defined waveforms are supported.

• Pre-defined Waveforms:

• Supported waveforms: sine, square, ramp, triangle, trapezoid and 
exponential

• Frequency: 1 mHz to 10 kHz

• Programmable frequency/timing resolution: 1 Hz nominal (sine), 250 ns 
(waveforms other than sine)

90 %

10 %

Peak level

Pulse width

Base level
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• Frequency accuracy of time base: 50 ppm

• User-defined waveform:

• Waveform length: 1 to 100,000 points

• Sample rate: 0.001 to 100,000 Sa/s, 250 ns resolution

• Storage: Non-volatile memory and USB memory are both available. 
Non-volatile memory can store one waveform with a length of up to 2500 
points. USB memory can store waveforms of up to 100,000 points.

Table 2-9 Maximum Duty Cycle and Pulse Width

Table 2-10 Minimum Pulse Width at the Given Voltage, Current, and Settling Conditions

Maximum 
duty cycle

Pulse width
Maximum 

voltage
Maximum peak 

current
Maximum base 

current

99.9999 % 50 s to 99999.9 s 6 V 3.03 Aa

a. Maximum current limitation: For 21 V/1.515 A and 6 V/3.03 A ranges, total maximum current 
is limited as shown in Table 2-4 for using 2 channels. Maximum current is not limited for using 
1 channel only.

3.03 Aa

21 V 1.515 Aa 1.515 Aa

210 V 0.105 A 0.105 A

2.5 % 50 s to 1 ms 6 V 10.5 A 500 mA

50 s to 10 ms 180 V 1.05 A 50 mA

50 s to 2.5 ms 200 V 1.515 A 50 mA

Source value Limit value Load
Source settling 
(% of range)

Minimum pulse 
width

200 V 1.5 A 200  0.1 % 1 ms

6 V 10.5 A 0.6  0.1 % 0.2 ms

1.5 A 200 V 65  0.1 % 2.5 ms

10.5 A 6 V 0.5  0.1 % 0.2 ms
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Output Characteristics

• Temperature coefficient (0 C to 18 C and 28 C to 50 C):

(0.1  accuracy specification) / C

• Maximum output power and source/sink limits: 31.8 W, ±6 V @±3.03 A, ±21 V 
@±1.515 A, ±210 V @±105 mA, four quadrant source or sink operation

• Output location: Channel 1 at front and channel 2 at rear

• Output connectors: Banana jack. Triaxial connections are recommended for 
sourcing less than 1 nA. A banana jack to triaxial adapter is available for low 
current source.

• Low terminal connection: Chassis grounded or floating

• Sensing modes: 2-wire or 4-wire (remote-sensing) connections

• Maximum load: 0.01 F in normal mode, 50 F in high capacitance mode

• DC floating voltage: Maximum 250 V DC between low force and chassis 
ground

• Guard offset voltage (V source): < 4 mV

• Remote sense operation range: 

Maximum voltage between High Force and High Sense: 3 V 

Maximum voltage between Low Force and Low Sense: 3 V

• Common mode isolation: > 1 G, < 4500 pF

• Maximum sense lead resistance: 1 k for rated accuracy

• Sense input impedance: > 10 G

• Current limit/compliance: Accuracy is same as current source. Minimum value 
is 1 % of range, or 1 nA in 10 nA range.

• Voltage limit/compliance: Accuracy is same as voltage source. Minimum value 
is 1 % of range, or 20 mV in 200 mV range.

• Over range: 101 % of source range for 1.5 A and 3 A ranges. 105 % of source 
range other than 1.5 A and 3 A ranges. No over range for 200 V range with 
current exceeding 105 mA pulse only condition.

• Over temperature protection: Output turns off then resets at over temperature 
sensed internally.
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Voltage Source. 

• Settling time:

Time required to reach within 0.1 % of final value at open load condition. Step is 
+10 % to +90 % range.

200 mV and 2 V ranges: < 50 s

20 V range: < 110 s

200 V range: < 700 s

• Slew rate and small signal bandwidth: See Table 2-11. Slew rate and small 
signal bandwidth can be down to -20 % in maximum.

• Noise 10 Hz to 20 MHz:  3 mVrms, 20 V range, without external filter

• Overshoot:

< (0.1 % + 10 mV), step is +10 % to +90 % range, resistive load.

• Range change overshoot:

 250 mV, 100 k load, 20 MHz bandwidth

• Line regulation/load regulation: Included in voltage source specifications.

• Load transient recovery time: Time to recover to within the settling band 
following a load change. See Table 2-12.

Current Source. 

• Settling time:

Time required to reach within 0.1 % (0.3 % for 3 A range) of final value at short 
condition. Step is +10 % to +90 % range.

10 nA and 100 nA ranges: < 10 ms

1 A range: < 500 s

10 A and 100 A ranges: < 250 s

1 mA to 3 A ranges: < 80 s

• Slew rate and small signal bandwidth: See Table 2-13. Slew rate and small 
signal bandwidth can be down to -20 % in maximum.

• Overshoot:

< 0.1 % (< 0.3 % for 3 A range), step is +10 % to +90 % range, resistive load.
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• Range change overshoot:

 250 mV/R load, 20 MHz bandwidth

• Line regulation/load regulation: Included in current source specifications.

Table 2-11 Slew Rate and Small Signal Bandwidth for Voltage Source

Table 2-12 Load Transient Recovery Time

Current 
range

Voltage range
Load 

resistance
200 mV 2 V 20 V 200 V

1 mA 44 mV/s, 
28 kHz

57 mV/s, 
18 kHz

57 mV/s, 
28 kHz

57 mV/s, 
28 kHz

10 M

10 mA 44 mV/s, 
28 kHz

360 mV/s, 
20 kHz

360 mV/s, 
17 kHz

360 mV/s, 
28 kHz

10 M

100 mA 28 mV/s, 
28 kHz

28 mV/s, 
20 kHz

28 mV/s, 
28 kHz

57 mV/s, 
28 kHz

10 M

1 A 25 mV/s, 
28 kHz

25 mV/s, 
28 kHz

25 mV/s, 
28 kHz

 10 M

1.5 A 36 mV/s, 
28 kHz

36 mV/s, 
18 kHz

36 mV/s, 
28 kHz

 10 M

3 A 27 mV/s, 
28 kHz

27 mV/s, 
28 kHz

27 mV/s, 
28 kHz

 10 M

100 mA current changea

a. At a load change to change the flowing current from +50 mA to +150 
mA, 10 V voltage force, 20 V range, 1 A limit.

800 mA current changeb

b. At a load change to change the flowing current from +100 mA to +900 
mA, 10 V voltage force, 20 V range, 1.5 A limit.

Settling band 20 mV 20 mV

Time 10 s 30 s
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Table 2-13 Slew Rate and Small Signal Bandwidth for Current Source

High Capacitance Mode

The high capacitance mode supports measurements when the load capacitance is 
greater than 0.01 F. In the high capacitance mode, the maximum allowed load 
capacitance value is 50 F.

• Voltage output settling time:

Time required to reach within 0.1 % of final value with 4.7 F capacitive load 
on a fixed range at specified current limit value.

200 mV and 2 V ranges: 600 s, at 1 A limit

20 V range: 1.5 ms, at 1 A limit

200 V range: 20 ms, at 100 mA limit

• Current measurement settling time:

Time required to reach within 0.1 % of final value after voltage source is 
stabilized on fixed range. Vout is 5 V unless noted.

1 A range: 230 ms

10 A and 100 A ranges: 23 ms

Current 
range

Voltage range
Load 

resistance
200 mV 2 V 20 V 200 V

1 mA 94 V/s, 
21 kHz

160 V/s, 
21 kHz

160 V/s, 
21 kHz

150 V/s, 
21 kHz

100 

10 mA 94 V/s, 
21 kHz

670 V/s, 
21 kHz

900 V/s, 
21 kHz

900 V/s, 
21 kHz

100 

100 mA 8 mV/s, 
10 kHz

8 mV/s, 
10 kHz

8 mV/s, 
10 kHz

12 mV/s, 
21 kHz

1 

1 A 78 mV/s, 
12 kHz

94 mV/s, 
12 kHz

92 mV/s, 
12 kHz

 0.1 

1.5 A 125 mV/s, 
12 kHz

135 mV/s, 
12 kHz

140 mV/s, 
12 kHz

 0.1 

3 A 250 mV/s, 
13 kHz

270 mV/s, 
13 kHz

260 mV/s, 
13 kHz

 0.041 
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1 mA and 10 mA ranges: 0.23 ms

100 mA to 3 A ranges: 100 s

• Mode change delay:

• Delay into high capacitance mode:

1 A range: 230 ms

10 A and 100 A ranges: 23 ms

1 mA to 3 A ranges: 1 ms

• Delay out of high capacitance mode:

All ranges: 10 ms

• Noise 10 Hz to 20 MHz (20 V range): 4.5 mVrms

• Voltage source range change overshoot (20 V range or below):

< 250 mV, 20 MHz bandwidth

• High capacitance mode working conditions:

• V/I mode: Voltage source mode only

• Range: Current measurement range is limited to fixed range only. 10 nA and 
100 nA ranges are not available.

• Current limit:  1 A

Programmable Output Resistance

In its default state the Agilent B2961A/B2962A behaves like either an ideal voltage 
source with a negligibly small source resistance or an ideal current source with a 
huge source resistance. The programmable output resistance feature allows you to 
specify either a particular output resistance or a specific voltage vs. current source 
characteristic. This feature is ideal for emulating a wide variety of devices (such as 
batteries, photovoltaic cells, sensors, transducers, etc.) that are otherwise difficult to 
simulate.

• Mode: Constant or V/I Emulation

• Programmable resistance range: 

• Series resistance (Rs) at voltage source: 

-Load resistance/2  Rs  Load resistance, for resistive load
2- 24 Agilent B2961A/B2962A User’s Guide, Edition 2



Introduction
Specifications
Rs  25  at 3 A range,  100  at 1 A and 1.5 A ranges,  1 k at 100 mA 
range, or  10 k at other ranges, Rs can be limited by capacitive load.

• Shunt resistance (Rsh) at current source:

Load resistance  Rsh  2 G, for resistive load

Rsh  10 M at 10 nA and 100 nA ranges,  1 M at other ranges, Rsh can 
be limited by capacitive load.

• Emulation mode: 

Emulation mode allows you to program a non-linear resistance. You specify the 
desired voltage/current characteristic using a tabular format.

Maximum number of points: 16 (piecewise linear interpolation between points)

* Programmable Output Resistance is only available for DC output.

External Low Noise Filter Supplemental Characteristics

The Agilent B2961A/B2962A supports dedicated external low-noise filters; they are 
available as an option or as an accessory. They connect to the banana jack outputs of 
each Agilent B2961A/B2962A channel.

Ultra Low Noise Filter (N1294A-021)

• Maximum output range: 42 V / 105 mA (DC)

• Output connector: BNC

• Output/residual resistance: 50  nominal (2-wire), 0.3  nominal (4-wire. 
4-wire connected inside of filter)

• Small signal bandwidth: 23 Hz nominal (2-wire), 8 Hz nominal (4-wire) 

• Voltage noise (20 V / 100 mA range, 50  load, 10 Hz to 20 MHz): 10 Vrms, 
1 nVrms/Hz1/2 at 10 kHz. Also see Figure 2-3. Source specification is applied 
for less than 10 Hz.

• Current noise (20 V / 100 mA range, 10  load, 10 Hz to 1 MHz): 300 nArms 
Source specification is applied for less than 10 Hz.

• Settling time: See Table 2-14.

• Load transient recovery time: Time to recover to within the settling band 
following a load change. See Table 2-15.

• Supported ranges:
Agilent B2961A/B2962A User’s Guide, Edition 2 2- 25



Introduction
Specifications
Voltage: 200 mV to 200 V ranges, 42 V maximum

Current: 10 A to 100 mA ranges, 105 mA maximum

• Maximum capacitive load: 50 F for 4-wire

• Dimensions: 41 mm (H)  58.2 mm (W)  141.5 mm (D)

When the filter is inserted to the output connector of B2961A/B2962A, the 
depth is 126.5 mm.

• Weight: 0.3 kg

The 10 A pulse range and programmable output resistance capability are not 
supported by external filters.

Figure 2-3 Noise Density

Table 2-14 Settling Time

2-wire 4-wire

Voltage sourcea

a. Time required to reach within 0.1 % of final value at open load condition. 
Step is +10 % to +90 % range. At 20 V range, 100 mA limit, 100 mA 
range.

80 ms 140 ms

Current sourceb 11 ms 150 ms

20 V

2 V range
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Table 2-15 Load Transient Recovery Time

Low Noise Filter (N1294A-022)

• Maximum output range: 210 V / 3 A (DC)

• Output connector and connection: Banana, 2-wire/4-wire

• Output/residual resistance: 0.3  nominal (2-wire)

• Small signal bandwidth: 2 kHz nominal (1 A and 3 A ranges), 800 Hz nominal 
(100 mA range)

• Voltage noise (20 V / 1.5 A range, 50  load, 10 Hz to 20 MHz): 350 Vrms 
Source specification is applied for less than 10 Hz.

• Current noise (20 V / 1.5 A range, 0.67  load, 10 Hz to 1 MHz): 450 Arms 
Source specification is applied for less than 10 Hz.

• Settling time: See Table 2-16.

• Load transient recovery time: Time to recover to within the settling band 
following a load change. See Table 2-17.

• Supported ranges:

Voltage: 200 mV to 200 V ranges, 210 V maximum

Current: 10 A to 3 A ranges, 3 A maximum

• Maximum capacitive load: 1 mF

• Dimensions: 41.5 mm (H)  58.2 mm (W)  127.5 mm (D)

When the filter is inserted to the output connector of B2961A/B2962A, the 
depth is 112.5 mm.

• Weight: 0.25 kg

b. Time required to reach within 0.1 % of final value at short condition. 
Step is +10 % to +90 % range. At 100 mA range, 20 V limit, 20V range.

50 mA current changea

a. At a load change to change the flowing current from +10 mA to +60 mA, 
10 V voltage force, 20 V range, 100 mA limit.

Settling band 20 mV

Time 50 ms for 2-wire, 85 ms for 4-wire
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The 10 A pulse range and programmable output resistance capability are not 
supported by external filters.

Table 2-16 Settling Time

Table 2-17 Load Transient Recovery Time

2-wire / 4-wire

Voltage sourcea

a. Time required to reach within 0.1 % of final value at open load condition. 
Step is +10 % to +90 % range. At 20 V range, 1.5 A limit, 1.5 A range.

640 s

Current sourceb

b. Time required to reach within 0.1 % of final value at short condition. 
Step is +10 % to +90 % range. At 1.5 A range, 20 V limit, 20V range.

1.2 ms

800 mA current changea

a. At a load change to change the flowing current from +100 mA to +900 
mA, 10 V voltage force, 20 V range, 1.5 A limit.

Settling band 20 mV

Time 450 s for 2-wire, 650 s for 4-wire
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Built-in Voltage/Current Monitor Specifications

• Voltage measurement specifications: See Table 2-18.

• Current measurement specifications: See Table 2-19.

Table 2-18 Voltage Measurement Specifications

Table 2-19 Current Measurement Specifications

Range
Measurement 

resolution
Accuracy 

(gain error (% of reading) + offset error)

200 mV 10 V (0.015 % + 225 V)

2 V 100 V (0.02 % + 350 V)

20 V 1 mV (0.015 % + 5 mV)

200 V 10 mV (0.015 % + 50 mV)

Range
Measurement 

resolution
Accuracy 

(gain error (% of reading) + offset error)

10 nA 1 pA (0.10 % + 50 pA)

100 nA 10 pA (0.06 % + 100 pA)

1 A 100 pA (0.025 % + 500 pA)

10 A 1 nA (0.025 % + 1.5 nA)

100 A 10 nA (0.02 % + 25 nA)

1 mA 100 nA (0.02 % + 200 nA)

10 mA 1 A (0.02 % + 2.5 V)

100 mA 10 A (0.02 % + 20 V)

1 A 100 A (0.03 % + 1.5 mA)

1.5 A 100 A (0.05 % + 3.5 mA)

3 A 1 mA (0.4 % + 7 mA)

10 Aa

a. 10 A range is available only for pulse mode, not available for DC mode.

1 mA (0.4 % + 25 mA)b

b. Measurement speed: 0.01 PLC
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Built-in Voltage/Current Monitor Supplemental 
Characteristics

• Temperature coefficient (0 C to 18 C and 28 C to 50 C):

(0.1  accuracy specification) / C

• Over range:

102 % of measurement range for 1.5 A and 3 A ranges. 106 % of measurement 
range other than 1.5 A and 3 A ranges.

• Voltage measurement range change overshoot:

< 250 mV, 100 k load, 20 MHz bandwidth

• Current measurement range change overshoot:

< 250 mV/R load, 20 MHz bandwidth

• Derating accuracy for measurement speed less than 1 PLC:

Add % of range shown in Table 2-20 for measurement with PLC < 1.

Table 2-20 Derating Accuracy with PLC Setting < 1 PLC

Data Buffer

A data buffer is an array of measurement elements. Each element holds the 
following values.

• Source setting

• Time stamp

• Measurement value

• Status

Maximum buffer size: 100,000 points/channel

PLC 
setting

Voltage range Current range

0.2 V 2 V to 200 V 10 nA 100 nA 1 A to 100 mA 1 A to 3 A

0.1 PLC 0.01 % 0.01 % 0.1 % 0.01 % 0.01 % 0.01 %

0.01 PLC 0.05 % 0.02 % 1 % 0.1 % 0.05 % 0.02 %

0.001 PLC 0.5 % 0.2 % 5 % 1 % 0.5 % 0.2 %
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Triggering and Timing Specifications

Triggering

• Digital I/O trigger in to trigger out1:  5 s

• Digital I/O trigger in to source change1:  5 s

• LXI Trigger in to source change1: Minimum 100 s, Typical 200 s, Maximum 
Unknown

• LXI Trigger in to measurement1: Minimum 100 s, Typical 200 s, Maximum 
Unknown

• Internal event to external LXI trigger output1: Minimum 100 s, Typical 200 s, 
Maximum Unknown

• LAN[0-7] Event Receiving Latency1: Unknown

• LAN[0-7] Event Sending Latency1: Unknown

• Minimum trigger interval: 10 s

Timer

• Trigger timing resolution: 1 s to 100 ms

• Timer accuracy: 50 ppm

• Arm/trigger delay: 0 to 100,000 s

• Arm/trigger interval: 10 s to 100,000 s

• Arm/trigger event: 1 to 100,000

• Time stamp: TIMER value automatically saved when each measurement is 
triggered.

1. Supplemental characteristics
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General Specifications

• Environment: For use in indoor facilities

• Temperature range

Operating 0 C to +55 C

Storage -30 C to +70 C

• Humidity range

Operating 30 % to 80 % RH, non-condensing

Storage 10 % to 90 % RH, non-condensing

• Altitude

Operating 0 m to 2,000 m (6,561 ft.)

Storage 0 m to 4,600 m (15,092 ft.)

• Power requirement: 100-240 V (±10 %), 50/60 Hz

• Maximum volt-amps (VA): 250 VA

• Cooling: Forced air. Side intake and rear exhaust.

• EMC

IEC 61326-1 / EN 61326-1

ICES/NMB-001

AS/NZS CISPR 11

KC: RRA Notification amending Radio Waves Act Article 58-2

• Safety

IEC 61010-1 / EN 61010-1

CAN/CSA-C22.2 No. 61010-1

• Dimensions

Without handle and feet: 88 mm (H)  213 mm (W)  450 mm (D)

Bench configuration (with handle and feet): 180 mm (H)  260 mm (W)  480 
mm (D)

• Weight

B2961A: 5.0 kg, B2962A: 6.4 kg
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Operation and Functions

Front Panel Interface

4.3” color TFT WQVGA (480272, with LED backlight) provides a graphical user 
interface (GUI) with the following features.

• Single, Dual view, and time domain view (voltage vs time or current vs time) on 
Graph view

• Preview of output waveform

• Easy-to-use key operations

• Easy access to basic and advanced source/measurement capabilities

Single view

Single view provides basic and advanced settings and display capabilities for a 
selected channel from the front panel of the instrument. The DC, pulse and 
integrated arbitrary waveform generation capabilities do not require any additional 
controller or software. The GUI has a feature that allows you to preview an arbitrary 
waveform before application. It also displays the measured voltage and current for 
the selected channel with 4.5 digits of resolution.

Dual view

Dual view allows you to view both channels simultaneously and provides basic 
setting and display capabilities. It also displays the measured voltage and current for 
both channels 1 and 2 with 4.5 digits of resolution. This mode is available only for 
the B2962A.

Graph View

Graph View displays measurement results in the time-domain (V-t or I-t curves) for 
up to 2 channels. This is useful for quick checking and debug of the output 
waveform(s).

Easy-to-use Key Operations

• Numeric/alpha keys, assist keys, and rotary knob for easy operation

• Numeric/alpha keys enable direct input of alphanumeric values.

• Assist key guides operation on the front panel.
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Easy Access to Source/Measurement Capabilities

• Settings:

• V/I source mode

• Source value

• Limit value

• Sweep parameters

• Pulse parameters

• Parameters for built-in waveform

• Measure speed

• Range setting

• Trigger setting

• Displays:

• Numeric display in 6 1/2 digits for sourcing

• Numeric display in 4 1/2 digits for monitoring

• V-t / I-t curve in Graph view

• Advanced Capabilities:

• Trace memory for accumulating measurement (or math) result and collecting 
their statistics

• File Operations (USB memory):

Save:

• System configuration

• Measurement/math result

• Trace data

• Graph screen dump

Load:

• System configuration

• List sweep data

• User-defined arbitrary waveform data
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Program and Interface Capabilities

Programming Language

The B2961A/B2962A supports SCPI (Standard Commands for Programmable 
Instruments).

Program Memory

Program memory allows you to store long strings of SCPI command lines once into 
the B2961A/B2962A's volatile memory and then recall those strings multiple times 
while the program is executing using a single SCPI command. By storing the 
command strings in memory, the time that would have been spent sending those 
same commands over a communication bus is eliminated. For tests that utilize lots 
of repeated code (such as subroutines), program memory can dramatically reduce 
test times.

• Maximum number of characters of program name: 32 with alphabets, numbers, 
hyphens, and underscores

• Maximum memory size: 100 KB (2500 lines typical)

LXI

LXI core conformant. The B2961A/B2962A follows specified LAN protocols and 
adhere to LXI requirements such as a built-in Web control server and IVI-COM 
driver.

• Ethernet: 10/100Base-T

• USB2.0: USB-TMC488 protocol (rear  1)

• GPIB: IEEE-488.2 compliant

USB File System

USB 2.0 high-speed mass storage (MSC) class device (front  1)
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Digital I/O Interface

• Connector: 25-pin female D

• Input/output pins: 14 open drain I/O bits

• Absolute maximum input voltage: 5.25 V

• Absolute minimum input voltage: -0.25 V

• Logic low maximum input voltage: 0.8 V

• Logic high minimum input voltage: 2.0 V

• Maximum source current: 1 mA, Vout = 0 V

• Maximum sink current: 50 mA, Vout = 5 V

• 5 V power supply pin:

Limited to 600 mA, solid state fuse protected

• Safety interlock pin:

One active high pin and one active low pin. Activation of both pin enables 
output voltage > 42 V.
2- 36 Agilent B2961A/B2962A User’s Guide, Edition 2



Introduction
Software and Drivers
Software and Drivers
• Agilent B2900A Quick I/V Measurement Software

The B2961A/B2962A includes PC-based Agilent B2900A Quick I/V 
Measurement Software. This powerful software makes it easy to quickly setup 
and perform I/V measurements and to display the measurement data in a table or 
graph without the need to perform any programming. The software allows you 
to control up to four channels over a GPIB or LAN connection, or one B2900 
via a USB connection.

System requirements:

• Windows 7 (64 bit/32 bit), XP SP3 (32 bit)

• Microsoft .NET framework 4.0 or later

• Agilent IO Libraries 16.0 or later

• Graphical Web Interface

The Graphical Web Interface is a web browser based instrument control panel. It 
enables you to set up and perform a measurement easily and quickly from a web 
browser using the built-in web server. This allows you to control one B2900 
over a LAN connection.

• IVI-C or IVI-COM drivers

Compatible with Windows 7 (64 bit/32 bit), XP SP3 (32 bit) IO Libraries 16.0 or 
later. Supports Agilent VEE, Microsoft Visual Studio (Visual Basic, Visual C++, 
Visual C#), National Instruments LabWindows and LabVIEW.

• LabVIEW driver (VI)

National Instruments LabVIEW 7.0 or later. LabView drivers are available at 
NI.COM.

NOTE For the latest system requirements, go to www.agilent.com and type in B2961A or 
B2962A in the Search field at the top of the page. 
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Furnished Accessories

The Agilent B2961A/B2962A is furnished with the following accessories.

• Quick Reference, 1 ea.

• Product Reference CD-ROM, 1ea.

• Agilent IO Libraries CD-ROM, 1ea.

• Power cord, 1 ea.

• USB cable, 1 ea.

The Product Reference CD-ROM stores Agilent B2900A Quick I/V Measurement 
Software, sample programs, and user manuals.

Available Accessories

Table 2-21 lists the available accessories for the Agilent B2961A/B2962A.

Table 2-21 Available Accessories

Model Number Option Item Description 

N1294A Accessories

N1294A-001 Banana to triaxial adapter for 2-wire connections

N1294A-002 Banana to triaxial adapter for 4-wire connections

N1294A-011 Interlock cable for 16442B, 1.5 m

N1294A-012 Interlock cable for 16442B, 3.0 m

N1294A-021 Ultra Low Noise Filter for B2961A/B2962A

N1294A-022 Low Noise Filter for B2961A/B2962A

N1294A-031 GPIO-BNC Trigger Adapter

N1295A Device/Component Test Fixture
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16442B Test Fixture

16442B-010 Add triaxial cables, 1.5 m, 4 ea.

16442B-011 Add triaxial cables, 3 m, 4 ea.

16442B-800 Extra blank PTFE board

16442B-801 Universal socket module, 0.1 inch pitch, with 10 pins

16442B-802 Universal socket module, 0.075 inch pitch, with 10 pins

16442B-803 Universal socket module, 0.05 inch pitch, with 10 pins

16442B-810 Extra pin set (for universal socket module, 10 pins.)

16442B-811 Extra wire set (mini banana to pin plug, 6 ea.)

16442B-812 Extra wire set (pin plug to pin plug, 6 ea.)

16442B-813 Extra wire set (mini banana to mini clip, 6 ea.)

16442B-814 Extra wire set (mini banana to mini banana, 6 ea.)

16442B-821 Socket module, 4-pin TO package

16442B-822 Socket module, 18-pin DIP package

16442B-823 Extra socket module, 28-pin DIP package

16442B-890 Extra accessory case

16493G Digital I/O Connection Cable

16493G-001 1.5 m length

16493G-002 3.0 m length

16494A Triaxial Cable

16494A-001 1.5 m length

16494A-002 3 m length

16494A-003 80 cm length

Model Number Option Item Description 
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Table 2-22 lists the options for the Agilent B2961A/B2962A.

Table 2-22 Options

Option Description 

External Low Noise Filter

LN1 Ultra low noise filter, 42V/105mA, 50  (N1294A-021)

LN2 Low noise filter, 210V/3A (N1294A-022)

Calibration

A6J ANSI Z540 compliant calibration

UK6 Commercial calibration certificate with test data

Printed Manual (User’s Guide)

ABA English

ABJ Japanese

Rack Mount Kit

1CM Rack mount kit
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Installation
This chapter describes how to install Agilent B2961A/B2962A and accessories and 
consists of the following sections.

• “Inspecting the Shipment”

• “Installing the Agilent B2961A/B2962A”

• “Maintenance”

• “Connecting a DUT”

• “Installing the Interlock Circuit”

• “Connecting to the Interfaces”

• “Communicating Over the LAN”

• “Using Digital I/O”

WARNING To avoid electrical shock and instrument damage, turn the instrument off 
before connecting or disconnecting measurement cable.

WARNING There are potentially hazardous voltages (210 V) present at the High Force, 
High Sense, and Guard terminals of this instrument. To prevent electrical 
shock, the following safety precautions must be observed during the use of the 
instrument.

• Use a three-conductor AC power cord to connect the cabinet (if used) and 
the instrument to an electrical ground (safety ground).

• If you do not use the Agilent 16442B test fixture, you must install and 
connect an interlock circuit that opens the interlock terminal when the 
shielding box access door is opened.

• Confirm periodically that the interlock function works normally.

• Before touching the connections on the High Force, High Sense, and Guard 
terminals, turn the instrument off and discharge any capacitors. If you do 
not turn the instrument off, complete all of the following items, regardless 
of the instrument settings.

• Press the On/Off switch, and confirm that the switch turns off.

• Confirm that the On/Off switch does not turn red.

• Open the shielding box access door (open the interlock terminal).

• Discharge any capacitors connected to a channel.

• Warn persons working around the instrument about dangerous conditions.
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Inspecting the Shipment 
Perform the following inspections when the Agilent B2961A/B2962A and 
accessories arrive at your site.

1. Before unpacking any component, inspect all boxes for any signs of damage that 
might have occurred during shipment, such as:

• dents

• scratches

• cuts

• water marks

If you suspect any damage, contact your nearest Agilent Sales and Support 
Office.

2. When you open the boxes that contain the B2961A/B2962A and accessories, 
check the components against the contents lists attached to the boxes.

If anything is missing, contact your nearest Agilent Sales and Support Office.

3. Verify the operation of B2961A/B2962A as described in “Checking the 
Operation of Agilent B2961A/B2962A”.

If any problem occurs, contact your nearest Agilent Sales and Support Office.

Checking the Operation of Agilent B2961A/B2962A

1. Make sure that the line switch is set to off.

2. Connect the power cord from the B2961A/B2962A’s rear panel AC input 
connector (receptacle) to an AC power outlet at your site.

3. Press the line switch to turn on the instrument. 

The initialization screen will appear on the B2961A/B2962A’s front panel 
display, and the power-on self-test is automatically executed. 

If the B2961A/B2962A is operating normally, the front panel LCD displays as 
shown in Figure 3-1 or 3-2.
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Figure 3-1 Display Example for 1-ch Model

Figure 3-2 Display Example for 2-ch Model

Checking for Errors

Errors can be checked as described below.

1. Press the More > System > Error > Log function keys. This opens the Error Log 
dialog box.

2. Check the errors displayed on the dialog box.

If no error is detected, “0, No Error” is displayed.

3. Press the OK softkey to close the dialog box.
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Installing the Agilent B2961A/B2962A
This section describes information you must pay attention to when installing the 
Agilent B2961A/B2962A.

• “Safety Considerations”

• “Environment”

• “Connecting the Power Cord”

• “Setting the Power Line Frequency”

• “Bench Installation”

• “Rack Installation”

Safety Considerations

Refer to the Safety Summary page at the beginning of this guide for general safety 
information. Before installation or operation, check the B2961A/B2962A and 
review this guide for safety warnings and instructions. Safety warnings for specific 
procedures are located at appropriate places throughout this guide.

Environment

WARNING Do not operate the instrument in the presence of flammable gasses or fumes

Environmental conditions for B2961A/B2962A are documented in “General 
Specifications” on page 2-32. In principle, B2961A/B2962A should only be 
operated indoors in a controlled environment.

The dimensions of B2961A/B2962A are also given in “General Specifications”. Fan 
cools the instrument by drawing air through the sides and exhausting it out the back. 
The instrument must be installed in a location that allows sufficient space at the 
sides and back of the instrument for adequate air circulation.

Connecting the Power Cord

WARNING FIRE HAZARD: Use only the power cord supplied with your instrument. 
Using other types of power cord may cause overheating of the power cord, 
resulting in fire.
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SHOCK HAZARD: The power cord provides the chassis ground through a 
third conductor. Be sure to connect to a three-conductor type power outlet with 
the correct pin grounded.

NOTE The detachable power cord may be used as an emergency disconnecting device. 
Removing the power cord will disconnect AC input power to the instrument.

Connect the power cord to the IEC 320 connector on the rear of the instrument. If 
the wrong power cord was shipped with your instrument, contact your nearest 
Agilent Sales and Support Office.

The AC input on the back of your instrument is a universal AC input. It accepts 
nominal line voltages in the range of 100 to 240 VAC.

Setting the Power Line Frequency

The power line frequency must be set properly for the AC power at your site. Press 
the following function keys to set the frequency to 50 Hz or 60 Hz.

• For setting to 50 Hz: More > System > PLC > 50 Hz

• For setting to 60 Hz: More > System > PLC > 60 Hz

Bench Installation

Do not block the air intake at the sides and the exhaust at the rear of the B2961A/ 
B2962A. Minimum clearances for bench operation are 5 mm along the sides and 
100 mm along the back.

For easier display viewing and measurement terminal access, you can tilt up the 
front of the instrument by turning the handle. To adjust the handle, grab the handle 
by the sides and pull outward. Then, rotate the handle to the desired position.
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Rack Installation

NOTE Use the Rack Mount kit (Option 1CM) to rack mount the Agilent B2961A/B2962A.

Agilent B2961A/B2962A can be mounted in a 19-inch EIA rack cabinet. It is 
designed to fit in two rack-units (2U) of space.

Remove the front and rear rubber bumpers and the handle before rack mounting the 
B2961A/B2962A.

Do not block the air intake at the sides and the exhaust at the rear of the B2961A/ 
B2962A.

Removing the Bumper

Stretch a corner of the rubber bumper and slide it off. 

Removing the Handle

1. Grab the handle by the sides and pull outward. This will allow you to rotate the 
handle.

2. Rotate the handle to a vertical position. Then, position the instrument 
horizontally.

3. Pull outward and then lift the handle upward.

CAUTION When reattaching the handle, pay attention to its direction. Incorrect attachment 
may damage the hardware.

1 1

2

3
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Option 900

• Plug: BS 1363/A, 
250 V, 10 A

• PN: 8120-4420

Option 901

• Plug: AS/NZS 3112, 
250 V, 10 A

• PN: 8120-4419

Option 902

• Plug: IEC 60277-1, 
250 V, 10 A

• PN: 8121-1226

Option 903

• Plug: NEMA 5-15P, 
125 V, 10 A

• PN: 8120-6825

Option 904

• Plug: NEMA 6-15P, 
250 V, 10 A

• PN: 8120-3996

Option 906

• Plug: SEV 1011, 
250 V, 10 A

• PN: 8120-4416

Option 912

• Plug: SB 107-2-D1, 
250 V, 10 A

• PN: 8121-1655

Option 917

• Plug: IS 1293 and 
IS 6538, 250 V, 10 A

• PN: 8121-1690

Option 918

• Plug: JIS C 8303, 
125 V, 12 A

• PN: 8121-0743

Option 919

• Plug: Israel SI 32, 
250 V, 10 A

• PN: 8121-0724

Option 920

• Plug: IRAM 2073, 
250 V, 10 A

• PN: 8121-0725

Option 921

• Plug: CEI 23-16, 
250 V, 10 A

• PN: 8121-0722

Option 922

• Plug: GB 1002 
figure 3, 250 V, 10 A

• PN: 8120-8376

Option 923

• Plug: SANS 164-1, 
250 V, 10 A

• PN: 8121-0564

Option 927

• Plug: NEMA WD-6, 
250 V, 10 A

• PN: 8120-0674

Option 930

• Plug: NBR 14136, 
250 V, 10 A

• PN: 8121-1809

Option 931

• Plug: CNS 10917-2, 
125 V, 10 A

• PN: 8121-1635

Option 932

• Plug: CS 0017, 
250 V, 10 A

• PN: 8121-1638
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Maintenance
Maintenance should be performed periodically to keep the Agilent B2961A/ 
B2962A in good condition. If problems arise, contact your nearest Agilent Sales and 
Support Office.

• “Cleaning”

• “Self-test”

• “Self-calibration”

• “Calibration”

Cleaning

WARNING SHOCK HAZARD: To prevent electric shock, unplug the B2961A/B2962A 
before cleaning.

Use a dry cloth or a cloth slightly dampened with water to clean the external case 
parts. Do not use detergents or chemical solvents. Do not attempt to clean internally.

Self-test

Agilent B2961A/B2962A provides the self-test function to check the operation. The 
self-test is automatically performed when the instrument is turned on. It is 
recommended to perform the self-test for the following condition or purpose. Before 
performing the self-test, turn the channel output off and disconnect test leads and 
cables from the terminals.

• If a channel is in the lock condition due to over temperature

In this condition, the Emergency dialog box is displayed on the gray background 
screen, however this is not shown in the remote status if the remote display is set 
to OFF. And the ERR indicator turns on and the On/Off switch is not effective. 

Perform the self-test to unlock the channel. The channel can be used soon if the 
self-test does not report any problem. 

• If you feel that the instrument may be defective

• For preventive maintenance
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To perform 
self-test

The following procedure shows how to perform the self-test.

1. If it is in the remote state, press the Cancel / Local key.

2. Press the On/Off switch and confirm that the switch turns off.

3. Disconnect test leads and cables from the channel terminals.

4. Press the following function keys.

More > System > Cal/Test > Self-Test

Confirmation dialog box is opened.

5. Press the OK key. This starts the self-test.

Self-calibration

Agilent B2961A/B2962A provides the self-calibration function to maintain the 
measurement performance. If the environmental temperature changes 3 C or 
more, perform the self-calibration. This is effective for the accurate measurements 
by minimizing the effect of thermal drift. The self-calibration must be performed 
after warming-up of 60 minutes. Before performing the self-calibration, turn the 
channel output off and disconnect test leads and cables from the terminals.

To perform 
self-calibration

The following procedure shows how to perform the self-calibration.

1. If it is in the remote state, press the Cancel / Local key.

2. Press the On/Off switch and confirm that the switch turns off.

3. Disconnect test leads and cables from the channel terminals.

4. Press the following function keys.

More > System > Cal/Test > Self-Cal

Confirmation dialog box is opened.

5. Press the OK key. This starts the self-calibration.

Calibration

Calibration and adjustments must be performed periodically so that the instruments 
satisfy the specifications, and keep a good condition. It is recommended to perform 
the calibration once a year at least. For the calibration and adjustments, contact your 
nearest Agilent Sales and Support Office. Trained service personnel will perform the 
calibration and adjustments.
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Connecting a DUT
This section describes how to connect a device under test (DUT) to the Agilent 
B2961A/B2962A source/measure terminals.

NOTE Set the channel output off when changing the connections. If not, the DUT may be 
damaged.

To set the channel output off, press the On/Off switch and confirm that the switch 
LED turns off.

This section includes the following descriptions.

• “2-Wire Connections or 4-Wire Connections”

• “Floating”

• “Using Test Leads”

• “Using the N1294A-021/022 Low Noise Filter”

• “Using the N1295A Test Fixture”

• “Using the 16442B Test Fixture”

• “Guarding”

NOTE Connecting the interlock circuit

B2961A/B2962A provides an interlock function to prevent the user from receiving 
an electrical shock from high voltages over 42 V. If the Digital I/O interlock 
terminal is open, B2961A/B2962A cannot apply a high voltage.

For high voltage measurement, connect the interlock terminal to the interlock circuit 
as described in “Installing the Interlock Circuit”.

WARNING Handling device under test (DUT) and terminal area

To prevent electrical shock caused by touching the end of the extension cable or 
the terminal area with the DUT, cover over the conductors with insulator. Also, 
protect the cable end and the DUT by using the grounded shield cover and 
such.

DUT may have a temperature by performing measurement. Pay attention to 
not only residual charge but temperature when handling the DUT.
Agilent B2961A/B2962A User’s Guide, Edition 2 3- 11



Installation
Connecting a DUT
2-Wire Connections or 4-Wire Connections

When connecting a DUT, you can choose the connection type either 2-wire 
connections or 4-wire connections.

If you want to simplify the connections, use 2-wire connections by connecting the 
Force terminals only and opening the Sense terminals. The Force terminals can be 
used to apply and measure voltage or current.

To apply voltage accurately, use 4-wire connections, remote sensing, well known as 
Kelvin connections. Connecting the Force and Sense lines together at the device end 
eliminates the voltage drop caused by the residual resistance of the test leads or 
cables.

To specify the connection type (Sensing Type), perform the following procedure.

1. Press the Config > Source > Connection function keys. This opens the Output 
Connection dialog box.

2. Set the Sensing Type on this dialog box. Choose 2-WIRE for 2-wire 
connections, or 4-WIRE for 4-wire connections.

3. Press the OK softkey. For 4-wire connections, the following indicator appears 
on the Single view or the Dual view.

4-wire connection indicator: 

Figure 3-3 Dual View, 4-Wire Connection Setup for Channel 1
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Floating

With the default setting, Low Force terminal is connected to the chassis ground. 
However, it can be internally disconnected from the ground for making the floating 
condition. This setup is used for connecting the source channels in series. 

To specify the low terminal status, perform the following procedure. Setting is not 
saved. Turning off the instrument sets the status to the grounded.

1. Press the Config > Source > Connection function keys. This opens the Output 
Connection dialog box.

2. Set the Low Terminal State on this dialog box. It must be FLOATING for the 
floating status, or GROUNDED for the grounded status.

3. Press the OK softkey.

For the floating status, the following indicator appears on the status information 
area. And then the Low Force and Low Sense terminals can be connected to the 
maximum of 250 V.

Channel 1 floating status indicator: 

Channel 2 floating status indicator: 

Figure 3-4 Dual View, Floating Status for Channels 1 and 2

CAUTION Do not apply current to the chassis ground. Doing so will damage the instrument.

WARNING Potentially hazardous voltages of up to 250 V may be present at the Low 
Force and Low Sense terminals. To prevent electrical shock, use accessories 
that comply with IEC 61010-2-031. All terminals and the extended conductors 
must be isolated by using insulation caps, sleeves, etc.
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Using Test Leads

B2961A/B2962A source/measure terminals use banana jacks. For connecting a 
DUT, the following test leads are available. Figure 3-5 shows the connections for 
two-terminal device measurements.

• Agilent U8201A Combo Test Lead Kit

Couple of test leads, test probes, alligator clips, SMT grabbers, fine-tips test 
probes, and banana plugs, CAT III 1000 V, 15 A maximum

Two kits are required for 4-wire connections.

• Agilent 11059A Kelvin Probe Set

Test leads for 4-wire connections, 42 V maximum

Figure 3-5 Connecting a Two-Terminal Device

High Sense

High Force

Low Force

Low Sense

DUT

High Force

Low Force

DUT

2-wire connections 4-wire connections
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Using the N1294A-021/022 Low Noise Filter

The following filters are available for the B2961A/B2962A to reduce undesirable 
noise and to obtain clean output signal. See Figure 3-6 for their top and connector 
panels. Also see “Output Filter and External Filter” on page 6-12 for more 
information.

• Agilent N1294A-021 Ultra Low Noise Filter

Noise level (20 V range, 10 Hz to 20 MHz): 10 Vrms

Noise level (100 mA range, 10 Hz to 1 MHz): 300 nArms

Maximum voltage/current: 42 V / 105 mA (DC)

Output: BNC

• Agilent N1294A-022 Low Noise Filter

Noise level (20 V range, 10 Hz to 20 MHz): 350 Vrms

Noise level (1.5 A range, 10 Hz to 1 MHz): 450 Arms

Maximum voltage/current: 210 V / 3 A (DC)

Output: Banana

Preparation To use the low noise filter, perform the following procedure. This setting is saved to 
the non-volatile memory.

1. Press the Config > Source > Ext. Filter function keys. This opens the External 
Output Filter dialog box.

2. Set the External Filter State on this dialog box to ON.

3. Set the External Filter Type on this dialog box to ULNF for using the ultra low 
noise filter (N1294A-021) or LNF for using the low noise filter (N1294A-022).

4. Press the OK softkey.

The following indicator appears on the Single view or the Dual view. And then 
the filter can be connected to the output terminal.

Ultra low noise filter indicator: 

Low noise filter indicator: 
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Figure 3-6 N1294A-021/022 Low Noise Filter

 

Output

± 42 V Max, ± 105 mA Max

N1294A Opt 021
Ultra Low Noise Filter 42 V/105 mA

Push the adapter in firmly until it
locks in-place(< 1mm spacing)

± 42 V Max

HSHS HF LF LS

Filter

Guard

N1294A Opt 022
Low Noise Filter 210 V/3 A

Push the adapter in firmly until it
locks in-place(< 1mm spacing)

± 250 V Max

HS HFHS LF LS

Filter

Guard

±210 V Max

High
Sense

High
Force

Low
Sense

Low
Force
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Connections 1. Attach the filter tightly to the B2961A/B2962A source/measure terminals. Note 
that the contact is not enough if the connection looks like “Bad connection” 
shown in Figure 3-7.

2. Use appropriate cable or test leads to connect the output of the filter.

CAUTION Connecting N1294A-021 Ultra Low Noise Filter

If the External Filter Type is set to LNF or the External Filter State is set to OFF, 
never connect the N1294A-021 to the B2961A/B2962A. Doing so, the B2961A/ 
B2962A can apply its maximum voltage/current, and may damage the N1294A-021. 

If the External Filter Type is set to ULNF and the External Filter State is set to ON, 
the B2961A/B2962A output is limited to the N1294A-021’s maximum 
voltage/current (42 V / 105 mA).

WARNING For using the floating condition, see “Floating” on page 3-13.

If the N1294A-021 ultra low noise filter is used, you can touch the outer 
conductor of the output connector (BNC). To prevent electrical shock, cover 
over the outer conductor with insulator.
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Using the N1295A Test Fixture

Agilent N1295A is a test fixture which has four triaxial connectors and which 
supports two 2-wire connections.

Requirements • Agilent N1295A test fixture furnished with pin clip wire 4 ea. and pin plug wire 
2 ea.

• Agilent N1294A-001 banana to triaxial adapter for 2-wire connections

• Triaxial cable, 2 ea. for one 2-wire connection

Connections 1. Attach the banana to triaxial adapter to the B2961A/B2962A source/measure 
terminals. See Figure 3-7. If there is some space as “Bad connection”, the 
contact is not enough.

2. Connect the triaxial cables between the adapter and N1295A as shown in Figure 
3-8.

3. Connect the DUT between terminals 1 and 2 for the example in Figure 3-8.

Figure 3-7 Attaching Banana to Triaxial Adapter

Figure 3-8 Agilent N1295A Connection Example

NOTE Shielding

N1295A is equipped with a lid. To minimize the effect of ambient noise, close the 
lid when performing measurements.

Bad connectionGood connection (no space)

1

1

2

3

4

3
2

4

± 42V � 1.05 A Max

Low Force

High Force

DUT
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CAUTION Maximum voltage and current

The test fixture and adapters must be used under the following limitations to prevent 
damage.

Agilent N1294A-001: 250 V maximum, 42 V maximum for connecting N1295A

Agilent N1294A-002: 250 V maximum, 42 V maximum for connecting N1295A

Agilent N1295A: 42 V, 1.05 A maximum

Using the 16442B Test Fixture

Agilent 16442B is a test fixture which has six triaxial connectors for source/measure 
unit (SMU), the GNDU connector for the ground unit of a parameter/device 
analyzer, the Intlk connector for the interlock control, and six coaxial connectors for 
other instruments. See Agilent 16442B User’s Guide for details and accessories of 
the 16442B.

Requirements • Agilent 16442B test fixture furnished with pin clip wire, pin plug wire, etc.

• Agilent N1294A-001 banana to triaxial adapter for 2-wire connections

• Agilent N1294A-002 banana to triaxial adapter for 4-wire connections

• Triaxial cable, 2 ea. for 2-wire connections, and 3 ea. for 4-wire connections

NOTE Shielding

16442B is equipped with a lid. To minimize the effect of ambient noise, close the lid 
when performing measurements.

CAUTION Maximum voltage and current

The test fixture and adapters must be used under the following limitations to prevent 
damage.

Agilent N1294A-001: 250 V maximum, 200 V maximum for connecting 16442B

Agilent N1294A-002: 250 V maximum, 200 V maximum for connecting 16442B

Agilent 16442B: 200 V, 1 A maximum for SMU input
Agilent B2961A/B2962A User’s Guide, Edition 2 3- 19



Installation
Connecting a DUT
Connections 1. Attach the banana to triaxial adapter to the B2961A/B2962A source/measure 
terminals. See Figure 3-7. If there is some space as “Bad connection”, the 
contact is not enough.

2. Connect the triaxial cables between the adapter and the 16442B. Figure 3-9 
shows a connection example.

3. Connect the DUT on the 16442B wiring panel by using the 16442B’s furnished 
accessories, socket module, blank board, and wire suitable for the DUT.

Figure 3-10 shows the connection example for the connections of Figure 3-9.

For 2-wire connections, connect the SMU 1 Force terminal to a DUT terminal, 
and connect the SMU 2 Force terminal to the other DUT terminal.

For 4-wire connections, connect the SMU 1 Force and Sense terminals to a DUT 
terminal. And connect the SMU 3 Sense and Guard terminals to the other DUT 
terminal if the adapter’s Low Force/Low Sense connector is connected to the 
SMU 3 Sense connector. The Low Force signal appears on the Guard terminal.

Figure 3-9 Connection Example between N1294A and 16442B

Figure 3-10 Connection Example of 16442B Wiring Panel

N1294A-001 Adapter
for 2-wire connections

N1294A-002 Adapter
for 4-wire connections

to SMU 2
       Force

to SMU 1 Force to SMU 1 Forceto SMU 1 Sense

to SMU 3 Sense
(or GNDU)

Low Force/
Low Sense

High Sense High Force

Low Force

High Force

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

DUT

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

2-wire connections 4-wire connections

DUT

(or GNDU Sense) (or GNDU Force)
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NOTE Performing high voltage measurement

When the Digital I/O interlock terminal is open, B2961A/B2962A cannot apply 
high voltage over 42 V. To perform high voltage measurements, B2961A/B2962A 
must be connected to the interlock circuit installed in 16442B. 

Prepare the N1294A-011 or 012 interlock cable, and connect it between the 
B2961A/B2962A Digital I/O connector and the 16442B Intlk connector. 
B2961A/B2962A can apply a high voltage when the test fixture lid is closed.

WARNING Potentially hazardous voltages of up to 210 V may be present at the High 
Force, High Sense, and Guard terminals when the 16442B test fixture lid is 
closed. To prevent electrical shock, do not expose these lines.
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Guarding 

Guarding reduces the leakage current between the instrument and a DUT. This is 
important when you measure a low current.

Figure 3-11 shows the theory of guarding. The buffer amplifier (1) keeps the 
potential of the Guard conductor at the same potential as the High Force conductor, 
so that the current does not flow between the High Force and Guard conductors. 
Therefore, the current measured by the instrument is the same as the current at the 
DUT terminal because no current is leaked.

For the connection examples shown in Figures 3-8 and 3-9, the guard is extended to 
the test fixture input connectors with triaxial cables.

Figure 3-11 Guarding

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2961A/B2962A.

A
Buffer

Guard High Force DUT
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Installing the Interlock Circuit 
The interlock circuit is a simple electric circuit, as shown in Figure 3-12. The circuit 
electrically opens when an access door is opened, and closes when the door is 
closed.

B2961A/B2962A cannot apply high voltages over 42 V when the Digital I/O 
interlock terminal is open. To perform high voltage measurements, the 
B2961A/B2962A interlock terminal must be connected to the interlock circuit 
installed in the measurement environment such as the shielding box. The interlock 
circuit is important and necessary to prevent electrical shock when the user touches 
the measurement terminals.

WARNING Potentially hazardous voltages of up to 210 V may be present at the High 
Force, High Sense, and Guard terminals when the interlock circuit is closed. 
To prevent electrical shock, do not expose these lines.

Requirements • LED (Agilent part number 1450-0641), 1 ea.

• Mechanical switch (Agilent part number 3101-0302 or 3101-3241), 2 ea.

• Resistor, 500  to 1 k (choose lower one to get higher output of LED), 1 ea.

• 25-pin D-sub connector (for wiring, mounted on the shielding box), 1 ea.

• Connection wire

• 25-pin D-sub cable, 1 ea.

Figure 3-12 Interlock Circuit

Mechanical switches

Shielding box

LED

Access door

D-sub connector

Interlock circuit B2961A/B2962A
Digital I/O

15, 19

14

17, 18

16

24, 25

Dsub cable

15, 19

22, 23

16, 17

24

14

Negative Positiveor

22R

R: 500 Ω to 1 kΩ

25R
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Procedure 1. Mount two mechanical switches onto your shielding box, so that the switches 
close when the access door is closed, and open when the door is opened. See 
Figure 3-14 and Figure 3-15 for the switch dimensions.

2. Mount an LED onto your shielding box. See Figure 3-13 for the LED 
dimensions.

The LED is used as a high voltage indicator which is lit when B2961A/B2962A 
is in the high voltage output status.

3. Mount a D-sub connector onto your shielding box.

4. Use a wire and short the following pins of the D-sub connector. See Figure 3-12 
for a connection example.

For the negative logic: Pins 24 and 25

For the positive logic: Pins 16 and 17

5. Use a wire and connect the two switches in series between the following pins of 
the D-sub connector. See Table 3-1 for the Digital I/O pin assignment.

For the negative logic: Pins 16 and some ground pins

The ground pins are pin numbers 15 and 17 to 21.

For the positive logic: Pins 24 and some +5 V pins

The +5 V pins are pin numbers 22, 23, and 25.

6. Use a wire and connect the LED between the pin 14 and some ground pins of the 
D-sub connector. Then set the pin 14 to HIGH VOLTAGE LAMP. See “DIO 
Configuration dialog box” on page 4-43.

Figure 3-13 Dimensions of the LED (Agilent part number 1450-0641) 
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7. Connect a resistor between the pin 14 and an unused +5 V pin.

Figure 3-14 Dimensions of the Interlock Switch (Agilent part number 3101-0302) 

Figure 3-15 Dimensions of the Interlock Switch (Agilent part number 3101-3241) 
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Connecting to the Interfaces

CAUTION Electrostatic discharges greater than 1 kV near the interface connectors may cause 
the unit to reset and require operator intervention.

B2961A/B2962A supports GPIB, LAN, and USB interfaces. All three interfaces are 
live at power-on. Connect your interface cable to the appropriate interface 
connector. Information on configuring the interfaces can be found later in this 
section.

The front panel display’s LAN indicator is lit when the LAN port is connected and 
configured.

B2961A/B2962A provides Ethernet connection monitoring. With Ethernet 
connection monitoring, the instrument’s LAN port is continually monitored and 
automatically reconfigured.

GPIB/USB Interfaces

NOTE For detailed information about GPIB and USB interface connections, refer to 
Connectivity Guide installed with the Agilent IO Libraries.

The following steps will help you quickly get started connecting your instrument to 
the GPIB (General Purpose Interface Bus). The following figure illustrates a typical 
GPIB interface system.

Connect to GPIB interface
card installed in PC.

Connect to GPIB
port on instrument. InstrumentInstrument

Instrument

PCGPIB cable
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1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. If you do not have a GPIB interface card installed on your computer, turn off 
your computer and install the GPIB card.

3. Connect your instrument to the GPIB interface card using a GPIB interface 
cable.

4. Use the Connection Expert utility from the Agilent IO Libraries Suite to 
configure the installed GPIB interface card’s parameters.

5. B2961A/B2962A is shipped with its GPIB address set to 23. To view or change 
the GPIB address, press the More function key, then the I/O > GPIB softkeys. 
The GPIB Configuration dialog box appears.

To change the GPIB address, use the rotary knob or the arrow keys, and press 
OK to set the value.

6. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments.

The following steps will help you quickly get started with connecting your 
USB-enabled instrument to the USB (Universal Serial Bus). The following figure 
illustrates a typical USB interface system.

1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. Connect the USB device port located on the back of your instrument to the USB 
port on your computer.

3. With the Connection Expert utility from the Agilent IO Libraries Suite running, 
the computer will automatically recognize the instrument. This may take several 
seconds. When the instrument is recognized, your computer will display the 
VISA alias, IDN string, and VISA address. This information is located in the 
USB folder.

Connect to USB
port on PC.

Connect to USB
port on instrument.

Instrument

PC

USB cable
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You can also view the instrument’s VISA address from the front panel. Press the 
More function key, then the I/O > USB softkeys. The VISA address is shown in 
the USB Status dialog box.

4. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments.

LAN Interface

NOTE For detailed information about LAN interface connections, refer to Connectivity 
Guide installed with the Agilent IO Libraries.

The following steps will help you quickly get started with connecting and 
configuring your instrument on a local area network.

Connecting to a Site LAN

A site LAN is a local area network in which LAN-enabled instruments and 
computers are connected to the network via routers, hubs, and/or switches. They are 
typically large, centrally-managed networks with services such as DHCP and DNS.

1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. Connect the instrument to the site LAN. The factory-shipped instrument LAN 
settings are configured to automatically obtain an IP address from the network 
using DHCP (DHCP is enabled). Note that this may take up to one minute. The 
DHCP server will register the instrument’s hostname with the dynamic DNS 
server. The hostname as well as the IP address can then be used to communicate 
with the instrument. The front panel display’s LAN indicator will turn green 
when the LAN port has been configured successfully, or turn red if the 
configuration fails.

To network
interface card (NIC).

Connect to LAN
port on instrument.

Instrument

PC

LAN cable

To site LAN
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NOTE If you need to manually configure any instrument LAN settings, see “LAN 
Configuration dialog box” on page 4-43 for information about configuring the LAN 
settings from the front panel of the instrument.

3. Use the Connection Expert utility from the Agilent IO Libraries Suite to add the 
B2961A/B2962A and verify the connection. To add the instrument, you can 
request Connection Expert to discover the instrument. If the instrument cannot 
be found, add the instrument using the instrument’s hostname or IP address.

NOTE If this does not work, refer to the troubleshooting section in the Agilent 
Technologies USB/LAN/GPIB Interfaces Connectivity Guide.

4. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments. You can also use the Web browser on your computer to connect to 
the instrument as described under “Using the Graphical Web Interface”.

Viewing the Active LAN Status

To view the currently active LAN settings, press the More function key, then the I/O 
> LAN > Status softkeys. The LAN status dialog box appears.

Note that the currently active LAN settings for the IP Address, Subnet Mask, and 
Default Gateway may be different from the settings specified in the LAN 
Configuration dialog box, depending on the configuration of the network. If the 
settings are different, it is because the network has automatically assigned its own 
settings.

Modifying the LAN Settings

As shipped from the factory, B2961A/B2962A’s pre-configured settings should 
work in most LAN environments. If you need to manually configure these settings, 
press the More function key, then the I/O > LAN > Config softkeys. The LAN 
Configuration dialog box appears.

NOTE B2961A/B2962A must be rebooted if the host name is changed.

For the LAN setup parameters, see “LAN Configuration dialog box” on page 4-43.
Agilent B2961A/B2962A User’s Guide, Edition 2 3- 29



Installation
Communicating Over the LAN
Communicating Over the LAN

Using the Graphical Web Interface

Your Agilent B2961A/B2962A has a built-in graphical web interface that lets you 
control it directly from an Web browser on your computer. Multiple simultaneous 
connections are allowed, but only from one computer. With additional connections, 
performance will be reduced. Multiple connections from multiple computers are not 
allowed.

With the graphical web interface, you can access the front panel control functions 
including the LAN configuration parameters. This is a convenient way to 
communicate with the B2961A/B2962A without using I/O libraries or drivers.

NOTE The built-in graphical web interface only operates over the LAN interface. It 
requires Internet Explorer 6+ or Firefox 2+. You will also need the Java Plug-in. 
This is included in the Java Runtime Environment. Refer to Sun Microsystem’s 
website. If you are using Internet Explorer 7, open a separate browser window for 
each connection.

The graphical web interface is enabled when shipped.

JP00XXXXXX

JP00XXXXXX

Agilent B2961A Power Source -

XXXXXXXXXX

B2961A

169.254.5.2

A-B2961A-50000

TCPIP::XXXXXXXXXX.local::inst0::INSTR

XXXXXXXXXX.local.

TCPIP::XXXXXXXXXX.local::hislip0::INSTR
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 To launch the graphical web interface:

1. Open a Web browser on your computer.

2. Enter the instrument’s hostname or IP address into the browser’s Address field 
to launch the graphical web interface. The B2961A/B2962A home page will 
appear.

3. Click on the Browser Web Control button in the navigation bar on the left to 
begin controlling your instrument.

4. For additional help about any page, click “Help with this Page”.

If desired, you can control the access to the graphical web interface using password 
protection. As shipped from the factory, the password is set to agilent. To change the 
password, click on the View & Modify Configuration button. Refer to the online 
help for additional information about setting the password.

Using Telnet

The Telnet utility (as well as sockets), is another way to communicate with 
B2961A/B2962A without using I/O libraries or drivers. In all cases, you must first 
establish a LAN connection from your computer to the B2961A/B2962A as 
previously described.

In an MS-DOS Command Prompt box, type “telnet hostname 5024” where 
hostname is the B2961A/B2962A’s hostname or IP address, and 5024 is the 
instrument’s telnet port. You should get a Telnet session box with a title indicating 
that you are connected to the B2961A/B2962A. Type the SCPI commands at the 
prompt.

Using Sockets

NOTE Agilent B2961A/B2962A allows any combination of up to four simultaneous data 
socket, control socket, or telnet connections to be made.

Agilent instruments are standardized on using port 5025 for SCPI socket services. A 
data socket on this port can be used to send and receive ASCII/SCPI commands, 
queries, and query responses. All commands must be terminated with a newline for 
the message to be parsed. All query responses will also be terminated with a 
newline.
Agilent B2961A/B2962A User’s Guide, Edition 2 3- 31



Installation
Communicating Over the LAN
The socket programming interface also allows control socket connections. The 
control socket can be used by a client to send device clear and to receive service 
requests. Unlike the data socket, which uses a fixed port number, the port number 
for a control socket varies and must be obtained by sending the following SCPI 
query to the data socket: SYSTem:COMMunicate:TCPip:CONTrol?

Once the port number is obtained, a control socket connection can be opened. As 
with the data socket, all commands to the control socket must be terminated with a 
newline, and all query responses returned on the control socket will be terminated 
with a newline.

To send a device clear, send the string “DCL” to the control socket. When the 
B2961A/B2962A has finished performing the device clear, it will echo the string 
“DCL” back to the control socket.

Service requests are enabled for control sockets using the Service Request Enable 
register. Once service requests have been enabled, the client program listens on the 
control connection. When SRQ becomes true, the instrument will send the string 
“SRQ +nn” to the client. The “nn” is the status byte value, which the client can use 
to determine the source of the service request.
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B2961A/B2962A has a Digital I/O connector, D-sub 25 pin female, for general 
purpose input/output (GPIO). It can be used for:

• Trigger input

• Trigger output

• Digital signal input/output

• Digital signal input

• Interlock control

• High voltage status output (shared with the digital signal input/output DIO 14)

The pin assignment of the Digital I/O connector is shown in Table 3-1. Pins DIO 1 
to DIO 14 can be assigned to one of the above functions, except for interlock 
control. To set the DIO functions, press the More function key, then the I/O > DIO > 
Config softkeys. For details, see “DIO Configuration dialog box” on page 4-43.

Figure 3-16 shows the input/output circuits internally connected to each pin of the 
Digital I/O connector.

For the available accessory, see “Accessory for Digital I/O Connector” on page 
3-35.

Figure 3-16 Digital I/O Internal Circuit
Vcc

to Digital I/O
connector

R1
R2

from Output control Vcc: +5 V
R1: 5 kohm
R2: 100 ohm

to Input control
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Table 3-1 Digital I/O Pin Assignment

Description Pin Number Description

+5 V a

a. Current limit: 600 mA (total current to the pins 22, 23, and 25)

25 13 DIO 13 (bit 13)

Interlock control b

b. Used for the positive logic. Connected to the pin 25 for the negative 
logic.

24 12 DIO 12 (bit 12)

+5 V a 23 11 DIO 11 (bit 11)

+5 V a 22 10 DIO 10 (bit 10)

GND 21 9 DIO 9 (bit 9)

GND 20 8 DIO 8 (bit 8)

GND 19 7 DIO 7 (bit 7)

GND 18 6 DIO 6 (bit 6)

GND 17 5 DIO 5 (bit 5)

Interlock control c

c. Used for the negative logic. Connected to the pin 17 for the positive 
logic.

16 4 DIO 4 (bit 4)

GND 15 3 DIO 3 (bit 3)

DIO 14 (bit 14) or 
High voltage status

14 2 DIO 2 (bit 2)

1 DIO 1 (bit 1)
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Accessory for Digital I/O Connector

The following accessory is available for the Digital I/O connector.

• Agilent N1294A-031 GPIO-BNC Trigger Adapter

This adapter is used to change the Digital I/O connector to the trigger input/ 
output BNC connectors. The BNC connectors are internally connected to the 
DIO pins 9 and 10.

This adapter can be connected directly to the Digital I/O connector.

Figure 3-17 N1294A-031 GPIO-BNC Trigger Adapter

NOTE Interlock terminals

If the N1294A-031 adapter is connected to the Digital I/O connector, the Interlock 
terminals are opened. Then the B2961A/B2962A output voltage is limited to 42 V.

To use the interlock function, see “Installing the Interlock Circuit” on page 3-23 and 
extend the Interlock terminals. They can be extended from the adapter internal board 
through the opening of the adapter top cover.

N1294A Opt 031
GPIO-BNC Trigger Adapter

DIO 10 DIO 9
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Front Panel Reference
This chapter provides the reference information of the Agilent B2961A/B2962A 
front panel keys and display.

• “Hard Keys and Rotary Knob”

• “Display and Assist Keys”

• “Function Keys”

• “Config key group”

• “Function key group”

• “Trigger key group”

• “Result key group”

• “File key group”

• “Program key group”

• “I/O key group”

• “Display key group”

• “System key group”

NOTE If measurement is not performed properly, check the trigger setting. The trigger type 
must be set to AUTO, or the trigger count (Count) must be set properly. See 
“Trigger Parameters” on page 4-19.
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Hard Keys and Rotary Knob

Line switch Turns the instrument on or off.

Trigger Starts a single (one shot) output/measurement or initiates trigger system. If a repeat 
measurement is in progress, stops it.

The single measurement is performed with the DC bias output, pulsed bias output, 
arbitrary waveform output, staircase sweep output, or pulsed sweep output set to the 
channel. One single measurement can contain the maximum of 100000 
measurement points.

Once a single measurement starts, the data buffer (maximum 100000 data) is 
cleared, and the last single measurement result is stored in the buffer. The 
measurement result is displayed on the Single view, Dual view, or Graph view. Also 
the last single measurement result can be listed and displayed on the Measure Result 
dialog box.

Auto Starts a repeat (continuous) measurement. If a repeat measurement is in progress, 
stops it.

The repeat measurement is performed with the DC bias output of the Source value. 
And the measurement result is displayed on the Single view or Dual view. The 
repeat measurement result is not stored in the buffer.

The repeat measurement is performed with the following trigger setup. Settings of 
“Trigger Parameters” are ignored. 

• Acquire trigger (measurement trigger): Initiate

• ARM acquire count: Infinite

• ARM acquire source: AUTO (automatic internal)

• TRIGger acquire count (Measure Count) 100

• TRIGger acquire source (Measure Trigger): AUTO (automatic internal)

• TRIGger acquire timer period (Measure Period): 10 ms (this is automatically 
extended if the measurement is not completed.)

• Trigger delay (Source Delay=Measure Delay): 0 s

• Trigger output: Disable

View Changes the display mode. See “Display and Assist Keys” on page 4-5.
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Cancel / Local Cancels the setup operation if the instrument is in the local status. Returns the 
instrument to the local status if it is in the remote status.

On/Off Used to enable or disable the channel. Turns the channel off if it is in the output 
status even if it is in the remote status. One switch on 1-channel models, and two 
switches on 2-channel models.

The switch turns green if the channel is enabled.

The switch turns red if the channel is in the high voltage state.

Numeric/alpha 
keys

Used to enter the value for setup parameters such as the source output value, limit 
value, and message, specified by the field pointer. The value can be changed if the 
field pointer is in the EDIT (green) status.

Rotary knob If the field pointer is in the MOVE (blue) status, turning the knob moves the pointer. 
Pressing the knob fixes the pointer position and changes the pointer status to EDIT 
(green).

If the field pointer is in the EDIT (green) status, turning the knob changes the value 
of the setup parameter specified by the pointer. Pressing the knob fixes the value and 
changes the pointer status to MOVE (blue).

If the field pointer is in the EDIT (green) status on a setup field other than the 
Source field and the Limit field, turning the knob changes the setting value. The 
value is applied by pressing the knob.

If the field pointer is in the EDIT (green) status on the Source or Limit field, turning 
the knob changes the setting value of the source channel in real time.

If the digit pointer is on a digit of a numeric value entry field, turning the knob 
changes the value of the digit. Note that changing the value from 9 to 0 or from 0 to 
9 changes the value of the next digit.

If the digit pointer is on the decimal point of a numeric value entry field, turning the 
knob moves the decimal point if the Immediate V/I Update by Knob setup is OFF.

Left and right keys If the field pointer is in the MOVE (blue) status, pressing the key moves the pointer.

If the field pointer is in the EDIT (green) status, pressing the key changes the value 
of the setup parameter specified by the pointer.

If the field pointer is in the EDIT (green) status on a numeric value entry field, 
pressing the key changes the pointer to the digit pointer.

If the digit pointer is on a digit of a numeric value entry field, pressing the key 
moves the pointer on the digits.
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Display and Assist Keys
Agilent B2961A/B2962A provides several display modes which depend on the 
model as shown below. The display mode is changed by the View key. Pressing the 
key changes the mode as shown below.

On B2961A Single  Graph  (return to Single)

On B2962A Dual  Single for channel 1  Single for channel 2  Graph 
 (return to Dual)

For each display mode, five assist keys are available on the right side of the display. 
They are assigned to several softkeys such as Mode, Source, Limit, Measure, and 
More. The softkey assignment depends on the display mode.

For details of each display mode and assist keys, see the following sections.

• “Dual View”

• “Single View”

• “Graph View”

• “Status Information”

The status information is common for all display modes. It is displayed above the 
bottom softkeys associated with the function keys. This display area is also used to 
display system messages and error messages.
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Dual View

Available on B2962A. The upper half is for channel 1. The lower half is for channel 
2. Each area displays the measurement results, source and measurement settings, 
and channel status. Most setup parameters can be edited on this display.

Display area 1. Channel number. 1 or 2.

2. Output status (OFF, CV, CC, or EMUL)

CV: Constant Voltage

CC: Constant Current

EMUL: Emulation Table (this is displayed when programmable output 
resistance is set using the emulation table.)

3. Latest measurement data (4½ digit resolution)

4. High capacitance (HC) mode indicator

5. Programmable output resistance indicator

6. External filter indicator

7. Remote sensing (4-wire connection) status indicator

8. Source function. VOLTS or AMPS.

9. Source shape indicator. DC, waveform, pulse, sweep, or pulsed sweep. DC does 
not show the indicator.

10. Source output value (6½ digit resolution)

1 2 4 5 6 7 8 9

10

11

3

D1
D2

D1

D2
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11. Limit value

To set the V/I Limit for Each Polarity, see “Display Preference dialog box” on 
page 4-46.

D1. Primary measurement data. Turns orange if the data exceeds the Limit value.

D2. Secondary measurement data. Turns orange if the data exceeds the Limit value.

NOTE Measurement Range

Voltage source uses the present output range to measure voltage and/or the 
minimum range which covers the Limit value to measure current.

Current source uses the present output range to measure current and/or the minimum 
range which covers the Limit value to measure voltage.

Assist keys In the following descriptions, Ch n indicates Ch 1 or Ch 2.

Ch n Mode Changes the assist keys to VOLTS (V) and AMPS (I) used to 
select the source function.

VOLTS (V) sets the voltage source.

AMPS (I) sets the current source.

Ch n Source Changes the assist keys to the unit keys shown below.

V, mV, and V for the voltage source

pA, nA, A, mA, and A for the current source

First, enter or set the output value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Ch n Limit Changes the assist keys to the unit keys shown below.

pA, nA, A, mA, and A for the current limit

V, mV, and V for the voltage limit

First, enter or set the limit value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.
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Ch n Measure Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), 
WATTS (P), and %LIMIT (%) used to select the measurement 
function.

AMPS (I) sets the current measurement.

VOLTS (V) sets the voltage measurement.

OHMS (R) sets the resistance measurement.

WATTS (P) sets the power measurement.

%LIMIT (%) sets the percent-to-Limit measurement.

Resistance data is given by Resistance=Vmeas/Imeas.

Power data is given by Power=VmeasImeas.

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-18.

More... Changes the assist keys to Ch 1 assist keys or Ch 2 assist keys. 
Ch 1 assist keys are effective for channel 1. Ch 2 assist keys are 
effective for channel 2.
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Single View

Displays the measurement results, source and measurement settings, and channel 
status. Most setup parameters can be edited on this display. The lower half displays 
the setup parameters selected by Assist keys 2.

Display area 1. Channel number. 1 or 2.

2. Output status (OFF, CV, CC, or EMUL)

CV: Constant Voltage

CC: Constant Current

EMUL: Emulation Table (this is displayed when programmable output 
resistance is set using the emulation table.)

3. Latest measurement data (4½ digit resolution)

4. High capacitance (HC) mode indicator

5. Programmable output resistance indicator

6. External filter indicator

7. Remote sensing (4-wire connection) status indicator

8. Source function. VOLTS or AMPS.

9. Source shape indicator. DC, waveform, pulse, sweep, or pulsed sweep. DC does 
not show the indicator.

10. Source output value (6½ digit resolution)

1 2 4 5 6 7 8 9

10

11

3

D1
D2

12
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11. Limit value

To set the V/I Limit for Each Polarity, see “Display Preference dialog box” on 
page 4-46.

12. Output function (sweep and arbitrary waveform) parameters.

D1. Primary measurement data. Turns orange if the data exceeds the Limit value.

D2. Secondary measurement data. Turns orange if the data exceeds the Limit value.

NOTE Measurement Range

Voltage source uses the present output range to measure voltage and/or the 
minimum range which covers the Limit value to measure current.

Current source uses the present output range to measure current and/or the minimum 
range which covers the Limit value to measure voltage.

Assist keys 1 Mode Changes the assist keys to VOLTS (V) and AMPS (I) used to 
select the source function.

VOLTS (V) sets the voltage source.

AMPS (I) sets the current source.

Source Changes the assist keys to the unit keys shown below.

V, mV, and V for the voltage source

pA, nA, A, mA, and A for the current source

First, enter or set the output value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Limit Changes the assist keys to the unit keys shown below.

pA, nA, A, mA, and A for the current limit

V, mV, and V for the voltage limit

First, enter or set the limit value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Measure Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), 
WATTS (P), and %LIMIT (%) used to select the measurement 
function.

AMPS (I) sets the current measurement.
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VOLTS (V) sets the voltage measurement.

OHMS (R) sets the resistance measurement.

WATTS (P) sets the power measurement.

%LIMIT (%) sets the percent-to-Limit measurement.

Resistance data is given by Resistance=Vmeas/Imeas.

Power data is given by Power=VmeasImeas.

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-18.

More... Changes the assist keys to Assist keys 2.

Assist keys 2 Show Preview Changes display from channel setup to waveform preview.

Hide Preview Changes display from waveform preview to channel setup.

Show Options Displays the optional parameters shown in “Optional 
Parameters” on page 4-17, and changes the softkey label to 
Hide Options.

Hide Options Displays the function setup parameters shown in “Function 
Parameters” on page 4-12, and changes the softkey label to 
Show Options.

Show Pulse Displays the pulse setup parameters shown in “Pulse 
Parameters” on page 4-18, and changes the softkey label to 
Hide Pulse.

Hide Pulse Displays the function setup parameters shown in “Function 
Parameters” on page 4-12, and changes the softkey label to 
Show Pulse.

Show Trigger Displays the trigger setup parameters shown in “Trigger 
Parameters” on page 4-19, and changes the softkey label to 
Hide Trigger.

Hide Trigger Displays the function setup parameters shown in “Function 
Parameters” on page 4-12, and changes the softkey label to 
Show Trigger.

More... Changes the assist keys to Assist keys 1.

Softkey labels Show XXXX and Hide XXXX are switched by pressing the key.
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Function Parameters

The following setup parameters are available.

Function:  Output function. The following parameters are available.

OFF: DC output

LINEAR SINGLE: Linear single sweep output

LINEAR DOUBLE: Linear double sweep output

LOG SINGLE: Log single sweep output

LOG DOUBLE: Log double sweep output

LIST: List sweep output

ARB EXPONENT: Exponential waveform output

ARB RAMP: Ramp waveform output

ARB SINUSOID: Sinusoidal waveform output

ARB SQUARE: Square waveform output

ARB TRAPEZOID: Trapezoidal waveform output

ARB TRIANGLE: Triangle waveform output

ARB USER: User defined arbitrary waveform output

For details, see “Sweep Output” on page 6-9, “List Sweep” 
on page 6-10, and “Arbitrary Waveform Output” on page 
6-11.

Start:  Start value of sweep source or arbitrary waveform.

Stop: Stop value of sweep source.

Points: Number of sweep source steps.

Step: Step value of sweep source.

End: End value of arbitrary waveform.

Delay: Delay time of arbitrary waveform.
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Rise Time: Rise time of arbitrary waveform.

Peak Time: Peak time of arbitrary waveform.

Fall Time: Fall time of arbitrary waveform.

End Time: End time of arbitrary waveform.

Count: Number of waveforms to be generated in one device action.

Time: Time of exponential waveform.

T(tau): Time constant of exponential waveform.

Ramp: Ramp (rise) time of ramp waveform.

Amplitude: Amplitude value of sinusoidal waveform.

Offset: Offset value of sinusoidal waveform.

Frequency: Frequency of sinusoidal waveform.

Phase Out: Phase marker output status, ON or OFF, for sinusoidal 
waveform. ON enables trigger output at phase marker 
position.

Marker: Phase marker value, 0 to 360, in degree.

NOTE To use the trigger output, set trigger output condition by using SCPI commands. See 
Agilent B2961A/B2962A SCPI Command Reference.

List Sweep Setup

When the field pointer is in the EDIT (green) status on the LIST sweep 
Start/Stop/Points field, the following assist keys are available for setting the list 
sweep source.

Edit Opens the List Sweep dialog box used to set the list sweep 
source.

Load Opens the Load List Sweep Data dialog box used to load a list 
sweep data from a USB memory connected to the front panel 
USB-A connector.

• List Sweep dialog box

This dialog box provides the following GUI for setting the list sweep source. 

(data graph) Displays the shape of the list sweep output

Source Source function (VOLTS or AMPS)
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CH Channel number 1 or 2, only on 2-channel models

Points Number of data points

Max Maximum value

Min Minimum value

(data list) Lists the data index and the output value

When the field pointer is in the EDIT (green) status on the 
data index field, the following assist keys are available for 
adding/deleting an entry and scrolling the list: Append, 
Insert, Delete, Scroll +100, and Scroll -100.

When the field pointer is in the EDIT (green) status on the 
output value field, the following assist keys are available for 
specifying the unit: V, mV, and V (for VOLTS) or pA, nA, 
A, mA, and A (for AMPS).

• Load List Sweep Data dialog box

This dialog box provides the following GUI for loading a list sweep data from a 
file stored on a USB memory.

(data graph) Displays the shape of the list sweep data selected by the file 
list

Path Folder into which the list sweep data file is saved

Points Number of data points

Max Maximum value

Min Minimum value

(file list) List of the list sweep data file

The following data can be loaded as the list sweep data.

• Comma separated value format, file extension csv

• Carriage return or line feed separated value format, file extension txt

• Space separated value format in a line, file extension prn
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User Defined Waveform Setup

When the field pointer is in the EDIT (green) status on the ARB USER defined 
waveform Start/Stop/Points field, the following assist keys are available for setting 
the user defined waveform output.

Edit Opens the User Defined Waveform dialog box used to set the 
user defined waveform.

Load Opens the Load User Defined Waveform dialog box used to 
load a waveform data from a USB memory connected to the 
front panel USB-A connector.

• User Defined Waveform dialog box

This dialog box provides the following GUI for setting the user defined 
waveform output. 

(data graph) Displays the shape of the waveform output

Source Source function (VOLTS or AMPS)

CH Channel number 1 or 2, only on 2-channel models

Points Number of data points

Max Maximum value

Min Minimum value

(data list) Lists the data index, the output value, and trigger output 
on/off flag

When the field pointer is in the EDIT (green) status on the 
data index field, the following assist keys are available for 
adding/deleting an entry and scrolling the list: Append, 
Insert, Delete, Scroll +100, and Scroll -100.

When the field pointer is in the EDIT (green) status on the 
output value field, the following assist keys are available for 
specifying the unit: V, mV, and V (for VOLTS) or pA, nA, 
A, mA, and A (for AMPS).

When the field pointer is in the EDIT (green) status on the 
Trigger field, the following assist keys are available for 
switching the trigger output flag setting: ON and OFF.

NOTE To use the trigger output, set trigger output condition by using SCPI commands. See 
Agilent B2961A/B2962A SCPI Command Reference.
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• Load User Defined Waveform dialog box

This dialog box provides the following GUI for loading a waveform data from a 
file stored on a USB memory.

(data graph) Displays the shape of the waveform data selected by the file 
list

Path Folder into which the waveform data file is saved

Points Number of data points

Max Maximum value

Min Minimum value

(file list) List of the waveform data file

The following data can be loaded as the waveform data.

• Comma separated value format, file extension csv

• Carriage return or line feed separated value format, file extension txt

• Space separated value format in a line, file extension prn
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Optional Parameters

Measure Speed:  Measurement speed. AUTO (1 PLC for 10 nA and 100 nA 
ranges, 0.01 PLC for other ranges), SHORT (0.01 PLC), 
MEDIUM (0.1 PLC), NORMAL (1 PLC), LONG (10 PLC), 
or MANUAL. The aperture time is automatically set to the 
above values in parentheses. For the aperture time, see 
“Measurement Time” on page 6-5. 

For the MANUAL speed, the aperture time must be set to 
the right field in seconds or PLC (power line cycle, number 
of power line cycles per measurement). Move the field 
pointer to the one by using the arrow keys or rotary knob and 
press the knob to set the pointer to the EDIT mode. Enter or 
set the value by using the numeric/alpha keys, knob, or 
arrow keys, then press the knob or one of the unit keys to 
apply the value. For setting the seconds value, the following 
unit keys are available as assist keys.

s, ms, and s

Source Ranging:  Selects the ranging mode AUTO or FIXED used for the DC 
(constant) source operation.

The right field is used to set the range value for the FIXED 
range operation, or the minimum range value for the AUTO 
range operation. For the available range values, see “Output 
and Measurement Ranges” on page 2-11.

Output R: Selects the operation mode OFF, CONST (constant), or 
EMUL (emulation) of the programmable output resistance 
function.

See “Programmable Output Resistance” on page 6-13 for 
more information.
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Pulse Parameters

B2961A/B2962A can be used as a pulse source, and supports pulsed output and 
measurement. Pulse ON or OFF can be selected by using the assist keys displayed 
when the field pointer is in the EDIT (green) status on the Pulse field.

The following setup parameters are available.

Peak Sets the pulse peak value. Not available for the sweep source 
which sets the sweep output value to the pulse peak. 

The pulse base value is set to the source output value in the 
upper half of the display area. See “Single View” on page 4-9.

Delay Sets the pulse delay time. The pulse source changes the output 
level from the base value to the peak value when the delay time 
elapsed after trigger delay.

Width Sets the pulse width.

When the field pointer is in the EDIT (green) status on an entry field, the assist keys 
are changed to the unit keys as shown below.

pA, nA, A, mA, and A for the peak current

V, mV and V for the peak voltage

s, ms, s, and ks for the delay and width
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Trigger Parameters

The B2961A/B2962A supports the following trigger types for triggering source 
output and measurement. They are effective for setting triggers easily.

The trigger type can be selected by using the assist keys displayed when the field 
pointer is in the EDIT (green) status on the Trigger field. See Table 4-1 for the 
trigger types and the setup parameters. 

AUTO Automatic trigger type

SYNC Synchronize trigger type

TIMER Timer trigger type

MANUAL Manual trigger type

The following setup parameters are available for setting the source output trigger 
(transient action) by using the Source column, and the measurement trigger (acquire 
action) by using the Measure column.

Count Trigger count (number of triggers), 1 to 100000 or INF. 
(infinity). This value is automatically set for the AUTO trigger 
type. For the other trigger type, set the number of triggers 
required for each source output and measurement properly. For 
example, set Source Count = Measure Count = 10 for the sweep 
measurement with 10 steps.

Delay Sets the trigger delay time.

Period Sets the trigger period.

Trigger Selects the trigger source by using the assist key AUTO, BUS, 
TIMER, INTm (only for 2-channel model), LAN, or EXTn, 
where m is the integer 1 or 2, and n is an integer from between 1 
and 14. See Table 4-1 for the trigger sources.

When the field pointer is in the EDIT (green) status on the Delay or Period field, the 
assist keys are changed to the unit keys as shown below.

s, ms, s, and ks
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Table 4-1 Trigger Types and Setup Parameters

Trigger=AUTO automatically selects the trigger source best suited for the present 
operating mode by using internal algorithms. 

Trigger=BUS uses the remote interface trigger command such as GET, TRIGger, 
and *TRG. 

Trigger=TIMER uses a signal internally generated every interval set by the Period 
parameter. 

Trigger=INT1 or INT2 uses a signal from the internal bus 1 or 2, respectively.

Trigger=LAN uses the LXI trigger.

Trigger=EXTn uses a signal from the DIO pin n which is an output port of the 
Digital I/O D-sub connector on the rear panel. n=1 to 14.

NOTE Setting trigger parameters in detail

For details of the trigger system, see Figure 6-7 on page 6-27.

The Single view provides the trigger types and parameters effective for setting 
triggers easily. If you want to set the trigger parameters in detail, select the 
MANUAL trigger type and use the Trigger Configuration dialog box opened by 
pressing the Trigger > Config function keys. See “Trigger key group” on page 4-33.

The Single view does not contain the setup parameters for the arm layer, but 
contains the setup parameters for the trigger layer. The Single view setup is given 
priority over the trigger layer setup on the Trigger Configuration dialog box. Hence, 
the overlapped parameter values on the dialog box are ignored.

Type Count Delay Period Trigger

AUTO set 
automatically

0 second N.A. AUTO

SYNC entered value entered value N.A. AUTO

TIMER entered value entered value entered value TIMER

MANUAL entered value entered value entered value selected value
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Graph View

Displays the graph for plotting the channel 1 and/or 2 measurement or math result. 
The Graph view can plot up to 5000 data.

Display area 1. Graph display status ON or OFF. Only on 2-channel models. [n] is for channel n.

2. Y-axis data type I (A), V (V), R (), P (W), or MATH (see Table 4-2)

3. Y-axis scale LINEAR or LOG 

4. X-axis scale LINEAR or LOG. X-axis data type is always time t (s).

5. Graph maximum value 

6. Graph minimum value 

7. Channel 1 and/or 2 source output value, limit value, or none (controlled by the 
Ch n Source, Ch n Limit, or Hide Ch n assist key)

8. Channel 1 and/or 2 Y-axis data at the active X-cursor position. ----.---- is 
displayed for the no-data position.

9. Cursor data (controlled by the Show Cursors or Hide Cursors assist key)

First line Positions and distance (e.g. I1, I2, A) of Y-cursors 1 and 2

Second line Positions and distance (t1, t2, t) of X-cursors 1 and 2

1 2 4

5

6

7

8

9

3
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Table 4-2 Y Axes Data Types for Graph View

Assist keys Auto Scale Changes graph scale to fit the trace in the graph automatically.

Dump Screen Opens the File Selection (Dump Screen) dialog box which is 
used to save the screen dump as a JPEG file.

The file can be saved onto a USB memory connected to the 
front panel USB-A connector. The file is saved with the 
specified name. If the file extension is not specified, “.jpg” is 
added automatically.

Show Cursors Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and 
cursor data) and changes the softkey label to Hide Cursors.

Hide Cursors Hides the cursors and changes the softkey label to Show 
Cursors.

Ch n Source Displays the channel n source output value and changes the 
softkey label to Ch n Limit.

Ch n Limit Hides the channel n source output value and displays the limit 
value. Also changes the softkey label to Hide Ch n.

Hide Ch n Hides the channel n limit value and changes the softkey label to 
Ch n Source.

In the above descriptions, Ch n indicates Ch 1 or Ch 2.

Data type Assist key Description

I (A) AMPS (I) Current data

V (V) VOLTS (V) Voltage data

R () OHMS (R) Resistance data

P (W) WATTS (P) Power data

MATH MATH Math result data
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NOTE If the number of data exceeds 5000

If the number of measurement data exceeds 5000, the Graph view plots the 
following data. where, n is integer, 1 to 5000.

Number of data is 5001 to 10000: [2*(n-1)+1]th data

Number of data is 10001 to 25000: [5*(n-1)+1]th data

Number of data is 25001 to 50000: [10*(n-1)+1]th data

Number of data is 50001 to 100000: [20*(n-1)+1]th data
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Status Information

The status information is common for all display modes. It is displayed above the 
bottom softkeys associated with the function keys.

Table 4-3 Status Indicator

Label Color Description

AUTO white Trigger auto. Automatic trigger is enabled now.

ARM white Trigger active. Trigger system is active now.

HV yellow High voltage. Output voltage setting is over 42 V.

Channel 1 floating status. Channel 1 is not grounded.

Channel 2 floating status. Channel 2 is not grounded.

REM white Remote. Instrument is in the remote state.

Local lockout. 
Instrument is in the local lockout (LLO) status.

ERR white Error. At least one error is detected.

EDIT green Edit mode. The field specified by the pointer can be 
edited. Not in the move mode.

MOVE blue Move mode. The field pointer can be moved. Not in the 
edit mode.

LAN green or 
red

LXI LAN status indicator. Green indicates normal LAN 
status. Red indicates abnormal condition. Blinking 
indicates the LAN identification status.

D white Display mode: Dual view

1 white Display mode: Single view for channel 1

2 white Display mode: Single view for channel 2

G white Display mode: Graph view
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Function Keys
Agilent B2961A/B2962A has six function keys below the front panel display, and 
provides the following nine softkeys.

Function keys 1 Config Channel configuration setup. Displays the softkeys for setting 
several functions of the channel. See “Config key group” on 
page 4-26.

Function Math and trace function setup. Displays the softkeys for setting 
these functions. See “Function key group” on page 4-31.

Trigger Trigger configuration and control. Displays the softkeys for 
setting and controlling the trigger system. See “Trigger key 
group” on page 4-33.

Result Measurement and trace result display. Displays the softkeys for 
displaying these results. See “Result key group” on page 4-36.

File File operation. Displays the softkeys for saving and loading a 
file. See “File key group” on page 4-38.

More... Changes the function keys to Function keys 2.

Function keys 2 Program Program configuration and control. Displays the softkeys for 
setting and controlling the program memory. See “Program key 
group” on page 4-39.

I/O I/O setup. Displays the softkeys for setting the I/O interfaces. 
See “I/O key group” on page 4-40.

Display Display setup. Displays the softkeys for setting the display 
functions. See “Display key group” on page 4-45.

System System setup. Displays the softkeys used for several system 
setups. See “System key group” on page 4-47.

More... Changes the function keys to Function keys 1.
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Config key group
Pressing the Config key displays the following three softkeys for setting several 
functions of the channel.

Source Displays the following five softkeys for setting the source operation.

Connection Channel operation and connection setup. See “Output 
Connection dialog box” on page 4-27.

Filter Output filter setup. See “Output Filter dialog box” on page 
4-28.

Ext. Filter External filter setup. See “External Filter dialog box” on page 
4-28.

Sweep Sweep source detail setup. See “Sweep dialog box” on page 
4-29.

Output R Programmable output resistance (using Emulation Table) setup. 
See “Output R (Emulation) dialog box” on page 4-30.

Measure Displays the following softkey for setting the measurement operation.

R Compen Resistance compensation ON or OFF. See “Resistance 
Compensation” on page 6-18.

On a 1-channel model, pressing this key displays the ON and 
OFF keys used to set the resistance compensation on or off.

On a 2-channel model, pressing this key displays the ALL, Ch 
1, and Ch 2 keys. They are used to specify the channel for 
setting the resistance compensation on or off.

ALL specifies channels 1 and 2.

Ch 1 specifies channel 1 only.

Ch 2 specifies channel 2 only.

Common Displays the following two softkeys for setting the miscellaneous function.

Wait Source and measurement wait time setup. See “Wait Control 
dialog box” on page 4-30.
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Group Only on 2-channel models. Channel grouping ON or OFF. 
If this function is ON, the channels perform synchronous 
channel operation. The present setting is indicated by an 
asterisk on the softkey label.

Output Connection dialog box

This dialog box provides the following parameters for setting the channel operation 
and connection.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 
2 (Ch 2)

This field specifies the channel set by this 
dialog box.

Sensing Type Sensing type, 2-wire connection (2-WIRE) or 
4-wire connection (4-WIRE). Set 4-WIRE for 
remote sensing.

Low Terminal State Low sense terminal connection, 
grounded (GROUND) or floating (FLOAT)

High Capacitance Mode High capacitance mode, ON or OFF

Set the mode to ON to perform high capacitive 
load measurements. See “High Capacitance 
Mode” on page 6-17.

Over Voltage/Current Protection Over voltage or current protection, ON or OFF

Set the function ON to turn off the channel 
output automatically and immediately when it 
reaches its limit.

Output-Off State Output-off state, high impedance (HIGH Z), 
normal (NORMAL), or zero volt (ZERO)

This is the source setup condition after output 
off. See Table 6-1 on page 6-15.

Auto Output-On Automatic output on function, ON or OFF

Set the function ON to turn on the channel 
output automatically just before the trigger 
system is initiated by the SCPI command (not 
by front panel operation).
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Auto Output-Off Automatic output off function, ON or OFF

Set the function ON to turn off the channel 
output automatically and immediately when all 
trigger system changes the status from busy to 
idle.

Output Filter dialog box

This dialog box provides the following parameters for setting the output filter.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Filter State Output filter, ON or OFF

Set the filter ON to obtain clean source output without spikes 
and overshooting. Note, however, that using a filter may 
increase the channel settling time.

Automatic Filter Automatic filter, ON or OFF

Set the function ON to automatically set the output filter which 
provides the best filter characteristics and cutoff frequency.

Time Constant Filter time constant, 5 s to 50 ms

External Filter dialog box

This dialog box provides the following parameters for using the N1294A-021/022 
low noise filter. The filter cannot be detected automatically.

The following settings are saved to the non-volatile memory.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

External Filter 
State Use of the filter, ON for use or OFF for non-use

External Filter 
Type Filter type, ULNF or LNF.

ULNF: Agilent N1294A-021 ultra low noise filter

LNF: Agilent N1294A-022 low noise filter
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Sweep dialog box

This dialog box provides the following parameters for setting details of the sweep 
source operation.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Sweep Ranging Ranging mode used for the sweep source operation, BEST, 
AUTO, or FIXED. See Table 4-4 on page 4-29.

Sweep Direction Sweep direction, UP (start to stop direction) or DOWN (stop 
to start direction)

Output after Sweep The value the source channel applies after it completes the 
sweep output

START VALUE (START): The value applied when the 
source channel starts the sweep

END VALUE (END): The value applied when the source 
channel completes the sweep

Table 4-4 Ranging Mode used for Sweep Source Operation

Description

BEST In the linear sweep mode, the sweep source channel automatically uses 
the minimum range which covers the whole sweep output.

In the log sweep mode, the sweep source channel automatically uses the 
range which provides the best resolution for each sweep step output.

AUTO The sweep source channel automatically changes and sets the range 
which provides the best resolution to apply the source output for each 
sweep step.

FIXED The sweep source channel sets the range specified by the range parameter 
Source Ranging: FIXED. See “Optional Parameters” on page 4-17.
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Output R (Emulation) dialog box

This dialog box provides the following parameters to set up the emulation table for 
programmable output resistance setting.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

# List index.

Voltage (V) Voltage value.

Current (A) Current value.

Mode Source mode: VOLTS or AMPS.

Wait Control dialog box

This dialog box provides the following parameters for setting the source and 
measurement wait time.

The source wait time is defined as the time the source channel cannot change the 
output after the start of a DC output or the trailing edge of a pulse.

The measurement wait time is defined as the time the measurement channel cannot 
start measurement after the start of a DC output or the trailing edge of a pulse.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

State Wait time, ON or OFF

Automatic Automatic wait time, ON or OFF

Gain and Offset Parameters for calculating the wait time. See the following 
formula.

• If State=ON and Automatic=ON:

wait time = Gain  initial wait time + Offset

• If State=ON and Automatic=OFF:

wait time = Offset

• If State=OFF:

wait time=0

The initial wait time is automatically set by the instrument, and cannot be changed. 
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Function key group
Pressing the Function key displays the following two softkeys for setting the math 
and trace functions.

Math Math function setup. See “Math Expression dialog box” on page 4-31.

Trace Trace function setup. See “Trace Buffer Setup dialog box” on page 4-32.

Math Expression dialog box

This dialog box provides the following parameters for setting the math function. If 
the math function is ON, the measurement data can be calculated by using the 
specified math expression.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Status Math function, ON or OFF

Unit String Unit for the calculation result of the math expression

The available math expressions are listed in the area below the Unit String field. 
This area can be used to select the math expression for data calculation. To select a 
math expression, highlight the name in this area.

The data calculation is effective for data measured after the math function is set by 
this dialog box. The calculation result can be displayed on the dialog box opened by 
using the Result key group. See “Result key group” on page 4-36.

Math expressions can be defined by using the SCPI commands while the 
B2961A/B2962A is in the remote mode. 

For the predefined math expressions, see “Predefined Math Expressions” on page 
6-19.
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Trace Buffer Setup dialog box

This dialog box provides the following parameters for setting the trace function. The 
data specified by the Feed Data parameter can be stored in the trace buffer if the 
Buffer Control parameter is NEXT. The maximum data size is specified by the 
Buffer Size parameter. See Figure 6-6 on page 6-23 for the trace buffer.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Feed Data Type of data placed in the trace buffer, SENSE or MATH

SENSE: Measurement result data

MATH: Calculation result data of math expression

The data contains the voltage measurement data, current 
measurement data, resistance measurement data, source output 
setting data, calculation result data, time data, or status data 
selected by using the Format keys of the I/O key group. See 
“I/O key group” on page 4-40.

Buffer Control Trace buffer control mode, NEVER or NEXT

NEVER: Disables the write operation to the trace buffer.

NEXT: Enables the write operation until buffer full.

Buffer full will change the mode to NEVER.

Buffer Size Size of the trace buffer, 1 to 100000 data
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Trigger key group
Pressing the Trigger key displays the following four softkeys for setting the trigger 
parameters in detail and controlling the trigger system. See Figure 6-7 on page 6-27.

Config Opens a dialog box. See “Trigger Configuration dialog box” on page 4-34.

Initiate Displays the softkeys for selecting the device action to initiate (to go to the arm 
layer of the trigger system). See Table 4-5. 

Abort Displays the softkeys for selecting the device action to abort (to return to the idle 
state of the trigger system). See Table 4-5.

Immediate Displays the following two softkeys for selecting the arm layer or trigger layer for 
sending the immediate trigger.

Trigger Selects the trigger layer.

Arm Selects the arm layer.

Selecting the layer displays the softkeys for selecting the device action to send the 
immediate trigger. See Table 4-5.

Table 4-5 Softkeys to Select Device Action and Channel

Softkey label Description

ALL Selects the transient and acquire device actions.

Trans. Selects the transient (source output) device action only.

Acq. Selects the acquire (measurement) device action only.

On a 1-channel model, selecting the device action executes Initiate, Abort, or 
Immediate for the specified device action.

On a 2-channel model, selecting the device action displays the following three 
softkeys for selecting the channel.

ALL Selects channels 1 and 2.

Ch 1 Selects channel 1 only.

Ch 2 Selects channel 2 only.

Selecting the channel executes Initiate, Abort, or Immediate for the specified 
device action of the specified channel.
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Trigger Configuration dialog box

This dialog box is used to set the trigger parameters in detail. Note that the 
overlapped parameter values are ignored and replaced with the settings made on the 
Single view. See “Trigger Parameters” on page 4-19.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Layer Specifies the layer or device action set by this dialog box.

ARM: Arm layer

TRIGGER: Trigger layer

ACTION: Device action

For ACTION, the available parameters are Ch, Layer, Action, 
and Trigger Output.

Action Specifies the device action type set by this dialog box.

TRANS.: Transient (source output) device action

ACQ.: Acquire (measurement) device action

Count Count, 1 to 100000 or INF. (infinity), for the action specified by 
the Ch, Layer, and Action parameters

Bypass Bypass, ON or OFF

Bypass=ON enables the bypass only for the first passage to the 
event detector for the action specified by the Ch, Layer, and 
Action parameters.

Bypass=OFF disables the bypass.

Trigger Source Event for the action specified by the Ch, Layer, and Action 
parameters. AUTO, BUS, TIMER, INT1, INT2, LAN, EXT1, 
EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, 
EXT10, EXT11, EXT12, EXT13, or EXT14. See Table 4-6. 

Period Only for the TIMER event.

Interval of the TIMER event for the action specified by the Ch, 
Layer, and Action parameters, 10 s to 100000 s

Trigger Delay Delay time for the action specified by the Ch, Layer, and Action 
parameters, 0 to 100000 s
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Trigger Output Trigger output, ON or OFF

Trigger output terminal, an internal bus (INT1, INT2), LAN 
port (LAN), or a digital I/O pin EXTn (n=1 to 14)

If this parameter is ON, B2961A/B2962A sends an output 
trigger when it changes the trigger state for the action specified 
by the Ch, Layer, and Action parameters. See Figure 6-7 on 
page 6-27. 

For using a digital I/O pin, it is necessary to set function of the 
pin, output trigger polarity, type, pulse width, and so on. See 
“DIO Configuration dialog box” on page 4-43 and “Using 
Digital I/O” on page 3-33.

Table 4-6 Trigger Source

Trigger Source Description

AUTO Trigger source best suited for the present operating mode is 
automatically selected by the internal algorithms. 

BUS Remote interface trigger command such as GET, TRIGger, 
and *TRG

TIMER Signal internally generated every interval set by the Period 
field

INT1 or INT2 Signal from the internal bus 1 or 2

LAN LXI trigger specified by the 
:ARM[:ACQ|:TRAN]:SOUR:LAN and 
:TRIG[:ACQ|:TRAN]:SOUR:LAN commands

EXTn Signal from the DIO pin n, which is an I/O port of the Digital 
I/O D-sub connector on the rear panel. n=1 to 14
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Result key group
Pressing the Result key displays the following two softkeys for displaying the 
measurement and trace results.

Measure Displays the measurement result. See “Measure Result dialog box” on page 4-36.

Trace Displays the trace result. See “Trace Statistical Result dialog box” on page 4-37.

Measure Result dialog box

This dialog box is used to display the last single (one shot) measurement result 
(maximum 100000 data) stored in the data buffer.

This dialog box provides the following GUI for displaying the measurement result. 
The result data is shown in the index and data table below the Type field. Also, the 
data is plotted in the graph area above the Points fields.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel of the data to display.

Type Type of data to display, AMPS, VOLTS, OHMS, WATTS, 
MATH, or TIME

AMPS: Current measurement data

VOLTS: Voltage measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

WATTS: Power data given by Power=VmeasImeas

MATH: Calculation result data of math expression

TIME: Time data

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-18.

Points Number of data points.

Max. Y-axis maximum value of the graph.

Min. Y-axis minimum value of the graph.
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Trace Statistical Result dialog box

This dialog box provides the following GUI for displaying the trace statistical result. 
The result data is displayed in the Mean, Std. Dev., Min., and Max. fields.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel of the data to display.

Feed Always SENSE

Element Type of data to display, AMPS, VOLTS, or OHMS

AMPS: Current measurement data

VOLTS: Voltage measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-18.

Length Data length

Mean Mean value

Std. Dev. Standard deviation

Min. Minimum value

Max. Maximum value
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File key group
Pressing the File key displays the following two softkeys for saving a file on and 
loading a file from a USB memory connected to the front panel USB-A connector.

Save Displays the following five softkeys for saving a file. Pressing a softkey displays the 
File Selection dialog box. See “File Selection dialog box” on page 4-38.

Measure Saves a measurement data file.

Math Saves a math result data file.

Trace Saves a trace buffer data file.

Config Saves a system setting data file.

Load Displays the following softkey for loading a file. Pressing the softkey displays the 
File Selection dialog box. See “File Selection dialog box” on page 4-38.

Config Loads a system setting data file.

File Selection dialog box

This dialog box provides the following GUI for saving or loading a file.

Path Folder name for saving or loading a file.

File Name File name to save or load.

The files and folders saved in the specified folder are listed in the area between the 
Path field and the File Name field. This area can be used for selecting a file to save 
or overwrite. To select a file, highlight its name in this area.

For saving a system setting file, if the file extension is not specified, “.sta” is added 
automatically. For saving the other data file, “.csv” is added automatically.
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Program key group
Pressing the Program key displays the following four softkeys for setting and 
controlling the program memory.

The program memory can be defined by using the SCPI commands while the 
B2961A/B2962A is in the remote mode. 

Catalog Displays the Program Catalog dialog box which lists the programs saved in the 
program memory. This dialog box is also used to specify the memory program to 
use. To select a memory program, highlight its name in this list.

View Displays the Program View dialog box which shows the program code of the 
specified program. 

Variable Displays the Variable dialog box which lists the variables used in the memory 
programs. Available index is 1 to 100.

Control Displays the following five softkeys for controlling the operation of the program 
memory.

Run Starts the specified memory program.

Pause Pauses the execution of the memory program.

Step Starts the step execution of the specified memory program.

Stop Stops the execution of the memory program.

Continue Continues the execution of the memory program presently 
paused.
Agilent B2961A/B2962A User’s Guide, Edition 2 4- 39



Front Panel Reference
I/O key group
I/O key group
Pressing the I/O key displays the following five softkeys for setting the I/O 
interfaces.

Format Displays the five softkeys for setting the data output format. See “Data Output 
Format” on page 4-41.

LAN Displays the following four softkeys for managing the LAN interface.

Config Displays the LAN Configuration dialog box used to set the 
configuration of the LAN interface. See “LAN Configuration 
dialog box” on page 4-43.

Status Displays the LAN Status dialog box which displays the status of 
the LAN interface.

Reset Resets all of the LAN connections.

Defaults Sets the LAN settings to the factory default settings.

Pressing the Reset softkey or the Defaults softkey displays a confirmation dialog 
box. Press the OK softkey to confirm the specified action, or press the Cancel/Local 
key to cancel the action.

USB Displays the USB Status dialog box which displays the VISA USB connect string. 

Example: USB0::2391::36376::MY12345678::0::INSTR

GPIB Displays the GPIB Configuration dialog box used to set the GPIB address of the 
B2961A/B2962A. This dialog also displays the VISA GPIB connect string. 

Example: GPIB0::23::INSTR

DIO Displays the following two softkeys for managing the Digital I/O interface.

Config Displays the DIO Configuration dialog box used to set the 
configuration of the Digital I/O interface. See “DIO 
Configuration dialog box” on page 4-43.

R/W Displays the DIO Read/Write dialog box used to read or write a 
value set to the Digital I/O interface. See “DIO Read/Write 
dialog box” on page 4-44.
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Data Output Format

Pressing the Format softkey displays the following five softkeys for setting the 
format and elements of the output data.

Measure Displays the Format (Measure) dialog box used to set the 
elements of the measurement data output. See “Format 
(Measure) dialog box” on page 4-41.

Math Displays the Format (Math) dialog box used to set the elements 
of the math result data output. See “Format (Math) dialog box” 
on page 4-42.

Trace Displays the Format (Trace) dialog box used to set the elements 
of the trace data output. See “Format (Trace) dialog box” on 
page 4-42.

Data Type Displays the following three softkeys for specifying the data 
output format. The present setting is indicated by an asterisk on 
the softkey label.

ASCII ASCII format

REAL32 IEEE-754 single precision format, 4-byte

REAL64 IEEE-754 double precision format, 8-byte

Data Swap Displays the following two softkeys for enabling or disabling 
the byte swap for the IEEE-754 precision format data output. 
The present setting is indicated by an asterisk on the softkey 
label.

OFF Disables the byte swap. Normal byte order.

ON Enables the byte swap. Reverse byte order.

If Data Swap=ON, the byte order is reversed. Byte 1 to byte 4 are sent in the order of 
byte 4 to byte 1 for the IEEE-754 single precision format, and byte 1 to byte 8 are 
sent in the order of byte 8 to byte 1 for the IEEE-754 double precision format.

Format (Measure) dialog box

This dialog box provides the following parameters for setting the elements of the 
measurement data output.

Voltage Voltage data output, ON or OFF

Current Current data output, ON or OFF
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Resistance Resistance data output, ON or OFF

Source Source data output, ON or OFF

Time Time data output, ON or OFF

Status Status data output, ON or OFF

Format (Math) dialog box

This dialog box provides the following parameters for setting the elements of the 
math result data output.

Data Result data output, ON or OFF

Time Time data output, ON or OFF

Status Status data output, ON or OFF

Format (Trace) dialog box

This dialog box provides the following parameters for setting the elements of the 
trace statistical data output.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Data Trace data. Selects one from the following data elements.

MEAN Mean value

STD.DEV. Standard deviation

MIN. Minimum value

MAX. Maximum value

PK-PK Peak to peak value

Timestamp Timestamp data format. Selects one from the following 
selections.

ABSOLUTE Absolute value (ABS.). Returns the 
incremental value for the first timestamp 
data.

DELTA Delta value (DELTA). Returns the 
incremental value for the previous 
timestamp data.
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LAN Configuration dialog box

This dialog box provides the following parameters for setting the configuration of 
the LAN interface.

mDNS mDNS (multicast DNS) status, ON or OFF

IP Address Config. IP address configuration, AUTO or MANUAL

AUTO configuration uses the DHCP server.

IP Address IP address of this instrument, used for the MANUAL IP 
address configuration

Subnet Subnet mask, used for the MANUAL IP address 
configuration

Gateway IP address of gateway, used for the MANUAL IP address 
configuration

DNS Server Config. DNS server configuration, AUTO or MANUAL

DNS Server IP address of DNS server, primary and secondary, used 
for the MANUAL DNS server configuration

Hostname Host name of this instrument

WINS Server IP address of WINS server, primary and secondary

DIO Configuration dialog box

This dialog box provides the following parameters for setting the configuration of 
the Digital I/O interface.

Pin # Digital I/O pin number, 1 to 14

This field specifies the pin set by this dialog box.

Function Function of the specified pin of the Digital I/O interface, 
digital signal input/output (DIGITAL I/O), digital signal 
input (DIGITAL IN), trigger output (TRIGGER OUT), 
trigger input (TRIGGER IN), or high voltage state 
(HIGH VOLTAGE LAMP, HI-VOLT LAMP, only for 
pin 14)

If Function is set to HIGH VOLTAGE LAMP, other 
setup parameters on this dialog box is ignored.

Polarity Polarity of the input/output function, positive 
(POSITIVE, POS.) or negative (NEGATIVE, NEG.)
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Output Trigger Type Type of output trigger, edge (EDGE) or level (LEVEL)

Output Trigger Timing Timing of the output trigger, after action (arm, trigger, 
and device action) (AFTER), before action (BEFORE), 
or both (BOTH)

Output Pulse Width Pulse width of the output trigger, 10 s to 10 ms

For more information about the trigger function, see “Trigger key group” on page 
4-33.

DIO Read/Write dialog box

This dialog box provides the following parameters for reading or writing a value set 
to the Digital I/O interface.

Format Format of the value set to the Mask Value field and the Value 
field, binary (BIN), decimal (DEC), or hexadecimal (HEX)

Mask Value Mask value which indicates the pattern of the un-used bits of 
the Digital I/O interface

The READ assist key is used to read the mask value presently 
set to the Digital I/O interface.

The WRITE assist key is used to set the specified mask value to 
the Digital I/O interface.

Value Value set to the Digital I/O interface

The READ assist key is used to read the value presently set to 
the Digital I/O interface.

The WRITE assist key is used to write the specified value to the 
Digital I/O interface.
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Pressing the Display key displays the following four softkeys for setting the display 
functions. The present setting is indicated by an asterisk on the softkey label.

Remote Displays the following two softkeys for enabling or disabling the front panel display 
when the B2961A/B2962A is in the remote mode.

OFF Disables the front panel display. Effective for fast operation.

ON Enables the front panel display.

Color Displays the following two softkeys for specifying the display color set.

Set 1 Sets the color set 1.

Set 2 Sets the color set 2.

Zoom Displays the following two softkeys for enabling or disabling the display zoom.

OFF Disables the zoom. Normal display.

ON Enables the zoom. Only the measured data is displayed.

Zoom-in can be cancelled by pressing the Zoom Out assist key.

In the zoom-in state, setup information is not displayed, and the measurement result 
is zoomed. Then,

• the Dual view displays the primary measurement data with a large font, and the 
secondary measurement data for each channel with a small font.

• the Single view displays the primary and secondary measurement data with a 
large font.

Pref. Displays the Display Preference dialog box used to set the preference for front panel 
operation. See “Display Preference dialog box” on page 4-46.
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Display Preference dialog box

This dialog box provides the following parameters for the front panel operation.

The following settings are saved to the non-volatile memory.

• V/I Limit for Each Polarity

Selects the Limit setup operation.

ON Individual setup ON

Limit+ and Limit- fields are available. Positive and negative limits 
can be set individually.

OFF Individual setup OFF

Limit field is available. ±(Limit value) is set to the limit.

• Immediate V/I Update by Knob

Selects the channel operation when the Source value or the Limit value is 
changed by using the digit pointer and the rotary knob.

ON Real time update ON

Setting value is applied to the channel immediately.

OFF Real time update OFF

Setting value is not applied immediately. It is applied to the channel 
by pressing the knob.
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System key group
Pressing the System key displays the following eight softkeys used for several 
system setups.

Error Displays the following two softkeys to view or clear errors.

Log Displays the Error Log dialog box which displays the SCPI 
errors.

Clear Clears the error buffer immediately.

Reset Initializes the B2961A/B2962A.

Pressing the Reset softkey displays a confirmation dialog box. Press the OK softkey 
to start initialization, or the Cancel/Local key to cancel.

Cal/Test Displays the following two softkeys for performing self-calibration or self-test.

Self-Cal Performs self-calibration.

Self-Test Performs self-test.

Pressing the softkey displays a confirmation dialog box. Press the OK softkey to 
start self-calibration or self-test, or the Cancel/Local key to cancel.

PLC Displays the following two softkeys to specify the power line frequency. The 
present setting is indicated by an asterisk on the softkey label.

50 Hz Specifies the power line frequency 50 Hz.

60 Hz Specifies the power line frequency 60 Hz.

Timestamp Displays the following two softkeys to clear timestamp.

Clear Clears the timestamp. Pressing this softkey displays a 
confirmation dialog box. Press the OK softkey to clear the 
timestamp, or the Cancel/Local key to cancel.

Auto CLR Displays the following two softkeys for setting the automatic 
clear of the timestamp. The present setting is indicated by an 
asterisk on the softkey label.

OFF Disables the automatic clear of the 
timestamp.
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ON Enables the automatic clear of the 
timestamp.

Start-up Displays the System Start-up dialog box which provides the following setup 
parameters.

Power-on State Power-on state, RST, RCL0, RCL1, RCL2, RCL3, or RCL4

The power-on state can be selected from the factory default 
reset condition (RST) and user conditions RCL0, RCL1, 
RCL2, RCL3, and RCL4 which can be defined by using the 
*SAV 0, *SAV 1, *SAV 2, *SAV 3, and *SAV 4 commands, 
respectively, while the B2961A/B2962A is in the remote 
mode. 

Power-on Program Power-on program execution ON or OFF

If this parameter is ON, the power-on program is 
automatically executed when the B2961A/B2962A is turned 
on.

The power-on program can be defined by using the 
:PROG:PON:COPY command while the B2961A/B2962A 
is in the remote mode. 

Sound Displays the following two softkeys to enable or disable the beep and sound. The 
present setting is indicated by an asterisk on the softkey label.

OFF Disables the beep and sound.

ON Enables the beep and sound.

Info. Displays the following four softkeys.

Revision Displays the Revision dialog box which displays the model 
number, serial number, and firmware revision of the 
B2961A/B2962A.

Date/Time Displays the Date and Time dialog box which is used to view or 
set the date and time.

Update Used for firmware update.

Demo. Performs demonstration. Pressing this softkey displays a 
confirmation dialog box. Press the OK softkey to start 
demonstration, or the Cancel/Local key to cancel.
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Front Panel Operations
This chapter explains how to use the Agilent B2961A/B2962A. 

• “Basic Operations”

• “To Use Miscellaneous Functions”

• “To Set Source Output”

• “To Execute Measurement”

• “To Use Math Function”

• “To Use Trace Buffer”

• “To Use Program Memory”

NOTE Turning the instrument on or off

Press the line switch. When the power is on, the LED below the switch is turned 
green. 

NOTE Setting the instrument to local mode

Press the Cancel/Local key. 

The front panel keys are available when the instrument is in local mode. 

NOTE Enabling or disabling the channel

Press the On/Off switch. 

The channel status is indicated by the lighting status of the switch as follows. 

Off: The channel is disabled. 

Green: The channel is enabled. 

Red: The channel is in the high voltage state. 

NOTE Starting measurement

Press the Trigger key. According to the setting conditions, the single (one shot) 
measurement is performed with the DC bias output, pulsed bias output, arbitrary 
waveform output, staircase sweep output, or pulsed sweep output. 

Press the Auto key. The repeat (continuous) measurement is performed with the DC 
bias output (of the Source value). 
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Basic Operations
Use the field pointer to specify a setup field in the setup screen. The field pointer 
can take the following states. Change the status as needed during the setup of 
B2961A/B2962A. 

MOVE status Highlighted in blue. You can move the pointer from field to 
field. 

EDIT status Highlighted in green. You can change the value of the current 
field. 

To Change the Setting in a Field

1. If the field pointer is in the EDIT status, press the rotary knob. The pointer status 
is changed to MOVE. 

2. Turn the rotary knob or press the arrow keys to move the field pointer. 

3. Move the field pointer to the item to be changed and press the rotary knob. The 
pointer status is changed to EDIT. 

4. Enter a value or character by pressing the numeric/alpha keys, turning the rotary 
knob, or pressing the arrow keys. Press the rotary knob to fix the setting value. 
The pointer status is changed to MOVE. 

Or press the assist key corresponding to the setting value to fix the setting value. 
The pointer status is changed to MOVE. 

NOTE Digit pointer

In numeric value entry fields such as the Source and Limit fields, you can specify 
only one digit to change its value. 

When the field pointer is in the EDIT status (i.e., all digits in the entry field are 
highlighted in green), pressing the arrow keys changes the pointer to the digit 
pointer, which points only one digit in the entry field. In this status, the following 
operations are allowed. 

The arrow keys are used to move the pointer. 

The numeric/alpha keys and rotary knob are used to change the value of the digit 
indicated by the pointer. 
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When the pointer is on the decimal point, turning the knob moves the decimal point 
if the real time update (Immediate V/I Update by Knob) is OFF. 

NOTE Channel operation when using the rotary knob

If the field pointer is in the EDIT (green) status on the Source or Limit field, turning 
the knob changes/updates the setting value of the source channel in real time.

Channel operation when using the knob and the digit pointer depends on the setting 
of the real time update (Immediate V/I Update by Knob).

• Real time update ON

Setting value is applied to the channel immediately.

• Real time update OFF

Setting value is not applied immediately. It is applied to the channel by pressing 
the knob.

To Change the Settings on a Dialog Box

1. Set the items on the dialog box in the same way as described in “To Change the 
Setting in a Field” on page 5-3.

2. To apply the settings, press Apply. 

To apply all settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key instead of pressing 
Apply. 
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To Use Miscellaneous Functions
This section describes the following miscellaneous operations other than the source 
output and measurement functions. 

• “To Set Power Frequency”

• “To Apply Initial Settings”

• “To Set Beeper”

• “To Set Date and Time”

• “To Perform Self-Test”

• “To Perform Self-Calibration”

• “To Set Operations at Power On”

• “To Display Error Message”

• “To Clear Error Buffer”

• “To Clear Timestamp”

• “To Set Automatic Clear of Timestamp”

• “To Display Firmware Revision”

• “To Set GPIB Address”

• “To Set Remote Display Mode”

To Set Power Frequency

1. Press the More > System > PLC function keys. 

2. Press 50 Hz or 60 Hz. To cancel the setting change, press the Cancel/Local key. 

To Apply Initial Settings

1. Press the More > System > Reset function keys. 

The Confirmation dialog box opens. 

2. Press OK to reset. To cancel the operation, press the Cancel/Local key. 
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To Set Beeper

1. Press the More > System > More > Sound function keys. 

2. To enable the beeper, press ON. To disable it, press OFF. To cancel the setting 
change, press the Cancel/Local key. 

To Set Date and Time

1. Press the More > System > More > Info. function keys. 

2. Press Date/Time. 

The Date and Time dialog box opens. 

3. Set the date and time. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Perform Self-Test

1. Press the On/Off switch and confirm that the switch is turned off. 

2. Disconnect test leads and cables from the channel terminals. 

3. Press the More > System > Cal/Test > Self-Test function keys. 

The Confirmation dialog box opens. 

4. Press OK to perform the self-test. To cancel the operation, press the 
Cancel/Local key. 

To Perform Self-Calibration

The self-calibration must be performed after warming-up of 60 minutes.

1. Press the On/Off switch and confirm that the switch is turned off. 

2. Disconnect test leads and cables from the channel terminals. 

3. Press the More > System > Cal/Test > Self-Cal function keys. 

The Confirmation dialog box opens. 
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4. Press OK to perform the self-calibration. To cancel the operation, press the 
Cancel/Local key. 

To Set Operations at Power On

1. Press the More > System > More > Start-up function keys. 

The System Start-up dialog box opens. 

2. See “Start-up” on page 4-48 to set each parameter. 

To Display Error Message

1. Press the More > System > Error function keys. 

2. Press Log. 

The error message is displayed in the Error Log dialog box. 

3. Press OK to close the dialog box. 

To Clear Error Buffer 

1. Press the More > System > Error function keys. 

2. To clear the error buffer, press Clear. To cancel the operation, press the 
Cancel/Local key. 

To Clear Timestamp 

1. Press the More > System > Timestamp function keys. 

2. Press Clear. The Confirmation dialog box opens. 

3. To perform the operation, press OK. To cancel the operation, press the 
Cancel/Local key. 

To Set Automatic Clear of Timestamp

1. Press the More > System > Timestamp function keys. 

2. Press Auto CLR. 

3. To enable the automatic clear, press ON. To disable it, press OFF. To cancel the 
setting change, press the Cancel/Local key. 
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To Display Firmware Revision

1. Press the More > System > More > Info. function keys. 

2. Press Revision. 

The revision information is displayed in the Revision dialog box. 

3. Press OK to close the dialog box. 

To Set GPIB Address

1. Press the More > I/O function keys. 

2. Press GPIB. 

The GPIB Configuration dialog box opens. 

3. Set the GPIB address. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Remote Display Mode

1. Press the More > Display function keys. 

2. Press Remote. 

3. To enable the screen display in remote mode, press ON. To disable it, press OFF. 
To cancel the setting change, press the Cancel/Local key.
5- 8 Agilent B2961A/B2962A User’s Guide, Edition 2



Front Panel Operations
To Set Source Output
To Set Source Output
This section describes the following source output operations. 

• “To Set Source Output Mode”

• “To Apply DC Voltage/Current”

• “To Stop Source Output”

• “To Set Limit Value”

• “To Set Output Function”

• “To Set Output Range”

• “To Set Programmable Output Resistance”

• “To Set Pulse Output”

• “To Set List Sweep Output”

• “To Set Source Output Trigger Parameters”

• “To Set Source Wait Time”

• “To Set Output Filter”

• “To Set Connection Type”

• “To Set Low Terminal State”

• “To Enable or Disable High Capacitance Mode”

• “To Enable or Disable Over Voltage/Current Protection”

• “To Specify Output-Off Status”

• “To Enable or Disable Automatic Output-On Function”

• “To Enable or Disable Automatic Output-Off Function”

• “To Set Ranging Mode of the Sweep Source”

• “To Set Sweep Direction”

• “To Set Source Output Value after Sweep”
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To Set Source Output Mode

1. For the Single view, press the Mode assist key. For the Dual view, press the Ch1 
Mode or Ch2 Mode assist key. 

The field pointer moves to the Source mode setup field. 

2. Press VOLTS (V) for the voltage output or AMPS (I) for the current output. 

To Apply DC Voltage/Current

1. For the Single view, press the Source assist key. For the Dual view, press the 
Ch1 Source or Ch2 Source assist key. 

The field pointer moves to the Source value setup field. 

2. Enter the output value by using the numeric/alpha keys, rotary knob, and arrow 
keys. 

3. Press the rotary knob or assist key to fix the setting value. 

4. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2). 

The channel starts the specified voltage/current output. While the switch is 
turned green, the channel continues the output and changes the value 
immediately if it is changed. 

To Stop Source Output

1. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2). 

The output and measurement are stopped and the switch turns off. 

To Set Limit Value

For details on this function, see “Limit/Compliance” on page 6-3. 

1. For the Single view, press the Limit assist key. For the Dual view, press the Ch1 
Limit or Ch2 Limit assist key. 

The field pointer moves to the Limit field. 

2. Enter the limit value by using the numeric/alpha keys, rotary knob, and arrow 
keys. 

3. Press the rotary knob or assist key to fix the setting value. 
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To Set Output Function

For details on the output functions, see “Function Parameters” on page 4-12, 
“Sweep Output” on page 6-9, “List Sweep” on page 6-10, and “Arbitrary Waveform 
Output” on page 6-11.

The following procedure sets the staircase sweep output. 

To set the pulsed sweep output, it is necessary to set the staircase sweep output and 
the pulse output. For details on setting the pulse output, see “To Set Pulse Output” 
on page 5-13. 

1. Press the View key to display the Single view. 

2. If Function parameters are not shown, press the Hide XXXX assist key.

3. Move the field pointer to the Function field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the LINEAR SINGLE, LINEAR DOUBLE, LOG SINGLE, or LOG 
DOUBLE assist key to select the relevant sweep operation. The pointer status is 
changed to MOVE. 

6. Move the field pointer to the sweep parameter setup field (Start, Stop, Points, or 
Step). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the sweep start value (Start), sweep stop value (Stop), number of sweep 
steps (Points), or sweep step value (Step). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE Applying the sweep voltage/current

Press the On/Off switch to start the Source value output. 

Press the Trigger key to perform the specified sweep output and measurement. 

To Set Output Range

For details on this function, see “Ranging Mode” on page 6-4 and “Optional 
Parameters” on page 4-17. 

1. Press the View key to display the Single view.
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2. Press the Show Options assist key. 

3. Move the field pointer to the Source Ranging field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press AUTO to set the auto range operation or FIXED to set the fixed range 
operation. The pointer status is changed to MOVE.

6. Move the field pointer to the range value setup field (on the right side of the 
Source Ranging field). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Press an assist key to set the following value. 

For the auto range operation: Minimum range of the range operation

For the fixed range operation: Range used for source output

To Set Programmable Output Resistance

For details on this function, see “Programmable Output Resistance” on page 6-13. 

1. Press the View key to display the Single view.

2. Press the Show Options assist key. 

3. Move the field pointer to the Output R field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press OFF to disable this function, CONST to set the constant mode, or EMUL 
to set the emulation mode. The pointer status is changed to MOVE.

6. For the constant mode:

a. Move the field pointer to the resistance value setup field which is right of the 
Output R field.

b. Press the rotary knob to change the pointer status to EDIT. 

c. Enter a resistance value. The channel works as a voltage source with built-in 
series resistor or a current source with a built-in shunt resistor. 

7. For the emulation mode, the emulation table must be set. See “Output R 
(Emulation) dialog box” on page 4-30 and set up the emulation table.
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To Set Pulse Output

For details on this function, see “Pulse Output” on page 6-7.

1. Press the View key to display the Single view. 

2. Press the Show Pulse assist key to display the Pulse parameters. For details on 
the parameters, see “Pulse Parameters” on page 4-18. 

3. Move the field pointer to the Pulse field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the ON assist key. The pointer status is changed to MOVE. 

6. Move the field pointer to the pulse parameter setup field (Peak, Delay, or 
Width). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the pulse peak value (Peak), delay time (Delay), or pulse width (Width). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE Applying the pulse voltage/current

Press the On/Off switch to start the Source value output. The Source value is used as 
the pulse base value. 

Press the Trigger key to perform the specified pulse output and measurement. 

To Set List Sweep Output

For details on this function, see “List Sweep” on page 6-10.

1. Press the View key to display the Single view. 

2. If Function parameters are not shown, press the Hide XXXX assist key.

3. Move the field pointer to the Function field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the LIST assist key. The pointer status is changed to MOVE. 

6. Move the field pointer to the sweep parameter setup field (Start, Stop, or Points). 

7. Press the rotary knob to change the pointer status to EDIT. 
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8. Press the Edit assist key. The List Sweep dialog box opens. 

9. Set the list sweep source using the List Sweep dialog box. For details, see “List 
Sweep Setup” on page 4-13. 

10. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

NOTE Load assist key

If you press the Load assist key instead of the Edit assist key in step 8, the Load List 
Sweep Data dialog box opens to allow you to load list sweep data from a USB 
memory. 

For details, see “List Sweep Setup” on page 4-13. 

NOTE Applying the list sweep voltage/current

Press the On/Off switch to start the Source value output. 

Press the Trigger key to perform the specified list sweep output and measurement. 

To Set Source Output Trigger Parameters

For details on this function, see “Trigger System” on page 6-26 and “Trigger 
Parameters” on page 4-19. 

1. Press the View key to display the Single view. 

2. Press the Show Trigger assist key to display the Trigger parameters.

3. Move the field pointer to the Trigger field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger 
type. The pointer status is changed to MOVE. 

6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, 
or Trigger in the Source column). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the trigger count (Count), trigger delay time (Delay), trigger period 
(Period), or trigger source (Trigger). 
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9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE If you want to set the trigger parameters in detail, select the MANUAL trigger type 
and use the Trigger Configuration dialog box opened by pressing the Trigger > 
Config function keys. See “Trigger key group” on page 4-33.

To Set Source Wait Time

For details on this function, see “Measurement Time” on page 6-5 and “Wait 
Control dialog box” on page 4-30. 

1. Press the Config > Common > Wait function keys. 

The Wait Control dialog box opens. 

2. Set each parameter in the Source column.

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Output Filter

For details on this function, see “Output Filter and External Filter” on page 6-12 and 
“Output Filter dialog box” on page 4-28. 

1. Press the Config > Source > Filter function keys. 

The Output Filter dialog box opens. 

2. Set each parameter.

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Connection Type

For details on this function, see “2-Wire Connections or 4-Wire Connections” on 
page 3-12.

1. Press the Config > Source > Connection function keys. 
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The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set 2-WIRE or 4-WIRE in the Sensing Type field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Low Terminal State

For details on this function, see “Floating” on page 3-13.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set GROUNDED or FLOATING in the Low Terminal State field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Enable or Disable High Capacitance Mode

For details on this function, see “High Capacitance Mode” on page 6-17.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the High Capacitance Mode field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Enable or Disable Over Voltage/Current Protection

For details on this function, see “Over Voltage/Current Protection” on page 6-14.
5- 16 Agilent B2961A/B2962A User’s Guide, Edition 2



Front Panel Operations
To Set Source Output
1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Over Voltage/Current Protection field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Specify Output-Off Status

For details on this function, see “Output-Off Status” on page 6-15.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set HIGH Z (high impedance), NORMAL (normal), or ZERO (zero volt) in the 
Output-Off State field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Enable or Disable Automatic Output-On Function

For details on this function, see “Automatic Output-ON/OFF Function” on page 
6-16.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Auto Output-On field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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To Enable or Disable Automatic Output-Off Function

For details on this function, see “Automatic Output-ON/OFF Function” on page 
6-16.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Auto Output-Off field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Ranging Mode of the Sweep Source

For details on this function, see “Ranging Mode” on page 6-4. 

1. Press the Config > Source > Sweep function keys. 

The Sweep dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set BEST, AUTO, or FIXED in the Sweep Ranging field. For details, see 
“Sweep dialog box” on page 4-29. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Sweep Direction

1. Press the Config > Source > Sweep function keys. 

The Sweep dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set UP or DOWN in the Sweep Direction field. For details, see “Sweep dialog 
box” on page 4-29. 

4. To apply the settings, press Apply. 
5- 18 Agilent B2961A/B2962A User’s Guide, Edition 2



Front Panel Operations
To Set Source Output
To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Set Source Output Value after Sweep

1. Press the Config > Source > Sweep function keys. 

The Sweep dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set START VALUE or END VALUE in the Output after Sweep field. For 
details, see “Sweep dialog box” on page 4-29. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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To Execute Measurement
This section describes the following measurement operations. 

• “To Set Measurement Mode”

• “To Perform Spot Measurement”

• “To Stop Measurement”

• “To Set Measurement Time”

• “To Perform Sweep Measurement”

• “To Set Measurement Trigger Parameters”

• “To Set Measurement Wait Time”

• “To Enable or Disable Resistance Compensation”

To Set Measurement Mode

1. For the Single view, press the Measure assist key. For the Dual view, press the 
Ch1 Measure or Ch2 Measure assist key. 

2. Press AMPS (I) for the current measurement, VOLTS (V) for the voltage 
measurement, OHMS (R) for the resistance measurement, WATTS (P) for the 
power measurement, or %LIMIT (%) for the percent-to-Limit measurement.

To Perform Spot Measurement

1. Set the measurement mode (see “To Set Measurement Mode” on page 5-20). 

2. Set the output voltage or current (see “To Apply DC Voltage/Current” on page 
5-10).

3. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2). 

The channel starts the specified voltage/current output. While the switch is 
turned green, the channel continues the output and changes the value 
immediately if it is changed. 

4. Press the Trigger key. 

The spot measurement is performed. 
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NOTE To change the Limit value, see “To Set Limit Value” on page 5-10. 

To Stop Measurement

1. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2) to turn the switch off. 

The channel stops source output and measurement.

To Set Measurement Time

For details on this function, see “Measurement Time” on page 6-5 and “Measure 
Speed:” on page 4-17. 

1. Press the View key to display the Single view. 

2. Press the Show Options assist key to display the optional parameters. 

3. Move the field pointer to the Measure Speed field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the AUTO, SHORT, MEDIUM, NORMAL, LONG, or MANUAL assist 
key to set the measurement time.

6. When MANUAL is specified, the aperture time setup field and PLC setup field 
are displayed. Enter and fix a value in either of the fields to set the measurement 
time. 

To Perform Sweep Measurement

For details on this function, see “Sweep Output” on page 6-9.

1. Press the View key to display the Single view. 

2. Set the source function (see “To Set Source Output Mode” on page 5-10). 

3. Set the Source value and Limit value (see “To Apply DC Voltage/Current” on 
page 5-10 and “To Set Limit Value” on page 5-10). 

4. Set the measurement mode (see “To Set Measurement Mode” on page 5-20). 

5. Set the sweep source (see “To Set Output Function” on page 5-11). 

6. Press the View key to display the Graph view. 

7. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2). 
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The channel starts the specified voltage/current output. While the switch is 
turned green, the channel continues the output and changes the value 
immediately if it is changed. 

8. Press the Trigger key. 

The sweep measurement is performed and the measurement result is displayed 
in a graph. 

To Set Measurement Trigger Parameters

For details on this function, see “Trigger System” on page 6-26 and “Trigger 
Parameters” on page 4-19. 

1. Press the View key to display the Single view. 

2. Press the Show Trigger assist key to display the Trigger parameters.

3. Move the field pointer to the Trigger field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger 
type. The pointer status is changed to MOVE. 

6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, 
or Trigger in the Measure column). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the trigger count (Count), trigger delay time (Delay), trigger period 
(Period), or trigger source (Trigger). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE If you want to set the trigger parameters in detail, select the MANUAL trigger type 
and use the Trigger Configuration dialog box opened by pressing the Trigger > 
Config function keys. See “Trigger key group” on page 4-33.

To Set Measurement Wait Time

For details on this function, see “Measurement Time” on page 6-5 and “Wait 
Control dialog box” on page 4-30. 

1. Press the Config > Common > Wait function keys. 
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The Wait Control dialog box opens. 

2. Set each parameter in the Measure column.

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

To Enable or Disable Resistance Compensation

1. Press the Config > Measure > R Compen function keys. 

2. For the 2-channel models, specify the channel to which the setting change is 
applied by using the following function keys. 

ALL: Channels 1 and 2 (Ch 1 and Ch 2)

Ch 1: Channel 1 (Ch 1) only

Ch 2: Channel 2 (Ch 2) only

3. To enable the resistance compensation, press ON. 

To disable it, press OFF. 

To cancel the setting change, press the Cancel/Local key.
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To Use Math Function
This section describes how to use the math function. For details on this function, see 
“Math Expression” on page 6-19. Also, for details on the setup parameters, see 
“Math Expression dialog box” on page 4-31. 

1. Press the Function > Math function keys. 

The Math Expression dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Status field, set the math function ON (enable) or OFF (disable). 

4. In the Unit String field, enter the unit for the calculation result data. 

To enter alphabets, press the ABC assist key and then use the numeric/alpha 
keys. 

To enter numbers, press the 123 assist key and then use the numeric/alpha keys. 

To delete a character, highlight the character to be deleted and then press the 
Delete function key. 

To insert a character, highlight the character at the position where to insert the 
character and then press the Insert function key. 

5. Select a math expression to use. 

To select a math expression, highlight the name of the math expression in the list 
area below the Unit String field. 

6. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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To Use Trace Buffer
This section describes how to set the trace buffer and how to display the statistical 
data. For details on this function, see “Trace Buffer” on page 6-22. 

To use the trace buffer, set the trace buffer and source output and measurement 
conditions, and then press the Trigger key. 

• “To Set Trace Buffer”

• “To Display Statistical Data”

To Set Trace Buffer

For details on the setup parameters, see “Trace Buffer Setup dialog box” on page 
4-32.

1. Press the Function > Trace function keys. 

The Trace Buffer Setup dialog box opens. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Feed Data field, set SENSE (for collecting the measurement result data) or 
MATH (for collecting the calculation result data). 

4. In the Buffer Control field, set NEXT (for enabling the write operation to the 
trace buffer) or NEVER (for disabling it). 

5. In the Buffer Size field, set the size of the trace buffer (1 to 100000). 

6. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

NOTE To specify the measurement result data (SENSE) to be collected, use “Format 
(Measure) dialog box” on page 4-41. 

To specify the calculation result data (MATH) to be collected, use “Format (Math) 
dialog box” on page 4-42. 

To change the statistical data to be saved in the trace buffer, use “Format (Trace) 
dialog box” on page 4-42. 
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To Display Statistical Data

For details on the setup parameters, see “Trace Statistical Result dialog box” on 
page 4-37.

1. Press the Result > Trace function keys. 

The Trace Statistical Result dialog box opens. 

2. In the Ch field, set the channel for the data to be displayed. 

3. In the Element field, set the data type SOURCE (source output data), VOLTS 
(voltage measurement data), AMPS (current measurement data), OHMS 
(resistance measurement data) for the statistical calculation. 

The statistical data for the data specified here is displayed in the area below the 
Length field. 

4. Press OK to close the dialog box. 

The Length field displays the number of data. 

The statistical data is displayed in the following fields: 

Mean: Mean value

Std. Dev.: Standard deviation

Min.: Minimum value

Max.: Maximum value
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To Use Program Memory
This section describes how to select and run a memory program. For details on this 
function, see “Program Memory” on page 6-24. 

See also “Program key group” on page 4-39. 

• “To Select a Program”

• “To Control Program Operation”

To Select a Program

1. Press the More > Program > Catalog function keys. 

The Program Catalog dialog box opens. 

2. Highlight the name of the memory program to run. 

3. Press OK. 

NOTE To set a value for a variable used in the memory program, use the Variable dialog 
box. For details, see “Program key group” on page 4-39. 

To Control Program Operation

1. Press the More > Program > Control function keys. 

2. Use the following keys to control the operation of a memory program. 

Run Starts the execution of the specified memory program. 

Pause Pauses the execution of the memory program. 

Step Starts the step execution of the specified memory program. 

Stop Stops the execution of the memory program. 

Continue Continues the execution of the memory program presently 
paused. 
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Function Details
This chapter describes the following functions of the Agilent B2961A/B2962A.

• “Limit/Compliance”

• “Ranging Mode”

• “Measurement Time”

• “Pulse Output”

• “Sweep Output”

• “List Sweep”

• “Arbitrary Waveform Output”

• “Output Filter and External Filter”

• “Programmable Output Resistance”

• “Over Voltage/Current Protection”

• “Output-Off Status”

• “Automatic Output-ON/OFF Function”

• “High Capacitance Mode”

• “Resistance Measurement”

• “Math Expression”

• “Trace Buffer”

• “Program Memory”

• “Channel Grouping”

• “Trigger System”

• “Interlock Function”

• “Over Temperature Protection”

• “Initial Settings”
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Limit/Compliance 
Limit/compliance is the output limiter for preventing damage to the test device from 
overcurrent or overvoltage. Voltage limit is for current output channels, and current 
limit is for voltage output channels.

When a channel reaches limit, the channel acts as a constant voltage source or a 
constant current source. The channel keeps the output value once limit has been 
reached.

Limit can be set with the same resolution and accuracy as output current or output 
voltage.

To Set Limit

The following points must be noted when setting the limit.

• The minimum limit value is limited as follows.

• Current limit

1 % of the range (at 100 nA Range)

1 nA (at 10 nA Range)

• Voltage limit

20 mV (at 0.2 V range)

• If the current limit value is too low, the channel will require a long settling time.

• The limit value can be specified asynchronously to positive and negative.
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Ranging Mode
The following ranging modes are available for the source output.

• FIXED (fixed range)

The channel uses the specified range only.

• AUTO (auto range)

The channel automatically uses the range which provides the best resolution for 
the source output value. It is possible to specify the minimum range effective for 
the auto range operation.

• BEST (best, only for the sweep source)

In the linear sweep mode, the channel automatically uses the minimum range 
which covers the whole sweep output.

In the log sweep mode, the channel automatically uses the range which provides 
the best resolution for each sweep step output.

Setting the Ranging Mode

The following points must be noted when setting the ranging mode.

• The pulsed source channel always uses the fixed range.

• To set the ranging mode used for the DC (constant) source operation, see 
“Optional Parameters” on page 4-17.

• To set the ranging mode used for the sweep source operation, see “Sweep dialog 
box” on page 4-29.
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Measurement Time 
Measurement time depends on aperture time, measurement range, and other 
measurement conditions, and can be expressed by the following formula:

Measurement time = Aperture time + Overhead time

Aperture time is the time required for measurement, and does not include such 
factors as range change or data compensation, which would be the overhead time.

Aperture Time

Aperture time is the time required to acquire the measurement data. For accurate and 
reliable measurement, the aperture time should be increased.

The aperture time is set by using the Measure Speed parameter on the Single view. 
See “Measure Speed:” on page 4-17.

Overhead Time

Overhead time is the time required for range change, etc. This time depends on the 
measurement condition, and cannot be specified. Major elements of the overhead 
time are:

• Range change time during measurement (when measurement ranging mode is 
set to AUTO)

• Range change time at the start of a measurement (when the measurement range 
is less than the limit value)

To Control Source/Measure Timing

The source output and measurement timing can be controlled by the following 
parameters. See Figure 6-1. This figure shows an example of sweep output. For a 
bias output, focus the shape of a sweep step only. 

1. Source delay

The source delay time is defined as the time from trigger to start of a source 
output.
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2. Measure delay

The measurement delay time is defined as the time from trigger to start of a 
measurement.

3. Source wait

The source wait time is defined as the time the source channel cannot change the 
output value after starting an output.

4. Measure wait

The measurement wait time is defined as the time the measurement channel 
cannot start measurement after starting an output.

5. Period

The period is the trigger interval. It can be defined for the TIMER or MANUAL 
trigger type (trigger source) and for the source output and measurement actions 
individually.

Figure 6-1 Source Output and Measurement Timing, Sweep Output Example

To set the delay time and the period, see “Trigger Parameters” on page 4-19.

To set the wait time, see “Wait Control dialog box” on page 4-30.

For more information about the trigger setup, see “Trigger key group” on page 4-33.
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(2) (2)

(4)

(3)

(1) (1)

(4)

(3)

(5)

Measure delay (2)
6- 6 Agilent B2961A/B2962A User’s Guide, Edition 2



Function Details
Pulse Output
Pulse Output
The channel can apply the pulsed voltage or current. Figure 6-2 shows a pulsed 
sweep output example. For a pulsed bias output, focus the shape of a pulse only. 

To Control Pulse Output/Measure Timing

The pulse output and measurement timing can be controlled by the following 
parameters. See Figure 6-2.

1. Source delay

The source delay time is defined as the time from trigger to start of a source 
output.

2. Measure delay

The measurement delay time is defined as the time from trigger to start of a 
measurement.

3. Pulse delay

The pulse delay time is defined as the time from the start of a source output to 
the start of a pulse (peak) output.

4. Source wait

The source wait time is defined as the time the source channel cannot change the 
output value after the trailing edge of a pulse.

5. Measure wait

The measurement wait time is defined as the time the measurement channel 
cannot start measurement after the trailing edge of a pulse.

6. Pulse width

The pulse width is the time from the start of a pulse output to the end of a pulse 
(peak) output. However, it is strictly defined as the time from 10 % of peak level 
at the leading edge to 90 % of peak level at the trailing edge. The available 
values are 50 s to 100000 s.
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Figure 6-2 Pulse Output and Measurement Timing, Sweep Output Example

To set the delay time, see “Trigger Parameters” on page 4-19.

To set the pulse delay time and the pulse width, see “Pulse Parameters” on page 
4-18.

To set the wait time, see “Wait Control dialog box” on page 4-30.

For more information about the trigger setup, see “Trigger key group” on page 4-33.

To Set Pulse Output

The following points must be noted when setting the pulse output.

• Pulse base value is set by the Source value on the Single or Dual view.

• Pulse peak value is set by the Single view.

Set the Peak value of “Pulse Parameters” on page 4-18 for the pulsed bias 
output.

Or set the Start, Stop, and Points values of “Function Parameters” on page 4-12 
for the pulsed sweep output.
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Sweep Output
The channel can apply a sweep voltage/current. It supports several sweep output 
functions, as shown in Figure 6-3. The channel not only performs the sweep output 
but performs the measurement for each sweep step as shown in Figures 6-1 and 6-2. 

The channel can also perform an arbitrary waveform output as the sweep source and 
perform the measurement for each step of the waveform. It is called as list sweep. 
For details, see “List Sweep” on page 6-10.

Figure 6-3 Variety of Sweep Outputs

To Set Sweep Output

The following points must be noted when setting the sweep output.

• To set the function parameters, see “Function Parameters” on page 4-12. 

• To set the ranging mode of the sweep source, see “Sweep dialog box” on page 
4-29. 

• To set the sweep direction, see “Sweep dialog box” on page 4-29. 

• To set the output condition after sweep, see “Sweep dialog box” on page 4-29. 

• To set the pulse delay time and the pulse width, see “Pulse Parameters” on page 
4-18. 

Single Sweep Double Sweep

Linear Sweep

Logarithmic Sweep

DC output Pulse output

DC output Pulse output

Pulse output

Pulse output

DC output

DC output
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List Sweep
By using the list sweep function, the channel can apply your desired waveform, for 
example as shown in Figure 6-4, and measure voltage or current at each output 
value.

This function can be used in both the DC voltage/current output range and the pulse 
voltage/current output range.

The source output and measurement timing is controlled by the trigger system. And 
the interval can be set to a constant value if the trigger type is set to TIMER. 

The source output and measurement can be performed in 10 s minimum interval.

To set these trigger parameters, see “Trigger Parameters” on page 4-19. The interval 
can be set by the Period parameter. The number of output values can be set by the 
Count parameter.

To set the source output values, use the List Sweep dialog box. See “List Sweep 
Setup” on page 4-13.

Figure 6-4 shows an example setup of the List Sweep dialog box with an image of 
the output waveform.

Figure 6-4 List Sweep Dialog Box
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Arbitrary Waveform Output
The channel can also apply an arbitrary voltage/current waveform. It supports 
several waveform output functions, as shown in Figure 6-5. This function can be 
used in the DC voltage/current output range.

To set an arbitrary waveform output parameters, see “Function Parameters” on page 
4-12. To set the user defined waveform data values, use the User Defined Waveform 
dialog box. See “User Defined Waveform Setup” on page 4-15.

Figure 6-5 Variety of Arbitrary Waveform Outputs
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Output Filter and External Filter
Output Filter and External Filter
The channel has a built-in output filter to obtain clean source output without spikes, 
noise, and overshooting. To set the filter, see “Output Filter dialog box” on page 
4-28. Note, however, that using a filter may increase the channel settling time.

Also the channel can be equipped with a N1294A-021 ultra low noise filter (ULNF) 
or a N1294A-022 low noise filter (LNF). By attaching the filter to the output 
terminal, the B2961A/B2962A can be used as a high resolution and high speed DC 
power supply or a DC bias source for high frequency measurement instrument.

For using the external filter, see “Using the N1294A-021/022 Low Noise Filter” on 
page 3-15 and “External Filter dialog box” on page 4-28. And set the dialog box 
properly.

Conditions for using the external filter is shown below.

• Supported source mode: DC voltage source or DC current source

• Built-in output filter:

Filter State: ON

Automatic Filter: ON

• Programmable output resistance function: Unsupported

• Maximum output voltage/current for using ULNF: ±42 V / ±105 mA

• Current ranges effective for using ULNF:

In the current source mode: 10 nA to 100 mA ranges

In the voltage source mode: 10 A to 100 mA ranges

• Current ranges effective for using LNF:

In the current source mode: 10 nA to 3 A ranges

In the voltage source mode, high capacitance mode ON: 10 A to 3 A ranges

In the voltage source mode, high capacitance mode OFF: 100 mA to 3 A ranges
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Programmable Output Resistance
If the programmable output resistance function is enabled, the channel operates like 
an electric load. 

This function provides two operation mode, constant and emulation.

For the constant mode, the channel works as a voltage source with built-in constant 
series resistor or a current source with a built-in constant shunt resistor. For easy 
understanding, when the High and Low terminals are shorted, the channel tries to 
apply 0.1 A with the setting of 0.1 V output and 1  output resistance.

For the emulation mode, the channel emulates user defined V/I curve set to the 
emulation table. Then the output status on the Single or Dual view is changed to 
“EMUL”.

To set the programmable output resistance, see “Optional Parameters” on page 4-17.

To set up the emulation table, see “Output R (Emulation) dialog box” on page 4-30.

NOTE For examples using this function, see the following documents.

• Programmable Output Resistance, Using Constant Mode

• Programmable Output Resistance, Using VI Emulation Mode

They are stored in the B2961A/62A Power Source Product Reference CD-ROM.
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Over Voltage/Current Protection
Over Voltage/Current Protection
The over voltage/current protection is effective for preventing damage to the test 
device from overcurrent or overvoltage. If this function is enabled, the channel sets 
the output to 0 V and sets the output switch to off automatically and immediately 
when it reaches the limit status.

To set the over voltage/current protection, see “Output Connection dialog box” on 
page 4-27.
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Output-Off Status
The output-off status is the condition which is set on the channel automatically, 
immediately after its output is turned off. The status must be specified before 
enabling the source output. The available conditions are shown in Table 6-1 

To set the output-off status, see “Output Connection dialog box” on page 4-27.

Table 6-1 Output-Off State

NOTE This setting is not applied to the output-off process triggered by the emergency 
condition such as the over voltage/current protection, interlock open, and over 
temperature protection. Then the output voltage is immediately set to 0 V and the 
output switch is set to off. 

Name Conditions after output-off

HIGH Z, 
high 
impedance

• Output relay: off (open or break)

• Voltage source setup is not changed if the source applies 
40 V or less.

• Current source setup is not changed if the source uses the 
100 mA range or lower.

NORMAL • Source function: Voltage source

• Output voltage: 0 V

• Current limit: 100 A at the 100 A range

• Output relay: off (open or break)

ZERO • Source function: Voltage source

• Output voltage: 0 V

• Current limit: 100 A at the 100 A range
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Automatic Output-ON/OFF Function
The automatic output-ON/OFF function defines the source channel’s output 
ON/OFF operation when the trigger system changes the status.

• Automatic-ON function

If this function is enabled, the channel automatically turns the output ON just 
before the trigger system is initiated by an SCPI command, not by a front panel 
operation.

• Automatic-OFF function

If this function is enabled, the channel automatically turns the output OFF 
immediately when all trigger system changes the status from busy to idle.

To set the automatic output ON/OFF function, see “Output Connection dialog box” 
on page 4-27.
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High Capacitance Mode
High Capacitance Mode
High capacitance mode is effective for the measurement of a capacitive load greater 
than 0.01 F. 

If the measurement result data is not stable, set this function ON. The measurement 
data may come stable. This function is effective for measurements of capacitive 
devices up to 50 F. 

High capacitance mode is available for the following source/measure condition.

• Operation mode: voltage source and current measurement

• Current measurement range: 1 A to 10 A

To set the high capacitance mode, see “Output Connection dialog box” on page 
4-27.
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Resistance Measurement
B2961A/B2962A supports resistance measurement. If the measurement parameter 
is set to resistance OHMS (R), B2961A/B2962A automatically calculates resistance 
value from measured voltage and current.

For performing accurate measurement, B2961A/B2962A provides the 
compensation function. 

Resistance Compensation

Resistance compensation (R Compen) is effective for performing low resistance 
measurements accurately. If R Compen is set to ON, the channel performs 
measurement twice and returns the compensated measurement result given by the 
following formula. This technique is effective for reducing the thermal EMF.

Rcompen=(V2-V1)/(I2-I1)

where, V1 is the measurement results at the 0 A source condition, and I1 is the 
measurement results at the 0 V source condition.

To enable resistance compensation, press the Config > Measure > R Compen > ON 
function key on a 1-channel model, or the Config > Measure > R Compen > ALL or 
Ch 1 or Ch2 > ON function key on a 2-channel model.

To disable resistance compensation, press the Config > Measure > R Compen > 
OFF function key on a 1-channel model, or the Config > Measure > R Compen > 
ALL or Ch 1 or Ch2 > OFF function key on a 2-channel model.
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Math Expression
B2961A/B2962A provides a math function for performing calculations using the 
measurement result data. The calculation result can be displayed and used for the 
trace statistics.

For the predefined math expressions, see “Predefined Math Expressions”.

To define a math expression, see Agilent B2961A/B2962A SCPI Command 
Reference. Math expressions can be defined by using the :CALC:MATH commands. 
For resources effective for the expression, see “Resources Used in the Expressions”. 

To use the math function, see “Math Expression dialog box” on page 4-31.

To display the calculation result, see “Graph View” on page 4-21 and “Measure 
Result dialog box” on page 4-36.

Predefined Math Expressions

The following math expressions have already been defined in B2961A/B2962A. 
The predefined math expressions are not cleared by the power off and on operations.

• Power (POWER)

• Offset Compensated Ohms (OFFCOMPOHM)

• Varistor Alpha (VARALPHA)

• Voltage Coefficient (VOLTCOEF)

In the following formula, [c] specifies the channel (1 or 2) used for the 
measurement.

POWER Calculates power using the following formula.

POWER = VOLT[c] * CURR[c]

OFFCOMPOHM Calculates offset compensated ohms (resistance) using the following formula.

OFFCOMPOHM = (VOLT[c][1]-VOLT[c][0]) / (CURR[c][1]-CURR[c][0])

where, VOLT[c][0] and CURR[c][0] are the data measured with a current output 
level, and VOLT[c][1] and CURR[c][1] are the data measured with a different 
current output level or zero output.
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This function is effective for reducing measurement errors in low resistance 
measurements.

VARALPHA Calculates varistor alpha using the following formula.

VARALPHA = log(CURR[c][1] / CURR[c][0]) / log(VOLT[c][1] / VOLT[c][0])

where, CURR[c][0] and VOLT[c][0] are the measurement data at a point on a 
varistor’s non-linear I-V characteristics curve, and CURR[c][1] and VOLT[c][1] are 
the data at the another point.

VOLTCOEF Calculates voltage coefficient using the following formula.

VOLTCOEF = (RES[c][1]-RES[c][0]) / (RES[c][1] * (VOLT[c][1]-VOLT[c][0])) 
* 100 %

where, RES[c][0] and RES[c][1] are the resistance measurement data at the first and 
second measurement points, respectively, and VOLT[c][0] and VOLT[c][1] are the 
voltage measurement data at the first and second measurement points, respectively.

The voltage coefficient is known as the ratio of the fractional change for a resistor 
whose resistance varies with voltage.

Resources Used in the Expressions

The following resources can be used in user-defined math expressions.

• Reserved variables

The variables listed in Table 6-2 are reserved for reading the channel output or 
measurement data. 

Scalar variable is used for spot measurement data. 

Vector (array) variable is used for sweep measurement data.

• Math operators

The following operators are available.

• Arithmetic operators: +, -, *, /, ^, see Table 6-3

• Elementary functions: ln, log, sin, cos, tan, exp

The functions log and ln perform the operation after calculating the absolute 
value. So if a negative value is specified, they do not cause an error but calculate 
as a positive value. For example, log(-10) results in log(10)=1.
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Table 6-2 Reserved Variables

Table 6-3 Arithmetic and Unary Operators

Reserved variable a

a. The numeric suffix [c] is effective for specifying the channel. For exam-
ple, use CURR2 to read the current spot measurement data of the chan-
nel 2.

Description
Scalar Vector 

SOUR[c] SOUR[c][] Source output setting data

VOLT[c] VOLT[c][] Voltage measurement data

CURR[c] CURR[c][] Current measurement data

RES[c] RES[c][] Resistance measurement data

TIME[c] TIME[c][] Time (timestamp) data

Priority of task Operator Description

High
:
:
:
:
:

Low

( ) Parentheses

+ and - Unary plus operator and unary minus operator

^ Exponentiation operator

* and / Multiplication operator and division operator

+ and - Additive operator and subtraction operator
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Trace Buffer
The trace buffer collects the test result data until a buffer full is detected. The 
maximum data size is 100,000 blocks for each channel. The data flow is shown in 
Figure 6-6. One data block may contain multiple data, such as voltage measurement 
data, current measurement data, resistance measurement data, source output data, 
calculation result data, time data, and status data. They are selected by using the 
Format keys of the I/O key group. See “I/O key group” on page 4-40.

For setting the trace buffer, see “Trace Buffer Setup dialog box” on page 4-32.

In Figure 6-6, the variables indicate the following data.

• VOLT: Voltage measurement data

• CURR: Current measurement data

• RES: Resistance measurement data

• TIME: Time data (timestamp of the measurement start trigger)

• STAT: Status data

• SOUR: Source output data

• CALC: Math (calculation) result data

If data is stored in the trace buffer, its statistical data can be calculated. Calculable 
statistical data is as follows.

• MEAN: Mean value

• SDEV: Standard deviation

• MIN: Minimum value

• MAX: Maximum value

• PKPK: Peak to peak value

The statistical data (except for PKPK) of VOLT, CURR, or RES data can be 
displayed on the Trace Statistical Result dialog box. See “Trace Statistical Result 
dialog box” on page 4-37 for displaying the data.

Use an external computer to display the data which cannot be displayed on the 
B2961A/B2962A screen. The data can be saved in an USB memory connected to 
the front panel USB-A connector or can be read by using SCPI commands.
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NOTE Do not forget to save or read the data before turning the B2961A/B2962A off. The 
trace buffer is cleared by turning the instrument off.

Figure 6-6 Data Flow to Trace Buffer for Each Channel
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Program Memory
The program memory stores command strings temporarily. The stored program can 
be executed by using the front panel keys, or automatically when B2961A/B2962A 
is turned on. See “Program key group” on page 4-39 and “Start-up” on page 4-48. 
The keys used for controlling the program memory are shown in Table 6-4. This 
table also shows the status changed by pressing the program control keys.

The program memory can eliminate several processes in the program execution, 
such as transferring commands, checking command syntax, and converting 
commands to the internal codes. Thus, using the program memory speeds up 
program execution. If frequently used command strings are stored in the program 
memory, interface/computer activity is minimized.

The program memory can be defined by using SCPI commands while 
B2961A/B2962A is in the remote mode. See Agilent B2961A/B2962A SCPI 
Command Reference.

• Number of programs saved in the memory: 100

• Number of programs used for start-up automatic execution: 1

• Total memory size: 100 KB

• Maximum length for a line: 256 bytes

• Maximum number of characters of program name: 32 with alphabets, numbers, 
hyphens, and underscores

Table 6-4 Program Control Keys (Function Keys) and Status Changes

Control key
Present execution status

Running Paused Stopped

Run Error to Running to Running

Pause to Paused Paused Stopped

Step Error to Running to Paused to Running to Paused

Stop to Stopped to Stopped Stopped

Continue Error to Running Error
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Channel Grouping
This section applies only to 2-channel models. This function is used to control the 
channel output timing automatically so that the channel keeps the output while the 
other channel performs measurement.

The grouped channels start the source output in the order of channel number, then 
start the measurement at the same time, and keep the output until the measurement is 
completed. If delay time and wait time are set, this is adjusted by these values.

If the grouping is released, the channels work independently regardless of the 
condition of the other channel.

To enable the channel grouping, press the Config > Common > Group > ON 
function keys.

To disable the channel grouping, press the Config > Common > Group > OFF 
function keys. 

Conditions for the channels to group:

• Trigger source (Trigger value) must be the same.

• If the trigger source is set to TIMER, the trigger period (Period value) of the 
source output trigger (transient action) must be the same. This is not applicable 
if the trigger count (Count value) is set to 1.

NOTE About Wait Time

If wait time is set, channels cannot start measurement or source output change until 
the wait time elapses. See “Wait Control dialog box” on page 4-30 for setting the 
wait time.

For the grouped channels, the wait time starts at the timing of the last output change 
(DC output change or pulse level transition from peak to base) by the last source 
output channel.
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Trigger System
B2961A/B2962A supports the ARM-TRIGGER model described in 1999 SCPI 
Command Reference. Operation summary of this trigger model is described below. 
Also see Figure 6-7.

The trigger system can be initiated by pressing the Trigger key on the front panel.

For the trigger setup parameters, see “Trigger Parameters” on page 4-19 and 
“Trigger Configuration dialog box” on page 4-34.

1. Moves to the ARM layer if the trigger system was initiated.

2. Waits for the ARM event which is a signal from the ARM trigger source.

3. Moves to the TRIGGER layer if the ARM event was detected and the ARM 
delay time elapsed.

4. Waits for the TRIGGER event which is a signal from the TRIGGER trigger 
source.

5. Executes the device action if the TRIGGER event was detected and the 
TRIGGER delay time elapsed.

6. Repeats 4 and 5 until the TRIGGER count reaches the specified count. And then 
moves to the ARM layer.

7. Repeats 2 to 6 until the ARM count reaches the specified count. And then moves 
to the Idle layer.

This trigger model is applied to two device actions, Transient (source output) and 
Acquire (measurement) independently. Two actions can start simultaneously or 
separately.

Also for the 2-channel models, two channels can perform synchronous operation or 
asynchronous operation.

NOTE Auto key

The Auto key sets the operation of the trigger system to AUTO or off.

In the AUTO status, the channel in the DC output status (On/Off switch is ON) 
repeats measurement (Acquire device action) under the predefined trigger 
conditions. The Transient device action is not performed.

For the predefined trigger conditions, see “Auto” on page 4-3.
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Figure 6-7 B2961A/B2962A Trigger System
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Trigger Source

B2961A/B2962A supports the following trigger sources. The trigger source must be 
set to the ARM event and the TRIGGER event individually.

• AUTO (automatic internal, AINT): Trigger source best suited for the present 
operating mode is automatically selected by the internal algorithms. 

• BUS: Remote interface trigger command such as GET, TRIGger, and *TRG 

• TIMER (timer, TIMer): Signal internally generated every interval set by the 
Period field

• INT1 or INT2 (internal): Signal from the internal bus 1 or 2

• EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, EXT10, 
EXT11, EXT12, EXT13, or EXT14 (external): Signal from the DIO pin n, 
which is an I/O port of the Digital I/O D-sub connector on the rear panel. n=1 to 
14

• LAN: LXI trigger

Device Actions

B2961A/B2962A supports the following device actions. Also see Figure 6-8.

• Transient device action (source output)

Source channel starts source output for applying one output value if the 
TRIGGER event was detected and the Source delay time elapsed.

• Acquire device action (measurement)

Measurement channel starts measurement for obtaining one measurement data if 
the TRIGGER event was detected and the Measure delay time elapsed.

NOTE To synchronize the channel operation, for the 2-channel models

If channels are set as shown below, the device actions start simultaneously.

• To synchronize source output:

• Trigger source is set to the same mode.

• Delay time is set to the same value.

• Source output ranging mode is set to the fixed mode.

• Source wait time control is set to OFF.
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• Measurement wait time control is set to OFF.

• To synchronize measurement:

• Trigger source is set to the same mode.

• Delay time is set to the same value.

• Measurement wait time control is set to OFF.

Figure 6-8 Transient and Acquire Device Actions
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Trigger

Step value

Step value

Measure Measure

Source delay

Measure delay Measure delay

Trigger Trigger

Trigger
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Trigger Output

B2961A/B2962A can output trigger at the timing of Trigger output shown in Figure 
6-7. The trigger output terminal can be selected from the following terminals.

• Internal bus, INT1, INT2

• LAN port

• Digital I/O pin, EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, 
EXT9, EXT10, EXT11, EXT12, EXT13, EXT14

The trigger output can be set by using “Trigger Configuration dialog box” on page 
4-34. The trigger output timing and the setup parameters are shown in Table 6-5.

Table 6-5 Trigger Output Timing and Setup Parameters

For using a digital I/O pin, it is necessary to set function of the pin, output trigger 
polarity, type, pulse width, and the Output Trigger Timing parameter. See “DIO 
Configuration dialog box” on page 4-43 and “Using Digital I/O” on page 3-33.

NOTE In addition, the trigger outputs are also available for Phase marker of sinusoidal 
wave and Trigger points of user defined wave by using the terminals which are not 
assigned to the above trigger outputs. For setting these trigger outputs, see 
“Function Parameters” on page 4-12.

Trigger output timing Layer Action
Trigger 
Output

Output 
Trigger 
Timing

Starting ARM loop ARM TRANS. for 
transient 
action or 
ACQ. for 
acquire 
action

ON BEFORE

Ending ARM loop ARM ON AFTER

Starting TRIGGER loop TRIGGER ON BEFORE

Ending TRIGGER loop TRIGGER ON AFTER

Starting Transient device action ACTION TRANS. ON BEFORE

Ending Transient device action ACTION TRANS. ON AFTER

Starting Acquire device action ACTION ACQ. ON BEFORE

Ending Acquire device action ACTION ACQ. ON AFTER
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Interlock Function
The interlock function is designed to prevent electrical shock when a user touches 
the measurement terminals. If the interlock terminal is open, maximum output is 
limited to 42 V.

To perform high voltage measurement greater than 42 V, connect the interlock 
terminal to an interlock circuit of a test fixture or a shielding box. The interlock 
circuit must have one LED and two mechanical switches that are connected together 
and placed near the shielding box opening doors. For details on installing the 
interlock circuit, see “Installing the Interlock Circuit” on page 3-23.

The interlock function works as shown below.

• When the interlock terminal is open, maximum output is limited to 42 V.

• When the interlock terminal is shorted, source channel can apply its maximum 
output value.

• When the interlock terminal is opened in a high voltage condition greater than 
42 V, the output voltage is immediately set to 0 V and the output switch is set 
to off. 

WARNING Open the interlock terminal so that the channel cannot apply dangerous 
voltage when the source/measure terminal is touchable or opened.
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Over Temperature Protection
The over temperature protection is effective for preventing damage to a channel 
from over temperature. If B2961A/B2962A is used in an environment over 30 C, 
channel outputs are limited to the value less than the maximum value. If a channel 
output reaches the limit, all channels automatically and immediately set the output 
to 0 V and set the output switch to off. And the causal channel is locked 
automatically.

To unlock the channel, the self-test must be performed. If the self-test does not 
report any problem, you can use the channel soon. For performing the self-test, see 
“Self-test” on page 3-9.

The maximum output for the condition over 30 C is less than the maximum output 
for the specification condition of 23 C  5 C. The channel output limit is given by 
the following formula.

DCMAX  ( [ ( PCS + 30 - TAMB) - |VOAB  IB| ] / |VOAP  IP| )2  100

The parameters are described below.

• DCMAX: Allowable maximum duty ratio in %, or 0 for DC bias output

• PCS: Maximum power, 64 W

• TAMB: Ambient temperature, in C

• VOAB = 250 V, for |IB|  105 mA

VOAB = 39 V, for |IB| > 105 mA and |VB| > 6V

VOAB = 21 V, for |IB| > 105 mA and |VB|  6V

VB: Pulse base voltage setting value or DC bias voltage setting value, in V

• IB: Current at pulse base or DC current, in A

• VOAP = 250 V, for |IP|  105 mA

VOAP = 39 V, for |IP| > 105 mA and |VP| > 6V

VOAP = 21 V, for |IP| > 105 mA and |VP|  6V

VP: Pulse peak voltage setting value, in V

• IP: Current at pulse peak, in A
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Initial Settings 
The B2961A/B2962A is initialized by turning the B2961A/B2962A on, the *RST 
command, or the device clear. Initial settings are shown in this section.

Table 6-6 System Initial Settings

Setup item Power on Reset

GPIO function Digital In 

GPIO function (D14) High Voltage 

GPIO polarity Negative 

GPIO output trigger type Edge 

GPIO output trigger timing Both 

GPIO output trigger pulse width 100 s 

Zoomed display OFF Not changed

Display image format JPG 

User message enable Disabled 

User message “” 

Byte order (measurement data) Normal 

Data format (measurement data) ASCII 

Data format (GPIO data) ASCII 

Data format (status register) ASCII 

Data elements (measurement data) All 
(V/I/R/S/T/Stat)



Data elements (calculate) CALC 

Automatic timestamp reset ON 

Mass storage directory (Root) 
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Table 6-7 Channel Initial Settings

Program variables None Not changed

Program selection None 

Program status Idle 

Setup item Power on Reset

Low terminal state Grounded Not changed

Output state OFF 

Output auto filter enable ON 

Output filter enable ON 

Output filter time constant 5 s 

Output filter frequency 31.8309886 kHz 

Output OFF state Normal 

Output protection OFF 

Programmable output resistance current list -1E-4,1E-4 

Programmable output resistance fixed level 0  

Programmable output resistance mode Fixed 

Programmable output resistance state OFF 

Programmable output resistance voltage list 0.0,0.0 

Programmable output resistance (series resistance) 0 

Programmable output resistance (shunt resistance) 2 G 

Programmable output resistance mode list VOLT 

External output filter state OFF Not changed

External output filter type ULNF Not changed

Setup item Power on Reset
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Source mode Voltage 

Source shape DC 

Automatic output-on ON 

Automatic output-off OFF 

Voltage source 0 V 

Voltage protection level 2 V 

Voltage source auto ranging ON 

Voltage source range 2 V 

Voltage source range lower limit 0.2 V 

Voltage source mode Fixed 

Voltage sweep points 1 

Voltage sweep start 0 V 

Voltage sweep stop 0 V 

Voltage list points 1 

Voltage list values 0 V 

Current source 100 A 

Current protection level 100 A 

Current source auto ranging ON 

Current source range 100 A 

Current source range lower limit 1 A 

Current source mode Fixed 

Current sweep points 1 

Current sweep start 0 A 

Current sweep stop 0 A 

Setup item Power on Reset
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Current list points 1 

Current list values 0 A 

Sweep direction UP 

Double sweep OFF 

Sweep ranging BEST 

Continuous triggered source ON 

Pulse delay 0 s 

Pulse width 50 s 

Auto settling time ON 

Settling time 0 s 

Measure function Current 

Auto aperture ON 

Aperture time 0.1 PLC 

Resistance measure compensation OFF 

Remote sensing OFF 

ARB waveform shape Square 

ARB waveform count 1 

ARB exponential current end level 0 A 

ARB exponential current start level 0 A 

ARB exponential current start time 0 s 

ARB exponential current time constant 0 s 

ARB exponential current total time 0 s 

ARB ramp current end level 0 A 

ARB ramp current end time 0 s 

Setup item Power on Reset
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ARB ramp current rise time 0 s 

ARB ramp current start level 0 A 

ARB ramp current start time 0 s 

ARB sinusoidal current amplitude 0 A 

ARB sinusoidal current frequency 1 mHz 

ARB sinusoidal current offset 0 A 

ARB sinusoidal current phase marker output EXT1 

ARB sinusoidal current phase marker phase 0 degree 

ARB sinusoidal current phase marker state OFF 

ARB square current end time 0 s 

ARB square current peak level 0 A 

ARB square current peak time 0 s 

ARB square current start level 0 A 

ARB square current start time 0 s 

ARB trapezoidal current end time 0 s 

ARB trapezoidal current fall time 0 s 

ARB trapezoidal current peak level 0 A 

ARB trapezoidal current peak time 0 s 

ARB trapezoidal current rise time 0 s 

ARB trapezoidal current start level 0 A 

ARB trapezoidal current start time 0 s 

ARB triangle current end time 0 s 

ARB triangle current fall time 0 s 

ARB triangle current peak level 0 A 

Setup item Power on Reset
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ARB triangle current rise time 0 s 

ARB triangle current start level 0 A 

ARB triangle current start time 0 s 

ARB user defined current BOS points 1 

ARB user defined current BOS signal EXT1 

ARB user defined current BOS state OFF 

ARB user defined current BOS value OFF 

ARB user defined current level 0 A 

ARB user defined current points 1 

ARB user defined current step time 0 s 

ARB exponential voltage end level 0 V 

ARB exponential voltage start level 0 V 

ARB exponential voltage start time 0 s 

ARB exponential voltage time constant 0 s 

ARB exponential voltage total time 0 s 

ARB ramp voltage end level 0 V 

ARB ramp voltage end time 0 s 

ARB ramp voltage rise time 0 s 

ARB ramp voltage start level 0 V 

ARB ramp voltage start time 0 s 

ARB sinusoidal voltage amplitude 0 V 

ARB sinusoidal voltage frequency 1 mHz 

ARB sinusoidal voltage offset 0 V 

ARB sinusoidal voltage phase marker output EXT1 

Setup item Power on Reset
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ARB sinusoidal voltage phase marker phase 0 degree 

ARB sinusoidal voltage phase marker state OFF 

ARB square voltage end time 0 s 

ARB square voltage peak level 0 V 

ARB square voltage peak time 0 s 

ARB square voltage start level 0 V 

ARB square voltage start time 0 s 

ARB trapezoidal voltage end time 0 s 

ARB trapezoidal voltage fall time 0 s 

ARB trapezoidal voltage peak level 0 V 

ARB trapezoidal voltage peak time 0 s 

ARB trapezoidal voltage rise time 0 s 

ARB trapezoidal voltage start level 0 V 

ARB trapezoidal voltage start time 0 s 

ARB triangle voltage end time 0 s 

ARB triangle voltage fall time 0 s 

ARB triangle voltage peak level 0 V 

ARB triangle voltage rise time 0 s 

ARB triangle voltage start level 0 V 

ARB triangle voltage start time 0 s 

ARB user defined voltage BOS points 1 

ARB user defined voltage BOS signal EXT1 

ARB user defined voltage BOS state OFF 

ARB user defined voltage BOS value OFF 

Setup item Power on Reset
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Table 6-8 Trigger System Initial Settings

ARB user defined voltage level 0 V 

ARB user defined voltage points 1 

ARB user defined voltage step time 0 s 

Setup item Power on Reset

ARM count 1 

ARM source AINT 

ARM timer 100 s 

ARM delay time 0 s 

ARM bypass OFF 

Trigger count 1 

Trigger source AINT 

Trigger timer 10 s 

Trigger delay time 0 s 

Trigger bypass OFF 

External trigger output EXT1 

External trigger output (LAN) LAN0-7 (all) 

External trigger output enable OFF 

Setup item Power on Reset
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Table 6-9 LXI Trigger Events Initial Settings

Setup item Power on Reset

Event domain 0 

LAN event “WaitingForAcquir
eArm1”, “Waiting
ForTransitionArm1
”, “WaitingForAcq
uireTrigger1”, “Wa
itingForTransition
Trigger1”, “Measu
ring1”,  “Settling1”

“WaitingForAcquir
eArm2”, “Waiting
ForTransitionArm2
”, “WaitingForAcq
uireTrigger2”, “Wa
itingForTransition
Trigger2”, “Measu
ring2”,  “Settling2”



Delay time 0 

Input/output filter string “ALL:5044” 

Input/output status OFF 

Input detection RISE 

Output drive OFF 

Output slope Positive 

Output source “” 

Output timestamp delta 0 

Event logging ON 

Circular event logging ON 

Event log size 100 
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Table 6-10 Calculate Functions Initial Settings

Table 6-11 Non-volatile Communication Settings

Setup item Power on Reset

Math function enable OFF 

Math function expression (VOLT*CURR) 

Math function expression name “POWER” 

Math function catalog “POWER”, 
“OFFCOMPOHM
”, “VOLTCOEF”, 
“VARALPHA”



Math function unit name “W” 

Trace feed source SENSe 

Trace control NEVer 

Trace points 100000 

Trace statistics format MEAN 

Trace timestamp format ABS 

Setup item Factory default setting

DHCP Enabled

IP address 169.254.5.2

Subnet mask 255.255.0.0

Default gateway 0.0.0.0

Obtain DNS server from DHCP Enabled

DNS server 0.0.0.0

WINS server 0.0.0.0
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Hostname A-B29xxA-nnnnn

B29xxA: model number

nnnnn: suffix of serial number.

Desired hostname

Desired service name

mDNS Enabled

Use DNS naming service Enabled

Use NetBIOS naming service Enabled

Domain name Not set

GPIB address 23

LXI identify Disabled

GPIB command interface Enabled

USB command interface Enabled

VXI-11 command interface Enabled

SCPI telnet command interface Enabled

SCPI socket command interface Enabled

SCPI HiSLIP command interface Enabled

Web interface Enabled

Command prompt for a Telnet session B2900A>

Welcome message for a Telnet session Welcome to Agilent B2900A 
Series

Setup item Factory default setting
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Table 6-12 Other Non-volatile Settings

Setup item Factory default setting

Channel grouping “1” for 1-ch models

“1,2” for 2-ch models

Remote display Enabled

Display color set 1

Beeper Enabled

Graphical web interface (web server) Enabled

Power-on program Not set

Line frequency 50 Hz

Fan control mode Normal

V/I Limit for each polarity OFF

Immediate V/I update by knob OFF

External output filter state OFF

External output filter type ULNF (ultra low noise filter)
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